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Quick Start

1. Installation

For detailed instructions refer to "S-Drive Installation " section.

4. Configuring Out of the Box S-Drive
Attachments

Go to "S-Drive Product Page" (https://sdriveapp.com). And click

"Get S-Drive" button. Answer the questions, confirm the
installation and click on "Install" button. After submitting your
Salesforce.com password click Continue/Next until the Ul asks you
to choose security level. Click on "Grant access to all users" and
click "Next" and click "Install". For detailed instructions refer to S-
Drive Installation section.

Important Note: Upgrading pre-1.24 versions to S-Drive 2.5
requires manual migration steps. You need to contact S-Drive
support to migrate your data to the latest version. If you have S-
Drive 1.24 or 1.25, you can upgrade to 2.5 by following steps in S-
Drive Installation section’s "Upgrading S-Drive" section.

2. Displaying S-Drive Tab in Sales App

For Salesforce Classic, go to "Setup" -> "Personal Setup" -> "My
Personal Information" -> "Change My Display". Click "Customize
My Tabs" button. If you don't find the link, try "My Settings"->
"Display & Layout"-> "Customize My Tabs". Select "Sales" from
the "Custom App" drop down box. Move "S-Drive" from
"Available Tabs" box to "Selected Tabs". Click "Save".

For Salesforce Lightning, go to “App Launcher”, there will be a
new App Card for “S-Drive”, select it. S-Drive App opens in
lightning experience with 3 tabs, which are “Home”, “S-Drive” for
S-Drive folders and “S-Drive Configuration” tab for configuration
settings.

3. Activating S-Drive

Click on "S-Drive" tab on Salesforce Classic. If it is not activated
yet, page will be redirected to S-Drive Activation page. If Remote
Site Settings are configured correctly, you need to complete “Step
2: Configure Amazon S3 Credentials", "Step 3: Configure Amazon
S3 Bucket Name" and "Step 4: S-Drive Authorization" sections.

. For Step 2, you must have Amazon S3 Access Key and
Secret Key information to use with S-Drive.

. For Step 4, you need to create a free S-Drive account
and authorize S-Drive to connect your organization at
https://portal.sdriveapp.com

For Salesforce Classic, S-Drive comes with preconfigured Account,
Case, Contact, Opportunity attachments as overridden. If you
want to use S-Drive Attachments on these objects, you can
easilyenable by following these steps:
. After installing and activating S-Drive, go to "Setup" ->
"App Setup" -> "Customize" -> "Accounts" (or Cases,
Contacts, Opportunities) -> "Button and Links"
. Click "Edit" next to the "View" label.
. Select "Override with" as "Visualforce Page" and select
the correct bundled page (AccountFilePage for
Accounts, CaseFilePage for Cases, ContactFilePage for
Contacts, OpportunityFilePage for Opportunities) from
the dropdown and click Save.
. You should see the Account (or Case, Contact,
Opportunity) Files section in your individual object
pages' bottom section.

For Salesforce Lightning, S-Drive comes with global S-Drive
component that can be used for any type of objects (Account,
Case, or Custom Objects). You can easily add S-Drive Lightning
component to any record page by following steps:

. On the any objects record page, (for example Account)

click settings menu button (**" ) on the top right. Select

“Edit Page” option.

. On the left side, under “Lightning Components” section
> Custom > there is “SDrive” lightning component.
Drag and drop the component to the record page
wherever you want.

. After component is added to record page on the right
side, there will be attributes. Please fill these attributes
correctly (Please check S-Drive Advanced User Guide to
get detailed information).

o Parent Object Name: Object name without prefix
that own files (i.e. Account, MyCustomObject__c)

o Object Namespace Prefix: If there is a prefix for
parent object, you should put it here. (For
Account it should be empty, for Custom object it
should get you org prefix. i.e. for
“cg__MyCustomObject__c” it will be “cg__")

o File Object Name: Object name without prefix for
files. (i.e. “AccountFile__c”,
“MyCustomObjectFile__c”)

o File Object Namespace Prefix:

1 All Rights Reserved - CyanGate LLC
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o) If there is a prefix for parent object, you should
put it here. (For Account it should be empty, for
Custom object it should get you org prefix. i.e. for
“cg__MyCustomObject__c” it will be “cg__")

o Relationship Field Name: For Standart objects it is
“[ObjectName]__r” (i.e. Account__r, Case__r).
For custom objects it is “Parent__r”.

o Default Sort Field Name: It can be object files any
sortable field name with prefix. By default, it is
“cg__File_Name__c” assuming the usage of a
managed package file object (please change this
to “File_Name__c” if a custom file object is being
used).

. “Save” the record page using Save button on top right,
then “Activate as Org Default” by clicking

“Activation...” button right of it.

5. Configuring Standard/Custom Object
Attachment Upload Feature

S-Drive stores all file information as Salesforce.com records on

objects that represent each file on Amazon storage. In order to

store file information, you can either use the S-Drive provided file

objects for the Case, Contact, Lead, Account and Opportunity

objects (see above item) or you can create your own. For
Salesforce Classic or Lightning there is no any distinction on
Object Files.

Creating Custom Object Files

This section

. Go to "Setup" -> "App Setup" -> "Create" -> "Objects". And click
"New Custom Object" button. Fill in the required fields to create
a new custom object (for example, named as "My Example
Object File"). For "Record Name" field, type "My Example
Object File Number". Select "Auto Number" as "Data Type".
Type in "A-{0000}" for "Display Format" and "1" for" Starting
Number"

. Check if the "Deployment Status" is set to "Deployed". Then click
"Save" button to create the custom object file

. After creating custom object, create fields for that object. So, to
create fields to "My Example Object File" object, click on
"Custom fields & Relationships" and create the following fields:
(while creating, make sure that all fields are visible to all users):

¢} Content Type Type = Text
Length = 255

o Description Type = Text Area(Long)
Length = 32,000
Visible Lines = 3

o File Name Type = Text

Length = 255
File Size in Bytes Type = Number
Length =18
Parent Type=Master-Detail Relationship
Related to = My Example Object
Parent Folder Id Type = Text
Length = 255
File Size Type = Formula

Formula Return Type = Text
Copy and paste below code to "Simple Formula" field:

IF(File_Size_in_Bytes__c > 1024,
IF(File_Size_in_Bytes__c > 1048576,
IF(File_Size_in_Bytes__c > 1073741824,
TEXT(ROUND((File_Size_in_Bytes__c
/1073741824),2)) & " GB",
TEXT(ROUND((File_Size_in_Bytes__c
/1048576),2)) & " MB"),
TEXT(ROUND((File_Size_in_Bytes__c
/1024),2)) & " KB"),
TEXT(File_Size_in_Bytes__c) & " bytes")

Click "Check Syntax" button to see if you have correctly
typed the formula.

WIP Type = Checkbox
Default Value = Checked
Key Type = Text
Length = 255
Version Id Type = Text
Length = 255
Version Description Type = Text
Length = 255
Is Latest Version Type = Checkbox
Default Value = Checked
Preview Key Type = Text
Length = 255
Thumbnail Key Type = Text
Length = 255
Preview Version Id Type = Text
Length = 255
Thumbnail Version Id  Type = Text
Length = 255

Private (This field is optional)

Type = Checkbox

Default Value = Unchecked
For more information, about usage/setting of this property
see "S-Drive Advanced Configuration Guide" (page 25).

Creating Before Delete Trigger for Custom Object (Optional)

You can find detailed information about creating "before delete
trigger" in "S-Drive Advanced Configuration Guide" (page 17).
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Creating Custom Object Files Page For Salesforce Classic

In this step we’ll create custom object file’s Visualforce page. This
page can be used to override the object’s view or it also can be
used as an inline section for the object’s layout. At the end of this
section, use cases for both scenarios will be displayed. To create
an object file page, follow these steps:

. Go to "Setup" -> "App Setup" -> "Develop"-> "Pages" and click
the "New" button at the top of the page. Create a page (For
example "MyExample" page). And type following code inside the
page (Note that this sample is for override option with chatter
enabled and inline is set to "true" for this reason. For inline
option you need to remove "apex:detail" tag):

<apex:page standardController="My_Example_Object__c
tabStyle="My_Example_Object__c">
<apex:detail inlineEdit="true"
relatedList="true"
showChatter="true"/>
<cg:AttachmentComponent title="My Example Object Files"
inline="true"
customObjectName="My_Example_Object__c"
customObjectFileName="My_Example_Object_File__c
objectld="{!My_Example_Object__c.Id}" />
</apex:page>

Remember that this is just an example. You need to set these
component attributes based on your configuration. For more
information about component attributes refer to "S-Drive
Advanced Configuration Guide" (page 20)

. Now set the security for your page on other profiles. Go to
"Setup" -> "App Setup" -> "Develop" -> "Pages" and click
"Security" link next to your page name. Move all profiles (or
select based on your needs) from "Available Profiles" to
"Enabled Profiles". Now we have an object (or created our
custom object), created our custom object file and custom
object file page. At this point, we can override the custom
object’s view or we can use "S-Drive Attachments" as an inline
section in the page layout:

o Overriding the View of the Object

Go to "Setup" -> "App Setup" -> "Create"-> "Object" and
click the label of your custom object. You'll see "Object
Definition Detail" screen. Scroll down and find "Standard
Buttons and Links" page block and click "Edit" action next
to the "View" label. Then select Visualforce Page for
Override With section and pick "MyExampleFilePage" (the
custom page you created previously for this object) from
the drop-down box. Click "Save" button to complete the
override. After creating a test object, you should see "My
Example Object Files" page block at the end of the object

detail page. See "S-Drive User Guide" for more information
on how to use the buttons and functions in this page
block.

Using as Inline Attachment

To use S-Drive Attachments as inline, we need to set
"inline" property to "true". That is, in the example page we
have created above, inline = "true" must be included to
use S-Drive Attachments as inline.

Go to "Setup" -> "App Setup" -> "Create"-> "Object" and
click the label of your custom object. You’ll see "Object
Definition Detail" screen. Scroll down and find "Page
Layouts" page block and click "Edit" action next to the
main layout of the object. Click "Fields" and drag-drop a
Section to an appropriate place in the layout.

After dropping the "Section", you’ll see the properties
screen for the dropped "Section". Type in a section name
and select if you want to display section header on detail
page and edit page. Also select "1-column" for the layout.
Then click "OK" button. You can customize these settings
based on your layout needs.

Now, go to Visualforce Pages from the top. Select the
"Custom page name" you created (e.g. TestPage) and drag
it into the section that you created previously. After
dropping the page into the section, click the properties
icon for the page on the top-right corner of the page in the
section. Keep "Width (in pixels or %)" as "100%", set
"Height (in pixels)" to "500". And check "Show scrollbars"
option. Click OK button. We are done with the
configuration. Save the layout by clicking the "Save"
button on the left-top corner of the screen.

Now if you go to your object’s tab, you'll see the S-Drive
Attachments inline in the page layout.

Tip: You can use "Inline Visualforce Expander" tool from
AppExchange to display S-Drive Attachments height
dynamically. Refer to the "S-Drive Advanced Configuration
Guide" page 31 for more information.

Adding S-Drive Lightning component to Custom Obiject Files

Record Page For Salesforce Lightning

On the custom objects record page click settings menu

button (") on the top right. Select “Edit Page” option.
On the left side, under “Lightning Components” section
> Custom > there is “SDrive” lightning component.
Drag and drop the component to the record page
wherever you want.
After component is added to record page on the right
side, there will be attributes. Please fill these attributes
correctly (Please check S-Drive Advanced User Guide to
get detailed information).
o Parent Object Name: Object name without prefix
that own files (i.e. MyCustomObject__c)
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o) Object Namespace Prefix: If there is a prefix for
parent object, you should put it here. (i.e. for
“cg__MyCustomObject__c” it will be “cg__")

o File Object Name: Object name without prefix for
files. (i.e. “MyCustomObjectFile__c”

o File Object Namespace Prefix: If there is a prefix
for the object, you should put it here. (i.e. for
“cg__MyCustomObject__c” it will be
“cg__")Relationship Field Name: For custom
objects it is “Parent__r".

o) Default Sort Field Name: It can be object files any
sortable field name with prefix. By default, it is
“cg__File_Name__c” (i.e. “CreateDate”,
“cg__File_Type__c“

. “Save” the record page using Save button on top right,
then “Activate as Org Default” by clicking

“Activation...” button right of it.

6. Allowing Customer Portal Users to Upload
Case Files from Customer Portal

. Specify Custom Email Footer

. Specify Max File Size in MBs

. Specify Default Email Expiration Time

. Change Default Upload Manager

. Allow users with "Modify All" permissions to create items at
the top level and disallow other users

. Change field display settings of S-Drive Attachment objects

. Configure File/Attachment Sync.

. Update Amazon Information

. Enable Versioning

. Update S-Drive Objects

. Enable Amazon S3 Transfer Acceleration

. Configure Preview and Thumbnail

You can refer to "S-Drive Advanced Configuration Guide" (page
35) for detailed information.

8. File/Attachment Sync

Go to "Setup" -> "App Setup" -> "Create" -> "Objects". Click "Edit"
next to the "Case File" object. Scroll down to the "Optional
Features" in "Edit" page. Check "Available for Customer Portal"
and click "Save".

Go to "Setup" -> "Administration Setup" -> "Manage Users" ->
"Profiles" and click "Edit" next to your currently installed
"Customer Portal Manager" installation. Note that selected profile
must be a cloned profile to make changes on it.

Scroll to the "Custom Object Permissions" section. Give Read,
Create, Edit and Delete access to the "Case Files" custom object
by checking the appropriate checkboxes, then click "Save".

(Optional) To Remove Submit & Add Attachments button from

new case creation screen, look at the "S-Drive Advanced
Configuration section.

7. S-Drive Configuration

You can configure Salesforce Files/Attachments to be synced with
S-Drive. Once you add a file/attachment to any configured object,
file/attachment will be synced to S-Drive.

You can refer to "S-Drive Advanced Configuration section for
detailed information.

9. S-Drive Reports

Organization administrators can use S-Drive Configuration to set
organization-wide configurations and get information about S-
Drive credentials, usage and billing. There is no any distinction
between Salesforce Classic & Salesforce Lightning. Using S-Drive
Configuration, it is possible to:

Enable/Disable Download Manager

Enable/Disable Checksum Verification

Enable/Disable Copy URL and Email features in S-Drive Tab
Embed Thread Id in Case Emails

Specify Restricted Portal User Profiles

Specify Case Email Reply-To Address

You can create "File Activity" reports for the S-Drive files. For
Accounts, Cases, Contacts, Opportunities and S30bjects reports
are enabled by default. For other standard/custom object files
you need to create a lookup relationship under File Activity
object:

. Go to "Setup" -> "App Setup" -> "Create" -> "Objects" and click
the "File Activity" object name. Scroll to the "Custom Fields &
Relationships" for the object and click "New" button. Choose the
field type" screen, select "Lookup Relationship" and click "Next"
button.

. Choose the related object screen, select "Related To" from the
drop-down as your object file (e.g. My Example Object File) and
click "Next" button. Keep default values for other steps and click
"Save" button.

S-Drive Reports tracks following activities:
. S-Drive OneClick Download

. S-Drive CopyUrl Download

. S-Drive Zip and Download

o S-Drive Email Sent.

To create S-Drive Reports, follow these steps:
. Click "Reports" tab and then click "New Report..." button.
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. Select "Other Types" from "Select Report Type" screen and
find the correct File Activity for your object (e.g. 'File
Activities with Account File' for 'Accounts') and click "Create"
button.

. "Activity Type" and "Additional Details" fields are important
for S-Drive Reports. Arrange fields for report and run/save
report based on your needs.

For more information about S-Drive Reports, refer to "S-Drive
Advanced Configuration section.

Sharing Rules and Permissions

For both Salesforce Classic & Lightning, "S-Drive Attachments"
support all sharing rules similar to related objects. "S-Drive
Folders" support manual sharing and it is also sharing-aware.

For more information about Sharing Rules, refer to S-Drive
Advanced Configuration section.

You can apply object-based sharing via manual sharing. Profile
based permissions are also supported on custom object files. S-
Drive supports four different access levels:

o None

. Read

. Read + Create + Edit

. Read + Create + Edit + Delete

To set these profiles based on permissions go to "Setup" ->
"Administration Setup" -> "Manage Users" -> "Profiles" menu.
Click on the "Edit" link next to the name of the profile you want to
edit. Note that you cannot change the standard profiles’
permissions. You may need to clone them before you can edit.
Inside the "Edit" screen of the selected profile, scroll down to the
"Custom Object Permissions" section. You'll see the "Basic Access"
selections for your custom object files. You will need to
check/uncheck these boxes based on your needs.

For more information and examples about S-Drive Permissions
refer to S-Drive Advanced Configuration section.
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1. INTRODUCTION

Welcome to S-Drive!

1.1 Layout of this Guide
This INTRODUCTION section explains the various pieces of S-Drive.

In GETTING SET UP, we'll talk about setting up the accounts you need as prerequisites to using S-Drive.
INSTALLING S-DRIVE tells you how to find S-Drive from the AppExchange.

ACTIVATING S-DRIVE walks you through setting up your AWS access and bucket, and connecting your
Salesforce org though our portal.

S-DRIVE FILE AREA ON ACCOUNTS, CASES, CONTACTS, OPPORTUNITIES, LEADS shows you how to add
the S-Drive file area to standard object pages so you can begin uploading and accessing files. At this
point, you are ready to use S-Drive.

DISPLAYING “S-Drive” AND “S-Drive Configuration” TABS helps you set up these tabs for easy access.

S-DRIVE ADVANCED CONFIGURATION explains how to create an S-Drive File Object for a standard or
custom object other than Accounts, Cases, etc.

S-DRIVE CONFIGURATION TAB walks you through all the things an admin can configure for the
organization.

ADVANCED FEATURES gives a quick overview of S-Drive’s features beyond simply uploading and
accessing files. More information can be found in the User’s Guide.

PROFILE PERMISSIONS, OWD, AND SHARING RULES talks about how S-Drive works with Salesforce’s
sharing settings and profile permissions.

S-DRIVE IN SALESFORCE.COM COMMUNITIES explains how to add S-Drive to your community.

S-DRIVE SALESFORCE MOBILE APP CONFIGURATION AND USER GUIDE shows you how to set up S-
Drive for Mobile.

Appendix A: S-DRIVE PORTAL gives more detail on the S-Drive portal account, including information
about billing.

Appendix B: Upgrading S-Drive is where to go if you're upgrading from an earlier version of S-Drive.
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Appendix C: Troubleshooting has some troubleshooting tips.

1.2 AWS and S-Drive Portal

S-Drive provides unlimited, cost-effective file storage using Amazon S3 on Amazon Web Services
(AWS). Your files are stored in the cloud and accessible in Salesforce through an easy to use interface.
Salesforce organizations are connected to AWS through an S-Drive portal account. This account is also
where you’ll be billed for your storage use. In order to use S-Drive, you’ll need an AWS account and an
S-Drive Portal account. See Section 2 GETTING SET UP for more information.

1.3 S-Drive Tab

With S-Drive, you can upload files to any standard or custom object record. In addition, there is an “S-
Drive Tab” where you can store files that aren’t related to any specific object. This can be used for
company-wide documents for example. Files on the S-Drive Tab (not associated with a standard or
custom object) are stored in an object called S30bject.

1.4 S-Drive File Objects

Each custom or standard object that you want to use S-Drive with has a corresponding S-Drive File
Object where the information about the files is stored. This is a custom object that has a master-detail
relationship with the object the files are associated with. For example, Accounts has an associated
object called AccountFiles. For Accounts, Cases, Contacts, Opportunities and Leads objects, S-Drive File
Objects have already been provided as part of the S-Drive package. For other standard objects, or for
your own custom objects, you can create the associated S-Drive file object through the S-Drive
Configuration tab. These objects should have permissions enabled in the profiles of users using them.

1.5 Other S-Drive Objects

In addition to the S-Drive objects that hold file information, there are other S-Drive objects that relate
to various features of S-Drive. These objects should have permissions enabled in the profiles of users
using S-Drive.

e AttachmentSyncs

e File Activities

e MyS30bjects

e Previews

e S3Configs

e S30bjects

e SDriveCustomActions
e SQueues

e SURLS
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e SURL Hits

2 GETTING SET UP
Welcome to S-Drive! S-Drive uses Amazon Web Services (AWS) to store files, and an S-Drive portal
account to track usage and billing. Let’s get those set up first.

2.1 Create an Amazon Web Services Account
To set up an AWS account, go to https://aws.amazon.com/ or directly to
https://portal.aws.amazon.com/billing/signup#/start to create an account.

2.1.1 Access Key and Secret Key
When creating your account, you will be given an Access Key and Secret Key, which you will need later
in order to activate S-Drive. If you need to find these keys again, you can go to
https://aws.amazon.com/ and go to Security Credentials.

” Contact Sales Support v English v My Account =
S~—

Products Seolutions Pricing Documentation Learmn Partner Network AWS Marketplace Customer Enablement Explore More Q AWS Management Console
Account Settings

Billing & Cost Management

Figure 2-1

2.1.2. Identity and Access Management (IAM) Policies and Minimum Policy
Example
See What is IAM for information about how to control access to your AWS resources. This is not
needed for most S-Drive customers.

To apply a policy to your restricted user:
1. Signin to AWS Management Console and click "IAM" from Services menu.
2. Click "Policies" on the dashboard and then click "Create Policy" button.
3. Select "Create Your Own Policy" on the screen.
4

Type name into "Policy Name" area. Copy contents of the below example and paste into
"Policy Document" area on AWS Console. Update sdrivebucket bucket name references in
policy document and click "Create Policy". The purpose of this policy is to give proper access
to your own Salesforce instance to be able to upload/ download files.
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"Version": "2012-10-17",
"Statement": [

{

"Effect": "Allow",
"Action": [
"53:*"
]l
"Resource": [
"arn:aws:s3:::sdrivebucket/*"
]
},
{
"Effect": "Allow",
"Action": [
"s3:ListAllMyBuckets"
]/
"Resource": [
"arn:aws:s3:::*"
]
}I
{
"Effect": "Allow",

"Action": [
"s3:PutBucketCORS"

]/
"Resource": [
"arn:aws:s3:::sdrivebucket”
]
}I
{
"Effect": "Allow",

"Action": [
"s3:GetBucketLocation"

]/
"Resource": [
"arn:aws:s3:::sdrivebucket”

]

5. Click "Users" on the dashboard and click on your user name. Then Click "Attach Policy" button
on the screen for the user that you use in S-Drive.

Find the policy which you created in #4 and click "Attach Policy" button.

2.2 Create an S-Drive Portal Account
In order to use S-Drive, you need an account on S-Drive portal. Here you will be able to see your
Amazon account and payment details. Go https://portal.sdriveapp.com. Register for a free account, or

login if you already have an account.
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For more information about your Portal account, including how to register a payment method, see
payment details, download invoices, connect or reconnect to organizations, change your password
and more, see Appendix A: S-DRIVE PORTAL.

3 INSTALLING S-DRIVE

NOTE: If you are upgrading S-Drive from a previous version, see Appendix B: Upgrading S-Drive.
Otherwise continue below.

Go to S-Drive Website (sdriveapp.com). Click "Get S-Drive" button

(Figure 3-1). The S-Drive Product Page on the AppExchange will be opened. Click "Get It Now".
Follow the directions to install S-Drive in your sandbox or production org.

d S )D R IV E FEATURES ~ SUPPORT  PRICING  DEMO REGISTER LOGIN

DRIVE

- Simple Secure Storage

For Salesforce Users

Eliminate the use of expensive Salesforce.com storage costs
by offloading Salesforce.com file storage to Amazon S3 with S-Drive.

Get S-Drive!

Figure 3-1
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4 ACTIVATING S-DRIVE

After completing installation, go to S-Drive Configuration in your Salesforce instance:

e In Classic, click on the “+” and click on S-Drive Configuration

e In Lightning, click on the “App Launcher” (E:.) menu which is on the left corner of the
Salesforce page.
o Then click on “S-Drive: Simple Secure Storage for Salesforce Users” app.

App Launcher Q. Find an app or item Visit AppExchange

v All Apps
Service Marketing Community i Salesforce Chatter
Manage customer service Best-in-class on-demand Salesforce CRM Communities .M The Salesforce Chatter social
with accounts, cont... More marketing automation ) network, incl... More

. | Content Sales Console Service Console Sales
Salesforce CRM Content rﬂ (Lightning Experience) Lets Q (Lightning Experience) Lets Manage your sales process
with accounts, le... More

sales reps work... More support agents ... More

S-Drive
( S b Simple Secure Storage for
DRIVE Salesforce Users.

v All Items

Accounts App Launcher Approval Requests Assets Calendar
Campaigns Cases Chatter Contacts Contracts
Dashboards Duplicate Record Sets Files Forecasts Groups

Figure 4-1

. Search Salesforce

555 S-Drive Home S-Drive S-Drive Configuration S-Drive Advanced Search

Figure 4-2

o Click on S-Drive Configuration

The S-Drive Configuration tab will take you to a list of instructions as follows:
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Step 1: Configure Remote Sites: If Remote Site Settings are configured correctly, you'll see "Your
remote site settings are configured correctly” message under the "Step 1: Configure Remote Sites"
section (Figure 4-3). If you see an error message in Step 1, resolve the issue by following the on-screen
instructions.

Welcome to £S,DRIVE

Thank you for installing S-Drive

Continue Configuration

Step 1: Configure Remote Sites

Your remote site settings are configured correctly.
Figure 4-3

e Step 2: Configure Amazon S3 Credentials: This step is required to connect your Amazon S3
account with S-Drive. You need to enter a valid "Amazon Secret Key" and "Access Key". After
providing keys. If you see "Amazon S3 Credentials are configured correctly," continue with
"Step 3: Configure Amazon S3 Bucket Name".
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Step 3: Configure Amazon S3 Bucket Name

Amaion 53 Buckst Name

Step 4: S-Drive Authorization

In order to start using S-Drive you need to create a free S-Drive account and authorize S-Drive to access your Salesforce organization on hitps://portal.sdriveapp.com
Please check S-Drive Portal Guide on the following page Support Documentation

Figure 4-4

Important Note: IAM users whom assigned individual security credentials, must have some
permissions to activate and use S-Drive. The minimum policy example can be seen in section 2.1.2
Identity and Access Management (IAM) Policies and Minimum Policy Example. Please apply this
policy if you are planning to use this kind of user for the activation.

e Step 3: Configure Amazon S3 Bucket Name: This is the bucket that will be used to store your
files in your Amazon S3 account. Bucket name must be unique and must comply with DNS
naming conventions. Bucket names cannot have capital letters or underscores.

You can select "Use existing bucket" or "Create a new bucket" option. (Figure 4-4)

If you select "Create a new bucket" option you need to provide a valid bucket name and
select the region name to create the bucket on this endpoint location.

If you select "Use existing bucket" option you must select one of the bucket names from the
list (that is retrieved from your Amazon S3 account).

Important Note: If you are planning to use S-Drive Versioning feature, we strongly suggest
you use a "versioning never enabled bucket". To ensure versioning status of your bucket, sign
in to your amazon console, find your bucket from S3 service and check bucket properties. If you
selected "Create a new bucket " option, you can ignore this note as it will create a "versioning
not enabled" bucket by default.
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Click "Configure Amazon S3 Bucket Name" button). If you see "Amazon S3 Bucket Name is
configured correctly" message continue with "Step 4: S-Drive Authorization".

Acoess Key [

Secret Key

Step 3: Configure Amazon S3 Bucket Name

® Use exising buckst ‘

Creats 3 new buckst (requires creste

et permission)

BuctetName [ siparansaylarisst o -‘
Confurs Amazon 53 Bustet e | e COEEp

Step 4: $-Drive Authorization

In order to start using S-Drive you need to create a free S-Drive account and authorize S-Drive to access your Salesforce organization on hitps://portal.sdriveapp.com
Please check S-Drive Porial Guide on the following page Support Documentation

Figure 4-5

e Step 4: S-Drive Authorization: You need to go to portal.sdriveapp.com to complete this step.
Go to portal.sdriveapp.com and login into the S-Drive portal account you created earlier.
Authorize S-Drive to connect to your organization:

e Click Connected Organizations link on the menu (Figure 4-6). Then under "Connect
Salesforce.com Organizations", click either “Production Instance” or “Sandbox Instance”
based on where you installed S-Drive (Figure 4-7). This redirects the salesforce.com login
page. Login, and you’ll see your organization on the list of “Connected Salesforce.com
Organizations.”

&DR'VE Biling  Connected Organizations  Payment Method Account  Logout
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Figure 4-6
Type User Name Date Created Date Updated Organization Status
PRODUCTION  user{@cyangate.com 1002772014 1118 11/14/2014 15:43

CONNECTED
DOARLISTIOAL rusnaatafMeunnnatn com | ~ruureerrn |

Figure 4-7

ANMAMNAA AA-RT ANMANNAL AA-E%

Congratulations! You are now ready to configure S-Drive to suit your needs.

5 S-DRIVE FILE AREA ON ACCOUNTS, CASES, CONTACTS,
OPPORTUNITIES, LEADS

In order to start using S-Drive for Accounts, Cases, Contacts, Opportunities, and Leads, you need to
have an area on the page to work with S-Drive files. The next section shows you how to set this up for
Classic. Or skip to S-Drive File Area for Lightning (Accounts, Cases, Contacts, Opportunities, Leads) for

Lightning.

5.1 S-Drive File Area for Classic (Accounts, Cases, Contacts, Opportunities,

Leads)

For Account, Case, Contact, Opportunity and Lead standard objects, the associated S-Drive file
objects and override pages for Salesforce Classic are bundled with the S-Drive installation. If you'll use
S-Drive attachments for these standard objects as override, you can use bundled objects and/or pages
where appropriate. If you are planning to use S-Drive Attachments for other standard/custom objects
or as override/inline, please refer to the "S-Drive Advanced Configuration Guide" document.

"Overriding the view of the object" means that the page will be used as an override to the standard
object page. In this case, 'S-Drive Attachments' will be a section at the end of the standard page

layout.

10
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1. In Salesforce Classic view, click Setup button on right top and go to Build-> Customize ->

Accounts (or Cases or Contacts or Opportunities or Leads- the label of the object that you
want to enable S-Drive Attachments for) -> Buttons, Links, and Actions. (Figure 5-1).

In Lightning view, you can click Setup icon ( $ ) on right top and go to Object Manager-

>Accounts or Cases or Contacts or Opportunities or Leads -> Buttons, Links, and Actions.

X

Home Chamer Libraries Content Subscriptions  +

It's Better in Lightning

Move to Lightning Experience an

Administer

Data.com Administration
@ Clean
B Clean Info

Account Fisids

Build

@ customize

Compact Layouts
Sasren Layouts

int

Use this page to manags butions, finks, and actions

ur users a producti

Check Readiness

 Switch to Lighining Experience

I - scwp el

Buttons, Links, and Actions

Action [r
Edt Accounts T3

Ean A to Gall List

Edn Adata Campeion
(D gy

Ean Check for New Deta
Edn Glean

Ear Delel

Edt Biscover Companies
&a Eat

Ean et More Accounts
Ean Lat

Ean New

&9 View

Ean View Account Hieranchy

Ware
T

GrsatsCatist

AccountAsaTaCamDEIan

Biling

Xcisn

Listctean

Deete

DiscoveryetAceounteACtion

Edi

DataDetCom CerAccauntsMUAIATtan
List

New

Ve

AccountHieraichy

Figure 5-1

Click the Edit action next to the View label (Figure 5-2).

Description

Detail Pags Link

Buens Links

Contant Source tcon
stanazra paae
Standsrd paga
Stanasra page
UL

Stondsea page
stanasra page
Standard page
stanazra page
Standsrd page
Stangsra page
Standard paga
Standsrd page
Standsrd page

Standard page

ana actons Hep (7

Overiiaden

Buttons, Links, and Actions New Action || New Button or Link | | Default Custom Links
Action Label Hame Description Type
Edit Accounts Tab Tab
Edit | Del Billing Billing Detail Page Link
Edit Delete Delete
Edit Edit Edit
Edit List List
Edit New New
view 4 view
Figure 5-2

2. Then select Visualforce Page for Override With section and pick related Visualforce page

(AccountFilePage for Accounts, CaseFilePage for Cases, ContactFilePage for Contacts,
OpportunityFilePage for Opportunities, LeadFilePage for Leads) from the drop-down box.
Click Save button to complete the override (Figure 5-3).
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Cveride Properties save | [Camel
Label Vs

—7

Defawt  Standard page
Salesforce Classic Ovemride () No vemde (use cefaul)
# Visuatorcs page[_Nome— v

Lightring Experience Ovemride -, Lighining compor—N00e— t/
PPN AccourFiPage [cg_AcoountFiePage]

cg_ 20¢]
MabieAccount 1ePage [cg_MobileAccountFilePags]
Mobie Ovemide -, Lightring compunent —Nome— v

® Use e Salestorce Ciassic override

Figure 5-3

3. Now it will display View as Overridden in the Buttons, Links, and Actions section (Figure 5-4).

Buttons, Links, and Actions New Action | New Bution or Link | DefautCustom Links [ —
Action Label Mame Description Type Content Source: kon Overridden
Edit Acoounis Tab Tab ‘Standard Salesforoe com Page
EditiDel  BEing Baing Detail Page Link URL
Edit Delete. Delete ‘Standard Salesforoe com Page
Edit Eait Edit ‘Stanéard Salesforce com Page
£t List Lit Standard Salesfros com Page
Edit New New ‘Standard Salesforoe com Page
Czjn Vew View W oo e (Vsuatires Page) _ )

Figure 5-4

4. After creating an account object, you should see "Account Files" (similar screens for Cases,
Contacts and Opportunities and Leads once you configure) page block at the end of the object
detail page (Figure 5-5). See "S-Drive User Guide" for more information on how to use the
buttons and functions in this page block.

Account Files Recycle Bin| | New Folder| | Upload| Download | | Attach from 5-Drive Folders| Email |Delete| | Cut| Copy| Paste
I
Home | Search Q)
b I eV
€ No records to display

Figure 5-5
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5.2 S-Drive File Area for Lightning (Accounts, Cases, Contacts,
Opportunities, Leads)

To display the S-Drive file area on Lightning pages for Account, Case, Contact, Opportunity and
Lead standard objects, you need to edit each of these objects’ pages. We’ll use the Account object
as an example, but the process is the same for Case, Contact, Opportunity, and Lead.

1. To edit the Lightning page for a standard object, first choose a record for that object. For
Accounts, if you don’t already have an Account record, you’ll need to create one (App
Launcher -> Accounts > New). If you already have an Account, you need to open that
account’s record page by clicking on its name.

n Accounts ’ =
Recently Viewed v N mpor

3 items + Updated a few seconds ago e-||=-|c s

ACCOUNT NAME v ACCOUNT SITE v PHONE v ACCOUNT OWNER ALIAS v

YDoga

YDoga

(336) 222-7000 YDoga

Figure 5-6
2. After clicking on the account in this page (Figure 5-6), which is “Smith Enterprises” in this

example, Smith Enterprises’ page will be opened. You need to click on the “Setup” icon ( 0 )
on the top right corner and choose “Edit Page” option. If you haven’t used Lightning
Experience at all, click on “Create Lightning Page” instead of “Edit Page”.
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i Setup
Developer Console
ct v
Edit Page
Edit Object
Figure 5-7

3. After clicking on “Edit Page” or “Create Lightning Page” “Lightning App Builder — New Account
Page” screen will be shown. You will see “Lightning Components” section on the left-hand
side. You need to scroll down to see the “SDrive” component, under “Custom”.
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ad| Report Chart

Rich Text

Tabs Sign Into link a Twltter profile, find

E Trending Topics

Pl Twitter

Visualfarce

¥ Custom (3)

ContactsToday
myEverythingComponent

n Opportunity Alert

¥ Custom - Managed (1)

SDrive

Figure 5-8

4. Grab the SDrive component and drag it to the right side where you see the components of the
account page. Drop wherever you want the S-Drive component to be placed. Note: if you do
not see the S-Drive component, you need to implement My Domain on your Salesforce Org.
My Domain is required to use this and other Salesforce features. See Salesforce Help: My

Domain for more information.
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il Lightning App Builder - New Account Page

e T e R e . e e . 1 T . 2 e A e
Lightning Components ] Page

Header and Right Sidebar

w Custom - Managg(1)

=g

Figure 5-9

5. Edit the following required fields correctly to create the S-Drive area for Account Files (or
Contacts, Cases, Opportunities, Leads)(Figure 5-10). You can also change the settings for a
selection of checkboxes which include: Enable copy URL, Enable delete, Enable download,
Enable edit, Enable e-mail, Enable upload, Enable folders, Enable private files, Enable Chatter,
Disable Cut Copy Paste. You can scroll down to see more settings for the S-Drive Lightning
component, such as showing folder tree component and breadcrumbs, which can be changed
by using the toolbar menu afterwards.

6. After clicking on “Save” button, you need to activate the page in order to use the S-Drive
component. You can click on “Activation” and choose “Assign as Org Default” or “Assign as
App Default” from the pop-up screen, in order to view the S-Drive component. Now, you
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should see “Account Files” page block at the end of the account object record page.

+| Enable Download — i ]

Title g v | Enable Edit h i)
I Account Files I
| Enable E-mail e i ]
Use Custom Logo on Header <l @ P
Default E-mail Address
Use Compact View = o
Parent Object Name o »| Enable Upload ‘ i ]
I Account I
| Enable Dropzone i o
Parent Object Prefix o )
Allowed File Extensions
File Object Name °
) | Enable Folders i i}
I AccountFile__c I
Enable Private Files * i ]
File Object Prefix L]
Enable Public Share s i)
CB__
| Enable Chatter e mm— i}
Relationship Field Name L]
Disable Cut Copy Paste et i ]
I Account__r I Py
Enable Shortcut Creation  wiffes @
Component Id L]
1 Default Sort Field Name o
cg__File_Name__c
| Enable Copy URL i i)
Default Sort Order o
v| Enable Delete * Li ]
asc -

Figure 5-10

Show Folder Tree .# i ]
Show Breadcrump e o

Open File After Clicking On Tt s @
Enable Field  ~<iffmmm— i ]

Set Component Visibility

The component attributes shown in Figure 5-10 are discussed in this section in detail:

1. Title

This is the title of the page block inside the object page. You can set it to “Account Files” (or
Case Files, Contact Files, etc.) This field is optional and if you don’t provide a value for this
field, it will be set to “S-Drive Files”.

2. Use Custom Logo on Header

Checking this box will enable inserting a custom logo. In order to enable this checkbox, add

your logo image to Static Resource with the name ‘SCustomLogo’ first. Note that Static

Resource should be public.
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3. Use Compact View
Checking this box will enable a compact view of S-Drive which will help users to fit S-Drive into
narrow spaces. In compact view, toolbar operations will be limited to the following: navigate to
Home, upload files, download files and folders, create folders, navigate to recycle bin.

4. Parent object name
This is the name of the object that the files will be attached to. For Account object, it will be
“Account”. For the other standard objects use Case, Contact, Opportunity or Lead.

5. Parent object prefix
This is the object’s namespace prefix that your Salesforce.com organization uses. For Account
and other standard objects, you do not need to add an object namespace prefix so leave this
field blank.

6. File object name
This is the name of the custom object S-Drive uses to hold the information regarding the
attached files. S-Drive comes with the custom File object associated with Account, Case,
Contact, Opportunity, and Lead. The object name is “AccountFile__c” (CaseFile__c,
ContactFile__c, OpportunityFile__c, or Lead_File_ c)

7. File object prefix
This is the file object’s namespace prefix that your Salesforce.com organization uses. If your
organization has a namespace prefix and you created this custom object file inside this
organization, your file namespace prefix is the same as your organization namespace prefix. If
this file object belongs to a managed package, you need to use that managed package’s
namespace prefix. For Account, Case, Contact, Opportunity, or Lead setitto “cg_ ”.

8. Relationship field name
Master-detail relation used for selected standard object. You need to fill it in as “Account__r

)

(Case__r, Contact__r, Opportunity__r, Lead__r)

9. Component Id
If multiple S-Drive components are used in a page, this attribute should be set to a unique key
for each component. For example: ‘1’, ‘a’, etc.
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10.

11.

12.

13.

14.

15.

16.

Enable copy URL

This option is used to enable/disable “Copy URL” link in the page. If the checkbox is checked,
you will be able to see the “Copy URL” link for each asset. The default value for this checkbox
is checked.

Enable delete

This option is used to enable/disable “Delete” option for all attachments in the page. If the
checkbox is checked, you will be able to see the “Delete” link for each asset. The default value
for this checkbox is checked.

Enable download

This option is used to enable/disable “Download” option for all attachments in the page. If the
checkbox is checked, you will be able to see the “Download” link for each asset. The default
value for this checkbox is checked.

Enable edit

This option is used to enable/disable “Edit” option for all attachments in the page. If the
checkbox is checked, you will be able to see the “Edit” link for each asset. The default value for
this checkbox is checked.

Enable e-mail

This option is used to enable/disable “E-Mail” option for all attachments in the page. If the
checkbox is checked, you will be able to see the “E-Mail” link for each asset. The default value
for this checkbox is checked.

Default email address

You can use this option, if you want to set a default “Additional To” email address for sending
emails from your S-Drive Attachments. For example, if you select an Account S-Drive
Attachment for an account and click “Email” button, “Email Files” screen will be opened and
“Additional To” field will be filled with the email address you have provided here.

Enable upload

This option is used to enable/disable “Upload” option for all attachments in the page. If the
checkbox is checked, you will be able to see the “Upload File(s)” link for each asset. The
default value for this checkbox is checked.
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17. Enable Drop Zone
This option is used to configure drop zone in S-Drive components. Select/deselect the
checkbox to enable or disable the drop zone.

18. Allowed file extensions
You can use this option, if you want to limit the file types to be uploaded into selected object’s
S-Drive attachments. Semicolon separated list of file extensions that are allowed to upload
can be written here. This attribute is optional and leaving this empty will allow all kind of files
to be uploaded. For example, “*.jpg, *.txt” will limit the files to be uploaded to jpg and txt
files.

19. Enable folders
This option is used to enable/disable folder support for S-Drive attachments in the page. If the
checkbox is checked, you will be able to see the “New Folder” button. The default value for
this checkbox is checked. If the box is not checked, the “New Folder” button will be removed
from the toolbar section.

20. Enable private files
This option is used for enabling public/private file access to the S-Drive attachments and
commonly used to limit the customer portal users’ access to individual files. The ability for
users to configure this is determined by the main configuration settings in S-Drive
Configuration Tab. If the checkbox is checked, you will see the public/private flag. Set this
attribute to true by checking the checkbox, if you want to enable private/public flag. Setting
the private flag on a file hides the file from customer portal users. The default value for this
checkbox is unchecked.

21. Enable Public Share
This option is used to configure public share in S-Drive components. Select the checkbox to
see Public Share option in Actions Menu. Deselect the checkbox to disable Public Share in
Actions Menu.

22. Enable Chatter
This option is used for enabling/disabling Chatter for Account files. If you enable this option,
you will be able to use functions such as ‘Post to Chatter’ and will be able to view the Chatter
feed of each Account file.
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23. Disable Cut Copy Paste
This option is used for enabling/disabling cut/copy-paste options. Set this attribute to true by
checking the checkboyx, if you want to disable cut/copy-paste operations.

24. Enable Shortcut Creation
This option is used to configure Shortcut Creation in S-Drive components. Select the checkbox
to see Create Shortcut button on toolbar. Deselect the checkbox to disable Create Shortcut
button on toolbar.

25. Default sort field name
This option is used to order/sort S-Drive documents based on a field. You need to set the
name of the field that should be used to order the list of files. For this example, it should be
filled in as “cg__File_Name__c”. You can change this option from the settings button located
at the toolbar of S-Drive attachments anytime. See “S-Drive Lightning User Guide” for more
information about using the S-Drive attachments.

26. Default sort order
This option is used to set the sort order direction of the S-Drive doucments. There are two
possible values for this attribute: “asc” or “desc”. The default value is “asc” which stands for
ascending. You can change this option from the settings button located at the toolbar of S-
Drive attachments anytime. See “S-Drive Lightning User Guide” for more information about
using the S-Drive attachments.

27. Files Count for A Page
This option is to set the number of files to be shown in an attachment page. The default value
for this section is set to 100. If this value is set to ‘30’ and object has 91 total items, the files
will be displayed in 4 pages. You can change this option from the pagination setting located
under the toolbar of S-Drive attachments. See “S-Drive Lightning User Guide” for more
information about using the S-Drive attachments.

28. Default view type
This option is to set the default view type of the file list table. There are 3 options you can
choose: List, Thumbnail and Grid. You can change this option from the toolbar of S-Drive
attachments and set it as default by using the settings button. See “S-Drive Lightning User
Guide” for more information about using the S-Drive attachments.
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29. Show Folder Tree
This option sets the default behavior of the folder tree component located on the left-hand
side of the S-Drive attachments page. You can choose to hide or show the Folder Tree
component by using the settings button on the toolbar of S-Drive attachments. See “S-Drive
Lightning User Guide” for more information about using the S-Drive attachments.

30. Show Breadcrumb
This option sets the default behavior of the breadcrumbs located on the left-hand side of the
S-Drive attachments page, above the folder tree component. You can choose to hide or show
the breadcrumbs by using the settings button on the toolbar of S-Drive attachments. See “S-
Drive Lightning User Guide” for more information about using the S-Drive attachments.

31. Open File After Clicking on It
This option is used to configure the behavior when a file is clicked on. Select the checkbox to
open the file when it is clicked on. Deselect the checkbox to go to the Details view of the file.

32. Enable Field
This option is used to configure Fields button on toolbar which is used to select and display
fields. Select the checkbox to enable the button on toolbar and deselect the checkbox to hide.
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5.3 S-Drive Compact View Configuration

In order to use S-Drive in narrow spaces in Lightning Experience, you can use the configuration option,
“Use Compact View” checkbox.

Title o
Account Files
Use Custom Logo on Header 0
» | Use Compact View i ]
Parent Object Name o
Account

Figure 5-11

The compact view enabled S-Drive component will look like the following:

£S5y Account Files

THUMBNAIL -~ FILE NAME DESCRIPTI... FILE SIZE CREATED ...

v CyanGate_ pptx 37.64 KB Yasemnin D...

| v Documents 0 bytes Yasemin D...

- v Fresh.jpg 12MB Yasemin D...
Figure 5-12

Note that the search bar is not available in compact view.
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In compact view, the number of fields that are shown in the file list is limited. As you configure your
fields in the S-Drive Configuration tab, the first four fields will be shown in the compact view, including

the File Name field.

STEP 1: STEP 2: Available Fields of Selected Object

Hidden Fields Displayed Fields
Account File Mame
Account File Name Description
Deleted File Size
Last Modified By ID Created By ID

Account File v Last Modified Date | L* ) | Tags (=]
Page Count 4 | | Created Date -

. = |l

Private
Record ID
Sync Id

System Modstamp

Figure 5-13

In a configuration like the figure above for Account Files, the following fields will be shown in the
component: File Name, Description, File Size and Created By ID.

5.4 S-Drive Email (Beta)

The Email Lightning component allows users to write emails with attachments of files from S-Drive.
You can place the email component to any lightning page with the Lightning App builder and attach
files of any file object type from any record. If you have Enhanced Emails enabled in your org, emails

sent from S-Drive email component will show up in your email Activity History.

Enabling S-Drive Email

Open the Lightning App Builder by clicking on the cog wheel at the top right corner of your Object

record page and click on "Edit Page".
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x @2 &8 @
$ Setup L1

Satup for current app

=+ Foliow New Contact e v
$ Service Setup

Developer Console

Edit Page

Search Edit Object a

Figure 5-14

Drag and drop the S-Drive E-Mail (Beta) component from the lightning components panel to your
desired location in the Lightning page editor.

“~ Custom (8)

Create Case With Attachments
EmailComponent
EmailConversation
LoockupForRecords
LookupForRecordsResult
S-Drive E-Mail (Beta)

S-Drive for File Objects

SDrive

Figure 5-15

6 DISPLAYING “S-Drive” AND “S-Drive Configuration” TABS

Display the S-Drive Tab and S-Drive Configuration tab for easy access.

6.1 Classic Tabs

To display "S-Drive" and "S-Drive Configuration" tabs in your custom app (e.g. "Sales" app) in Classic
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1. Goto User Menu on the top right corner and choose "My Settings” (Figure 6-1).

Yazemin Doganci +

My Profile
I My Settings I
Developer Console

Switch to Lightning Experience
Logout

Figure 6-1

2. Under “Display & Layout” tab, click on "Customize My Tabs" button.

[ Quick Fing | customize My Tabs
My Settings Choose the tabs that will display in each of your apps.
Custom App.
L Personal ‘ Site.com v
| Display & Layout |
- o Y Available Tabs Selected Tabs
App Launcher o Home (default) o
Customize My Tabs Assete Accounts
Campaigns Contacts
Customize My Pages Chalferg Add | Opportunities e
Console » Cases -
My Social Accounts and Content E Leads E
Contacts Contracts Remove | My Example Objects Down
o o Contribute My Example Object Files
coessibility D&B Companies
Dashboards
B4 Email Data com - -
C Chatter
Calendar & Reminders
[l Desktop Add-Ons
cf1 Import
Figure 6-2

3. Select your custom app from the "Custom App" drop down menu (e.g. "Sales" app). Move "S-
Drive" and "S-Drive Configuration" tabs from "Available Tabs" box to "Selected Tabs" box by
selecting and clicking the right arrow as shown below. Click "Save" (Figure 6-3).

26 All Rights Reserved - CyanGate LLC



“S\DRIVE

Customize My Tabs

Choose the tabs that will display in each of your apps.

Custom App:
Sales v
Available Tabs Selected Tabs
Leads & Home (default)
Macros Contacts
Lllei@ Assets Add Eampa\tgns Up
ositions ccounts
a
Price Books LLJ Opportunities u
Products 4] |Media Assets =
Reports Remove | TestObjects Down
S-Drive Mobile
Site.com S-Drive Configuration
Solutions
Streaming Channels v

\ Save | Cancel

6.2 Lightning Tabs

To display “S-Drive”, “S-Drive Configuration” and “S-Drive Advanced Search” tabs in Salesforce

Lightning

U

Figure 6-3

1. Click on “App Launcher” (%) menu which is on the left corner of the Salesforce page.
2. Click on “S-Drive: Simple Secure Storage for Salesforce Users” app (Figure 6-4).

v All Apps

App Launcher

Service
Manage customer service
with accounts, cont... More

=

‘R-*—'\'_:a Content
Salesforce CRM Content
L=
S-Drive
( S b Simple Secure Storage for
DRIVE Salesforce Users.
v All Items
Accounts App Launcher
Campaigns Cases
Dashboards

Duplicate Record Sets

Q. Find an app or item

Marketing Community

Best-in-class on-demand Salesforce CRM Communities

marketing automation

Sales Console
(Lightning Experience) Lets
sales reps work... More

Approval Requests

Chatter

Files

Service Console
(Lightning Experience) Lets
support agents ... More

Assets
Contacts

Forecasts

A

Visit AppExchange

Salesforce Chatter
The Salesforce Chatter social
network, incl... More

Sales
Manage your sales process
with accounts, le... Mare

Calendar

Contracts

Groups

Figure 6-4
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3. After clicking, you will return to your Home page in Salesforce, and you will be able to view the S-Drive
related tabs on top of the page.

. Search Salesforce

555 S-Drive Home S-Drive S-Drive Configuration S-Drive Advanced Search

Figure 6-5

7 S-DRIVE ADVANCED CONFIGURATION

7.1 Configuring S-Drive on Standard/Custom Objects

S-Drive can be used for uploading files to standard and/or custom object without any restriction. You
need to create objects and configure several settings manually to use these features.

Note that for Account, Case, Contact, Opportunity and Lead standard objects, the associated S-Drive
file objects and override pages are bundled with the S-Drive installation. If you’ll use S-Drive
attachments for these standard objects as override, you can use bundled objects and/or pages where
appropriate.

This section will guide you through how to create an S-Drive file object to go with the object you want
to use S-Drive with, and a how to display the S-Drive area on your object page.

7.1.1 Creating S-Drive File Objects
Every object you want to use S-Drive with must have an associated S-Drive File object with a master-

detail relationship where the file object is the detail. S-Drive can create this object for you.

Note: For Accounts, Cases, Contacts, Opportunities and Leads objects, S-Drive File Objects have
already been provided as part of the S-Drive package. For those, you can skip to section 4: Creating
Custom Object File Pages.

For this feature to be available, you must configure remote site settings. Go to Setup -> Security ->
Remote Site Settings and create a new remote site named anything let’s say “SDriveMeta” and copy
your organization domain for example as: “https://cgsdrive-dev-ed.my.salesforce.com”.

To create an S-Drive file object for your custom object, go to S-Drive Configuration -> Customization

Settings section.
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Custom Object S-Drive Config

Under the Custom Object S-Drive Config part of the page, user is expected to do the followings;

Object List: Objects of the organization except for custom file objects are listed in the list.

Related Objects: Any related object to the selected one on will be displayed related objects table, If there were no related object the table will be shown empty.
Custom File ObjectName: User is supposed to input the name of the file object.

Generate File Object: Used to create a custom file object which is related to the object selected in object list .

Object List
Mail Merge Template

My Example Object o
Name

Network

Network Member
Network Member Group
Note

Note and Attachment
Object Permissions
Open Activity

Oomsamansmite

cg__My_Example_Object_File__c e

Related Objects

Custom File ObjectName [My Example Object File o_'

Generate File Object

4

Figure 7-1

Scroll down to the Custom Object S-Drive Config part of the page and follow the steps below:

(1) "Object List": Objects of the organization except for S-Drive file objects are listed in the
dropdown menu.

(2) “Related Objects”: Any related object to the selected one on (1) will be displayed here.
(3) “Custom File ObjectName”: Choose a name for the new file object that is being created.

(4) “Generate File Object”: Click here to create a custom file object which is related to the object
selected in (1).

After creating the object, the user can now configure SDrive attachment with the object thanks to
automatically created file object.
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7.1.2 (Optional) Creating Before Delete Trigger for Custom Object

For Accounts, Cases, Contacts and Opportunities objects, these triggers have already been provided as
part of the S-Drive package. You can skip "Creating Before Delete Trigger for Custom Object" section
for these four standard objects and go to step 4: Creating Custom Object File Pages.

In this step we’ll create a before delete trigger for our custom object. This trigger is used to prevent
deletion of the object if it has custom object files in it. This step is an optional step, but we strongly
recommend creating this trigger. The following steps will explain the creation of the trigger:

1. Go to Setup -> App Setup -> Create -> Objects and click the label of your custom object
(Figure 7-2). (To create triggers on standard objects, go to Setup -> App Setup -> Customize ->
Standard Object Name (e.g. Solutions) -> Triggers.)

“ Anp successfully installs &
Edit | Del My Example Object v

Calid | Pnd by Fomumn i o ylnim [T ey oy

Figure 7-2

~,

2. Find "Triggers" page block in the opening page. Click New button to create a new trigger.
(Figure 7-3).

Triggers Quick Find New
0 ftemns, Sorted by Label
LABEL s  API VERSION SIZE WITHOUT COMMENTS MODIFIED BY

Figure 7-3
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Apex Trigger Edit Save | | Quick Save | | Cancel

Apex Trigger | Version Settings

Is Active (]
Q 5 @4 & A A

[trigger <name> on cg_r‘ly_Example_ObjectI_c (<events>») {

}

Figure 7-4

3. Make sure "Is Active" is checked in the "Apex Trigger Edit" screen (Figure 7-4). Type the
trigger codes defined below, inside the code block (Figure 7-4). Make sure you changed the
bold sections with your object name, object file name and namespace prefix. For our example
object YourObjectName will be "My_Example_Object",

NamespacePrefix will be "cg__ " and YourObjectFileNameContainingNamespacePrefix will be

“cg_ My _Example_Object_File_ c (Figure 7-5). Click Save button to create the trigger (Figure

7-4).

YourObjectNameContainingNamespacePrefix will be "cg__ My _Example_Object_ c"

QL 5> a4 A

hrigger My Example ObjectBeforeDelete on cg My Example Object_ c (before delete)
i

List<Id> ids = new List<Id>():

for (cg My Exsmple oObject_ o oh] : Trigger.old)
i

ids.add(obj. Id):
H

Integer tempCount =
[Felect count (] from cg_ My Example Chject_File c
where cg My Exawple Object File e.cg WIP o = false and
cg My Example Object _File c.ocg Parent o in :ids]:

if (LempCount > O)
i
Trigoger.old[0] .addErraor (' There are files attached to this obhject.' +
' Tou need to first delete object files mwanually and' +
' then delete the chiject!');

Figure 7-5
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trigger YourObjectNameBeforeDelete on
YourObjectNameContainingNamespacePrefix (before delete)

{
List<Id> i1ids = new List<Id>();

for (YourObjectNameContainingNamespacePrefix obj
Trigger.old)

{
ids.add (obj.Id);

Integer tempCount = [Select count() from
YourObjectFileNameContainingNamespacePrefix where
YourObjectFileNameContainingNamespacePrefix.NamespacePrefixWIP
c = false and
YourObjectFileNameContainingNamespacePrefix.NamespacePrefixParen

t ¢ in:ids];

if (tempCount > 0)
{
Trigger.old[0] .addError ('There are files attached to
object. You need to first delete files manually and then delete
the object!");

}

@ Notes

If you have a sandbox environment, and if you must create a test case in order to
deploy the trigger to your production organization, below is an example test class for
My_Example_Object custom object.
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BizTest
private class My _Example_Object Test {

static testMethod woid triggerTestl()
i

test.starttesti)

." cg_ My Exauple_Object_ c obj = new cg_ My Example Object_ c{):
obj.Namne = 'Test My Example Ohject':
insert obj:

\*cg_Hy_Example_Dbject_File_u: aFile = new cg_ My Exanple Object File_  ci):

aFile.cq  File Name ¢ = 'Test File':

aFile.cg_ WIF_ c = false;

aFile.cq_  Parent_c = obj.Id:

insert aFile:

try
{
delete obj;
systemn.assertifalse); //should newver happen

}

catch(Exception )

{
S¥STten.assertitrue) ; f/should fail

}
test.stoptesti);

After creating above test class and enabling the trigger, if you try to delete a My
Example Object which contains My Example Object Files, you’ll get this warning
message: "There are object files attached to this object. You need to first delete object
files manually and then delete the object!"

7.1.3 Creating Custom Object Files Page for Classic
In this fourth step we’ll create custom object file’s Visualforce page. This page can be used to
override the object’s view, or it also can be used as an inline section for the object’s layout. At the
end of this section, use cases for both scenarios will be displayed.

To create an object file page, follow these steps:
1. Go to Setup -> App Setup -> Develop-> Pages and click the New button at the top of the page
(Figure 7-6).

Visualforce Pages

Visualforce Pages provide a robust and easy to use mechanism to create new and exciting user experiences for your application or to enhance existing

View: | Al v | Create New View
A/B/CDIEIFIGIHIIIJ K

Developer Conscle | | New

Figure 7-6
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2. Inthe "Page Edit" screen you’ll create your new page. Give an appropriate name to your page.
For our example, we will use "MyExamplePage" name. Type "MyExamplePage" inside Label
field (Figure 7-7-a). Type "MyExamplePage" inside Name field (Figure 7-7-b).

Page Edit m m w Vi e s =Lkl | Component Reference
Page Information
Label | MyExamplePage e‘

Hame | MyExamplePage b
Description Nt ‘

Q =/ & A A

1 |capex:page>
C) 2| «<!-- Begin Default Content REMOVE THIS --»

Vo

<hl»Congratulations</hi>

This is your new Page

<!== End Default Content REMOVE THIZ -->»
<f’apex:page>|

Figure 7-7

You need to set the "Salesforce.com API" version to 22.0 or above to use S-Drive 2.0 features. To set
the version number click the "Version Settings" tab next to the "Visualforce Markup" tab and change
the version number from drop-down (Figure 7-8).

Visualforce Markup = Version Settings

Name Version Namespace Type
Salesforce.com API ( 220 E )] Salesforce.com API
Figure 7-8

Now we need to create our page content. We will be using custom components in our page.
Basically, our page skeleton will be as follows:

<apex:page standardController="My Example Object c"

tabStyle="My Example Object c">
<cg:AttachmentComponent
title="My Example Object Files"
customObjectName="My Example Object c"
customObjectFileName="My Example Object File c"
objectId="{!Id}"

objectNamespacePrefix="mynamespaceprefix "
fileNamespacePrefix="mynamespaceprefix "
enableCopyURL="true/false"
enableDelete="true/false"
enableDownload="true/false"
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enableEdit="true/false"
enableEmail="true/false"
enableUpload="true/false"
enableChatter="true/false"
inline="true/false"
inlineEdit="true/false"
legacyIdSupport="true/false"
privateEnabled="true/false"
orderBy="File Name c"
allowedFileExtensions="*.avi;*.txt"
defaultEmailAddress="user@company.com"
enableAttachFromSDriveFolders="true/false"
enableFolders="true/false"
relationshipName="Parent r"
pageSize="100"

useUploadAsPopup="true/false" />
</apex:page>

As an example, the following will be a typical custom override Visualforce page with inline
edits and chatter enabled:

<apex:page standardController="My Example Object c"
tabStyle="My Example Object c">
<apex:detail inlineEdit="true" relatedList="true"
showChatter="true"/>
<cg:AttachmentComponent
title="My Example Object Files"
inline="true"
customObjectName="My Example Object c"
customObjectFileName="My Example Object File c"
objectId="{!My Example Object c.Id}" />
</apex:page>

You need to set these component attributes based on your configuration. Let’s discuss these
component attributes:

a) standardController
You need to set this standard controller to the object that you want to use with. For our
example this is the custom object name that we created: "My_Example_Object__c". As
you can see from the example we appended " c" to the end of the name. This means this
object is a custom object. You can use standard objects also. For standard objects you will
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not append "__c" at the end of the object name (e.g. Solution). Also, do not prepend your
account’s namespace prefix.

b) tabStyle
This is the tab style of the page. Normally you can set it same with standardController.
That means tab style will be derived from the standard controller you chose.

c) title (optional)
This is the title of the page block inside the object page. You can set it to "Custom Object
Name" Files. For our example it will be "My Example Object Files". This field is optional
and if you don’t provide a value for this field, it will be set as "Attached Files".

d) customObjectName
This is the name of the custom or standard object that will be the object that the files will
be attached to. For our example, it is "My_Example_Object__ c". If this is a custom object
you need to append " c" to the end of the name. If this is a standard object you won’t
append"__c" at the end of the object name (eg. Solution). Also do not prepend your
account’s namespace prefix.

e) customObjectFileName
This is the name of the S-Drive file object that we created in previous sections. This object
holds the information regarding the attached files. For our example, it is

"My_Example_Object_File__c".

f) objectld
You need to pass in the "{!ld}" value for this attribute. This attribute is required to retrieve
object id.

g) objectNamespacePrefix (optional)
This is the object’s namespace prefix that your Salesforce.com organization uses. If your
organization has a namespace prefix and you created this custom object inside your
organization, your object namespace prefix is same as your organization namespace
prefix. If this object belongs to a managed package, you need to use that managed
package’s namespace prefix. If your object does not belong to any namespace you do not
need to set this attribute. If your namespace prefix is "exampleprefix" you need to set

objectNamespacePrefix as "exampleprefix__".
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h) fileNamespacePrefix (optional)
This is the file object’s namespace prefix that your Salesforce.com organization uses. If
your organization has a namespace prefix and you created this custom object file inside
this organization, your file namespace prefix is same with your organization namespace
prefix. If this file object belongs to a managed package, you need to use that managed
package’s namespace prefix. If your file object does not belong to any namespace you do
not need to set this attribute. If your namespace prefix is "exampleprefix" you need to set

fileNamespacePrefix as "exampleprefix__".

i) enableCopyURL (optional)
This option is used to enable/disable "Copy URL" link in the page. There are two possible
values for this attribute: "true", "false". If "false" is set "Copy URL" links won’t be
displayed in this page. This field is optional and if you don’t provide a value for this field, it
will be set as "true", therefore "Copy URL" link will be visible for each asset. Note that
security and permission settings override this option.

j) enableDelete (optional)
This option is used to enable/disable "Del" links for all attachments in the page and
"Delete Selected" button for the whole page. There are two possible values for this
attribute: "true", "false". If "false" is set "Del" links and "Delete Selected" button won’t be
displayed in this page. This field is optional and if you don’t provide a value for this field, it
will be set as "true" therefore, "Del" links and "Delete Selected" button will be visible.
Note that security and permission settings override this option.

k) enableDownload (optional)
This option is used to enable/disable "Download", “Open” and “Zip & Download” for all
attachments in the page. There are two possible values for this attribute: "true", "false".
If "false" is set "Download", “Open” and “Zip & Download” won’t be displayed in this
page. This field is optional and if you don’t provide a value for this field, it will be set as
"true" therefore, "Download", “Open” and “Zip & Download” links will be visible for each
asset. Note that security and permission settings override this option.

1) enableEdit (optional)
This option is used to enable/disable "Edit" link for all attachments in the page. There are
two possible values for this attribute: "true", "false". If "false" is set "Edit" links won’t be
displayed in this page. This field is optional and if you don’t provide a value for this field, it
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will be set as "true" therefore, "Edit" links will be visible for each asset. Note that security
and permission settings override this option.

m) enableEmail (optional)
This option is used to enable/disable "Email Selected" button in the page. There are two
possible values for this attribute: "true", "false". If "false" is set "Email Selected" button
won’t be displayed in this page. This field is optional and if you don’t provide a value for
this field, it will be set as "true", therefore "Email Selected" button will be visible for each
asset. Note that security and permission settings override this option.

n) enableUpload (optional)
This option is used to enable/disable "Upload File(s)" button in the page. There are two
possible values for this attribute: "true", "false". If "false" is set "Upload File(s)" button
won’t be displayed in this page. This field is optional and if you don’t provide a value for
this field, it will be set as "true", therefore "Upload File(s)" button will be visible for each
asset. Note that security and permission settings override this option.

o) enableChatter (optional)
This option is used to enable/disable Chatter related activities for files. There are two
possible values for this attribute: “true”, “false”. If “false” is set, “Post to Chatter” and
Chatter Feed won't be displayed in the page. This field is optional and if you don’t provide
a value for this field, it will be set as “true”, therefore the “Post to Chatter” button and
Chatter Feed in the details page will be displayed for each asset. Note that security and
permission settings override this option.

p) inline (optional)
This option is used to decide if the page is used with override for the view or as a section
in the page layout. There are two possible values for this attribute: "true", "false". Set this
attribute to "true" to use this component inside an inline Visualforce page. The default for
this attribute is false. One important note about "inline" is it needs to be set to true for
"typical custom override Visualforce page with inline edits and chatter enabled" example
because of a bug related to Salesforce.com.

q) inlineEdit (optional)
This option is used to decide if the inline edit feature will be available for the other parts
of the page or not. If inline option is set to true, inlineEdit option is ignored, meaning that
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inlineEdit feature can only be used when the view of the object is overridden. So, you
cannot use this option with the use as inline attachment feature. There are two possible
values for this attribute: "true", "false". Set this attribute to "true" to enable the inlineEdit
feature for the Visualforce page. Also note that this feature is supported for the pages
with version 21.0 and above (Spring 2011). The default for this attribute is false.

There are three possible scenarios for the usage of the inlineEdit:

1- Ifinline is set to true (using inline attachment feature), inlineEdit’s value does not have
any meaning (it is ignored).

2- Ifinline is set to false (default is false, using with the override for the view of the
object), and we set inlineEdit to true, it means inline editing for the page elements is
enabled.

3- Ifinline is set to false (default is false, using with the override for the view of the
object), and we set inlineEdit to false, it means inline editing for the page elements is
disabled.

r) legacyldSupport (optional)
This option is used for legacy id support. There are two possible values for this attribute:
"true", "false". Set this attribute to true to use 18-character ids. The default for this
attribute is false.

s) privateEnabled (optional)

This option is used for enabling public/private file access to the S-Drive attachments and
commonly used to limit the customer portal users’ access to individual files. Before setting
this property, you need to add a new field to your custom object file named ‘Private’ (See

‘Creating Custom Obiject Files’ section for more information). Set this attribute to true if
you want to enable private/public flag. Setting the private flag on a file hides the file from
customer portal users. There are two possible values for this attribute: "true"”, "false". The

default for this attribute is "false" except for the Case Files custom page (
Figure 7-9).
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Figure 7-9

orderBy (optional)

This option is used to order/sort S-Drive attachments based on a field. You need to set the
name of the field that should be used to order the list of files with namespace prefix. This
attribute is optional and leaving this empty will not order the results in any specific order.
For example: "cg__ File_Name__c". With S-Drive 1.18, dynamic ordering is possible, so
you can set this value to set out-of-the-box ordering and users can order items on-the-fly.

Note that Salesforce does not allow Long Text Area fields to be ordered/sorted. So, if you
want to order/sort by a long text are field (e.g. Description__c), you need to change its
type from ‘Long Text Area’ to ‘Text Area’. This will limit your description to be 255
characters long.

allowedFileExtensions (optional)

You can use this option if you want to limit the file types to be uploaded into selected
object’s S-Drive attachments. Semicolon separated list of file extensions that are allowed
to upload. This attribute is optional and leaving this empty will allow all kind of files to be
uploaded. For example: "*.jpg;*.txt" will limit the files to be uploaded to jpg and txt files
(Figure 7-10).
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Figure 7-10

v) defaultEmailAddress (optional)
You can use this option, if you want to set a default "TO" email address for sending emails
from your S-Drive Attachments. This option is automatically set for out of the box Contact,
Opportunity, Case and Account S-Drive Attachments.
For example, if you select a Contact S-Drive Attachment for a contact and click "Email
Selected" button, "Email Files" screen will be opened and "To..." field will be filled with
the contact name as shown below:

Ernail Filez \'

[ To... J |Umut Dogan | [ Clear ]

[ Additional To... ]|

If default email address is not found in your Salesforce Contacts, that email will be set to
the "Additional To..." section of the "Email Files" page. These "To..." or "Additional To..."
fields are auto-filled when "Email Files" page is loaded. You can clear them and/or select
other contacts as you wish.

w) enableAttachFromSDriveFolders (optional)
This option is used to enable/disable "Attach from S-Drive Folders" button in the page.
There are two possible values for this attribute: "true", "false". If "false" is set "Attach
from S-Drive Folders" button won’t be displayed in this page. This field is optional and if
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you don’t provide a value for this field, it will be set as "true"; therefore "Attach from S-
Drive Folders" button will be visible for each asset. Note that security and permission
settings override this option. Also note that "Attach from S-Drive Folders" button is not
visible for customer portal users, no matter what the enableAttachFromSDriveFolders
value is.
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x) enableDownloadManager (optional)
Download Manager has been deprecated. Zip & Download can be used instead of
download manager. You can control it using enableDownload flag.

y) enableFolders (optional)
This option is used to enable/disable folders support for S-Drive Attachments. Set this
attribute to false to disable folders. If you disable folders for S-Drive Attachments, "New
Folder" button and breadcrumb will be removed from the buttons section. This
configuration won't hide/delete currently created folders. The default for this attribute is
true.

z) relationshipName (optional)
Master-detail relation used for selected standard/custom object. This attribute is optional

and default value is 'Parent__r'.

aa) pageSize (optional)
Page size for pagination. Attachment items will be paginated based on this value. So, if
this value is set to '30', and object has 91 total items, 4 page will be displayed. This
attribute is optional and default value is 100.

Home C Total ltems: 91 Page:1 |2 3| |4 g

D Actions T File Name# Created By ID Created Date Description File Size
[T Edit| Del Documents Umut Dogan 8122011 3:48 AN 0 bytes

bb) enablelavaUpload (optional)
Java upload has been deprecated.

@ Note

This setting won't work if HTML is selected for Default Upload Manager in S-Drive
Configuration tab. We strongly suggest using HTML upload.

cc) useUploadAsPopup (optional)
Set this attribute to true to enable upload widget as a popup window for selected S-Drive
Attachment object. The default for this attribute is false. This value overrides the "Default
Upload Manager" configuration in "S-Drive Configuration".
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If you want to get more information about component attributes, you can click "Component
References" button and find cg:attachmentcomponent reference from the list. (Figure 7-7-d).

After setting the page based on above component attributes, click "Save" button.

3. Lastly set the security for your page on other profiles. Go to Setup -> App Setup -> Develop ->
Pages and click Security link next to your page name (Figure 7-11).

EONT [ DT MPaE Tg 7o

Edit | MyExampleFage IMyExamplePags cg 17.0

Edit | Security - OpportunityFilePage OpportunityFilePage cq 17.0
Figure 7-11

Move all profiles (or select based on your needs) from "Available Profiles" to "Enabled
Profiles" as shown in Figure 7-12. If you skip this step, your users that belong to the disabled
profiles will see an error page similar to Figure 7-13.

Enable Profile Access for Visualforce Page
MyExamplePage

Available Profiles Enabled Profiles

Systern Administrator
Cloned Standard

-~MNaone--

R A Contract Manager
Customn: Marketing Profile
) "R Il Custom: Sales Profile
Custom: Support Profile
@ Customer Portal Manager
Marketing User
Remove

Partner User

Portal Manager Clone
Read Only

Solution Manager
Standard Platform User
Standard User

Figure 7-12

Insufficient Privileges

*fou do not have the level of access necessary to petform the operation you requested. Please contactthe owner of the record or your administrator if access is necessary

Figure 7-13

4. Now we have an object (or created our custom object), created our custom object file and
custom object file page.
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At this point, we can override the custom object’s view or we can use S-Drive Attachments as

an inline section in the page layout.

e Qverriding the View of the Object

"Overriding the view of the object" means that the page will be used as an override to the
standard object page. In this case, the S-Drive Attachments section will be a section at the
end of the standard page layout.

5. Go to Setup -> App Setup -> Create-> Object and click the label of your custom object.
You'll see "Object Definition Detail" screen. Scroll down and find "Standard Buttons
and Links" page block and click Edit action next to the View label (Figure 7-14-a). Then
select Visualforce Page for Override With section and pick MyExampleFilePage (the
custom page you created previously for this object) from the drop-down box. Click
Save button to complete the override (Figure 7-14-b).

Standard Buttons and Links Override Properties save | [Cancel
Action Label Name Overridden 7 —
Edit  MyExample Objects Tab Tab ) UED
ot List List Hame  View
Default  Standard Salesforce.com Page

View View Override With = No Override (use default)
Eqit  Edit Edit \ © Custom 8-Control | —None— =]
Edit  Delete Delete C.@ Visualforce Page | MyExamplePage [cg_MyExamplePage] )
Edit  Clone @ Clone Comment Q’}

Figure 7-14

6. Now it will display View as Overridden in the Standard Buttons and Links section
(Figure 7-15).

Standard Buttons and Links
Action Label Name Overridden Display
Edit My Example Objects Tab Tab Standard Salesforce.com Page
Edit  List List Standard Salesforce.com Page
Edit  Wiew WView v ( MyExamplePage (Visualforce Page) )
Figure 7-15

7. After creating a test object, you should see "My Example Object Files" page block at
the end of the object detail page (Figure 7-16). See "User Guide" for more information
on how to use the buttons and functions in this page block.
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My Example Object Files Hew Folder | |Upload File(s) | Attach from S-Drive Folders | |Email Selecied |Delete Selected |Download Manager

Nao records to display

Figure 7-16
e Using as Inline Attachment

"Using as inline Attachment" means that the attachment component will be used as a
section in the object’s page layout. So, your customizations to the page layout won’t be
affected and you can append S-Drive Attachments in the page layout anywhere you would
like. Please note that "inline" component attribute for the custom page must be set to

"true" to use the S-Drive Attachments as inline.

1. Go to Setup -> App Setup -> Create-> Object and click the label of your custom object.
You'll see "Object Definition Detail" screen. Scroll down and find "Page Layouts" page
block and click Edit action next to the main layout of the object (Figure 7-17).

Page Layouts m

ctlion Pape Layout Hame

Edit |Del  Test Ohject Layout

Figure 7-17

2. Click Fields and drag-drop a Section to an appropriate place in the layout (Figure

7-18).
Test Object Layout ™
Save ¥ Quick Save Preview As.. ¥ | Cancel 4 Undo H
(&, Quick Find | Ficld MNarme
ElluﬂDnS I Elank Space Qhwmer
Wisualforce Pages B Section Test Obje
Custom S-Controls Crasted By
Figure 7-18

3. After dropping the "section", you'll see the properties screen for the dropped
"section". Type in a section name and select if you want to display section header on
"Detail Page" and "Edit Page". Also select "1-Column" for the layout. Then click OK
button. You can customize these settings based on your layout needs (Figure 7-19).
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Section Properties

Section Name | 5-Drive Attachmerts

Display Section Header On [ Detail Page

Layout

\O [

@ 1-Column O 2-Colurmn

Figure 7-19

4. Now, go to Visualforce Pages from the top. Select the "custom page name" you

created (e.g. TestPage) and drag it into the section that you created previously (Figure
7-20).

Save ¥ | Quick Save | Preview As... ¥ | Cancel £ Undo | "4 Redo = Layout

Fields
Buttons HF]Elznk Space
‘ \ |+B Sectian
Custom S-Contrals Test Page
Related Lists

@, auick Find| Page Mame | %

Test Object Sample

Test Object Detail

T

51 Test Object Humber N-2004-001234

& Created By

le User

o= -

Figure 7-20

5. After dropping the page into the section, click the properties icon for the page on the
top-right corner of the page in the section (Figure 7-21).
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Figure 7-21

6. Keep "Width (in pixels or %)" as "100%", set "Height (in pixels)" to "500". And check
"Show scrollbars" option. You can optionally check "Show label". Click OK button
(Figure 7-22).

Custom S-Control Properties

wickh (in pixels or %1 |100% |

Height [in pixels]): SO0

Show serollbars: V

Shows label : I:‘

Figure 7-22

7. You can use "Inline Visualforce Expander" tool to automatically resize inline S-Drive
page based on the size. So if you apply this tool to inline S-Drive Attachments page,
page's height will be dynamic based on the number of items in the list. For this type of
a configuration we suggest you to set the "useUploadAsPopup" attachment
component property to set "true". You can install the "Inline Visualforce Expander"
from AppExchange:
http://appexchange.salesforce.com/listingDetail ?listingld=aON30000004cEEYEAM
And you can download the installation/configuration document here:
http://appexchange.salesforce.com/servlet/servlet.FileDownload?file=00P30000007K
casEAC

Final result will be like below screen:
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Active
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Account Files

Actions

Download | Copy URL | Edit | Del

Download | Copy URL | Edit | Del

Download | Copy URL | Edit | Del

Upload File(s) Attach from S-Drive Folders

Email Selected

Created Date

10/9/2012 7:00 AM
10/8/2012 4:58 AM
10192012 7.01 AM

Created By ID

Total ltems: 5 Page: 1 |2

John Resig
John Resig

John Resig

File Size
61.64 KB
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1.49 KB
Total items: 5 Page: 1 2 /

8. We are done with the configuration. Save the layout by clicking the "Save" button on
the left-top corner of the screen (Figure 7-18).

9. Now if you go to your object’s tab (page), you’ll see the S-Drive Attachments inline in

the page layout (Figure 7-23).

Test Object Files

Upload File{s) | | Attach from S-Drive Folders | Email Selected || Delete Selected

7.2 Creating Lightning Page

Figure 7-23

With 2.0 release, S-Drive is available for Lightning Experience. In this section, you can learn about
creating lightning page for custom objects. To create a lightning page. This is the same process
used in section 5.2 S-Drive File Area for Lightning (Accounts, Cases, Contacts, Opportunities,

Leads)

1. You need to switch to Lightning Experience and open Lightning App Builder. To open
it, you should open a record from your custom object (My_Example_Object__c) and
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click on “Create Lightning Page” link under Setup” icon ( 13' ). If you already have a

Lightning Page, you should click on “Edit Page” link under c Setup” icon ( @ ). See the
figure below.

‘ Search Salesforce E m % v L ? $ A ', ,‘
-
see
ess  S-Drive Home S-Drive S-Drive Configuration S-Drive Advanced Search )
eoe Lod setup
T2 T 2 N\ 7 S T2 (R WA\ a

Developer Console

+ Follow E w
Pﬂm—_—mﬂ—T_m Edit Object -
RELATED DETAILS / ACTIVITY CHATTER

|

My Example Object
1

My Example Object Name
1

Activity Timeline Y| ¢ Expand All
Formula Testt
2.00 Next Steps
Created By Last Modified By No next steps. To get things moving, add a task or set up a
e = meeting

Figure 7-24

2. After clicking on “Edit Page” or “Create Page” option, “Lightning App Builder” will be
shown. You will see “Lightning Components” section on the left-hand side. You need
to scroll down to see the “SDrive” component, under “Custom”.
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3.

il Lightning App Builder - My Example Object Record Page

O Desktop

Lightning Compenents ¢

Search components...

5;:_-,<: Related Record i

ad Report Chart

Rich Text
Tabs

E Trending Topics

Visualforce

¥ Custom (1)

SDrive

¥ Custom - Managed (0)

No components available.

Figure 7-25

Grab the S-Drive component and drag it to the right side where you see the
components of the account page. Drop wherever you want the S-Drive component to
be placed.

& Back 7 Help

Record Page

Object

Account

Header and Right Sidebar

Description

Activation...

Figure 7-26
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4. You need to edit the following required fields correctly, to configure S-Drive for your
custom object in Lightning Experience (Figure 48). You can also change the settings
from a selection of checkboxes which include: Enable copy URL, Enable delete, Enable
download, Enable edit, Enable e-mail, Enable upload, Enable folders, Enable private
files. You can scroll down to see more settings about the S-Drive Attachment
component, such as showing folder tree component and breadcrumbs, which can be
changed by using the toolbar menu afterwards.

5. After clicking on “Save” button, you need to activate the page to use the S-Drive
component. You can click on “Activation” and choose “Assign as Org Default” or
“Assign as App Default” from the pop-up screen, to view the attachment component.
Now, you should see “My Example Object Files” block at the end of my example
object record page. See "Lightning User Guide" for more information on how to use
the buttons and functions in this block.
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Note: If you want to enable multiple S-Drive components in one, single Lightning page, just
repeat steps 3-5. But fill your “Component Id” section with another unique number.
“Component Id” section is described in point (h), in the section below.

Place another S-Drive component from the Lightning Components section.

o x @
Lightning Companents (] Page » SDrive
Search components

Account Files

Jse Custom Logo on Heade L]
s, Account Files Sewich a
parent Object Name °
0 omsomos commmomooomo ||
T Recycle Bin i Parent Otject Prefix o

AccountFile__c

v custom (6)
®_
CaseCommunityStaticForm
N Cosecormmatiysiatcor £s, S-Drive Files in Account
°
m“'l"'l [2fa-] Ihl ] Iz BRI
HOME
L au Show 100 per p o
[sDrive (cg) ! (@ o recorssfoun
w Custom - Managsd (0) -] o
Enable Copy URL
Mo components avallable
- e o
[

Figure 7-27

The component attributes shown in Figure 7-28 are discussed in this section below in detail:
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age » SDrlve

My Example Object Flles
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Parant Object Mame

n Enable Copy URL

n Enable Dealat

mn

n Enable Download

Drefault Sort Fleld Mame

cg _Flle_Mame_cC

Ny Examiple_Cblect__c n Enable Edlt asc
Parent Oblact Prefix 1] Flles Count For A Pag 0
TR S B crsbie E-mall 0 e Ak ootz
cE__ 100
Diefault E-mall Address o
Flle Object Mame 0 Default View Type 0
My _Example_Ohbject_Fle_ c list -
B Ensble Upload o
Flle Objact Prafix L 3 Show Folder Tree 1]
Allowed Flle Extenslons 0
cg
Show Breadcrumb L ]
Relatlonship Fleld Mame i
= = pen Fle After Clicking On It
B Ensbie Folders o Dipen Fle Affe = I o
Parent__r
. Enable Private Alles o w Set Component Visibility
Component Id L] s
FRiters
B Ensbie Chatter 0 + Add Hite

Figure 7-28

a) Title (optional)
This is the title of the page block inside the object page. You can set it to “My Example Object
Files”. This field is optional and if you don’t provide a value for this field, it will be set as “S-
Drive Files”.

b) Use Custom Logo on Header
Checking this box will enable inserting a custom logo. In order to enable this checkbox, add
your logo image to Static Resource with the name ‘SCustomLogo’ first. Note that Static
Resource should be public.
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c) Parent object name
This is the name of the custom or standard object that will be the object that the files will be
attached to. For our example, it is "My_Example_Object__c". If this is a custom object you
need to append " c" to the end of the name. If this is a standard object you won’t append

__c" at the end of the object name (eg. Solution). Also, do not prepend your account’s
namespace prefix.

d) Parent object prefix (optional)
This is the object’s namespace prefix that your Salesforce.com organization uses. If your
organization has a namespace prefix and you created this custom object inside your
organization, your object namespace prefix is same with your organization namespace prefix. If
this object belongs to a managed package, you need to use that managed package’s
namespace prefix. If your object does not belong to any namespace you do not need to set this
attribute. If your namespace prefix is "exampleprefix" you need to set objectNamespacePrefix

as "exampleprefix__".

e) File object name
This is the name of the S-Drive file object that we created in previous sections. This object holds
the information regarding the attached files. For our example, it is
"My_Example_Object_File_ c". Do not prepend your account’s namespace prefix.

f) File object prefix (optional)
This is the file object’s namespace prefix that your Salesforce.com organization uses. If your
organization has a namespace prefix and you created this custom object file inside this
organization, your file namespace prefix is same with your organization namespace prefix. If
this file object belongs to a managed package, you need to use that managed package’s
namespace prefix. If your file object does not belong to any namespace you do not need to set
this attribute. If your namespace prefix is "exampleprefix" you need to set File object

namespace prefix as "exampleprefix__".

g) Relationship field name
Master-detail relation used for selected standard/custom object. This attribute is optional and

default value is 'Parent__r'.

h) Component Id
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If multiple S-Drive components are used in a page, this attribute should be set to a unique key
for each component. For example: ‘1’, ‘a’, etc.

i) Enable copy URL (optional)
This option is used to enable/disable “Copy URL” link in the page. If the checkbox is checked,
you will be able to see the “Copy URL” link for each asset. The default value for this checkbox is
checked.

i) Enable delete (optional)
This option is used to enable/disable “Delete” option for all attachments in the page. If the
checkbox is checked, you will be able to see the “Delete” link for each asset. The default value
for this checkbox is checked.

k) Enable download (optional)
This option is used to enable/disable “Download”, “Open” and “Zip & Download” options for
all attachments in the page. If the checkbox is checked, you will be able to see the “Download”
link for each asset. The default value for this checkbox is checked.

1) Enable edit (optional)
This option is used to enable/disable “Edit” option for all attachments in the pagelf the
checkbox is checked, you will be able to see the “Edit” link for each asset. The default value for
this checkbox is checked.

m) Enable e-mail (optional)
This option is used to enable/disable “E-Mail” option for all attachments in the page. If the
checkbox is checked, you will be able to see the “E-Mail” link for each asset. The default value
for this checkbox is checked.

n) Default email address (optional)
You can use this option, if you want to set a default “Additional To” email address for sending
emails from your S-Drive Attachments. For example, if you select an Account S-Drive
Attachment for an account and click “Email” button, “Email Files” screen will be opened and
“Additional To” field will be filled with the email address you have provided here.

o) Enable upload (optional)
This option is used to enable/disable “Upload” option for all attachments in the page. If the
checkbox is checked, you will be able to see the “Upload File(s)” link for each asset. The default
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value for this checkbox is checked.

p) Allowed file extensions (optional)
You can use this option, if you want to limit the file types to be uploaded into selected object’s
S-Drive attachments. Semicolon separated list of file extensions that are allowed to upload can
be written here. This attribute is optional and leaving this empty will allow all kind of files to be
uploaded. For example, “*.jpg, *.txt” will limit the files to be uploaded to jpg and txt files.

q) Enable folders (optional)
This option is used to enable/disable folder support for S-Drive attachments in the page. If the
checkbox is checked, you will be able to see the “New Folder” button. The default value for this
checkbox is checked. If the box is not checked, the “New Folder” button will be removed from
the toolbar section.

r) Enable private files (optional)
This option is used for enabling public/private file access to the S-Drive files and commonly
used to limit the customer portal users’ access to individual files. Set this attribute to true by
checking the checkbox, if you want to enable private/public flag. Setting the private flag on a
file hides the file from customer portal users. The default value for this checkbox is unchecked.

s) Enable Chatter
This option is used for enabling/disabling Chatter for Case files. If you enable this option, you
will be able to use functions such as ‘Post to Chatter’ and will be able to view the Chatter feed
of each Case file.

t) Default sort field name (optional)
This option is used to order/sort S-Drive attachments based on a field. You need to set the
name of the field that should be used to order the list of files. For this example, it should be
filled in as “cg__File_Name__c”. You can change this option from the settings button located at
the toolbar of S-Drive attachments anytime. See S-Drive Lightning User Guide for more
information about using the S-Drive attachments.

u) Default sort order (optional)
This option is used to set the sort order direction of the S-Drive attachments. There are two
possible values for this attribute: “asc” or “desc”. The default value is “asc” which stands for
ascending. You can change this option from the settings button located at the toolbar of S-
Drive attachments anytime. See S-Drive Lightning User Guide for more information about using
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the S-Drive attachments.

v) File count in a page (optional)
This option is to set the number of files to be shown in an attachment page. The default value
for this section is set to 100. If this value is set to ‘30’ and object has 91 total items, the files will
be displayed in 4 pages. You can change this option from the pagination setting located under
the toolbar of S-Drive attachments. See S-Drive Lightning User Guide for more information
about using the S-Drive attachments.

w) Default view type (optional)
This option is to set the default view type of the file list table. There are 3 options you can
choose: List, Thumbnail and Grid. You can change this option from the toolbar of S-Drive
attachments, and set it as default by using the settings button. See S-Drive Lightning User Guide
for more information about using the S-Drive attachments.

x) Show Folder Tree (optional)
This option sets the default behavior of the folder tree component located on the left-hand
side of the S-Drive attachments page. You can choose to hide or show the Folder Tree
component by using the settings button on the toolbar of S-Drive attachments. See S-Drive
Lightning User Guide for more information about using the S-Drive attachments.

y) Show breadcrumb (optional)
This option sets the default behavior of the breadcrumbs located on the left-hand side of the S-
Drive attachments page, above the folder tree component. You can choose to hide or show the
breadcrumbs by using the settings button on the toolbar of S-Drive attachments. See S-Drive
Lightning User Guide for more information about using the S-Drive attachments.

z) Open File After Clicking on It
This option sets the file behavior when it is clicked on. If you want to open a file when it is
clicked on, mark this checkbox as checked. If you want to preview a file when it is clicked on,
mark this checkbox as unchecked.

7.2.1 Configuring S-Drive for File Objects Component for Object File Record Page

Every object that uses S-Drive, whether standard or custom, has a File Object associated with it.
Accounts has AccountFiles. Cases has CaseFiles, etc. When you use S-Drive on a custom object,
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you create a custom file object. The tab for the file object shows a list view of documents

uploaded to S-Drive for that object. If you click on a record in the list view, it will show information
about the document, but there’s no access to the document itself. In order to be able to get to the
document from the list view record, you need to edit the Lightning page to add the S-Drive for File

Objects component. This component provides easier access to any S-Drive file or folder through
the record page of the file, with “Open in S-Drive” button. This button redirects the user to S-

Drive and opens the file or folder’s detail page.

To configure your Object File Record Page with the S-Drive for File Objects component, go to any
file object tab (Account Files, etc) and select a record.

& File

Folder 1
0 bytes

Details  [§ Account

Folder 1
2018-05-25 07:19:46

Yasemin Doganci

T ;,FI 0 bytes
3

@ Open in S-Drive

Click on “Edit Page” setting to see the Lightning App Builder for the Object File Record Page.

Figure 7-29
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The required fields to be filled in are:

1. Parent Object’s S-Drive Component Id: If S-Drive component on parent object’s
record page has an Id, it should be defined here for S-Drive Component to
recognize. For example: If S-Drive on Account has ‘1’ as component id, S-Drive File
component should have ‘1’ in this field.

2. Parent Object Title: Title for parent object detail tab. For example: ‘Account’.
3. Parent Object Name: APl Name of the custom object that the files will belong to.
This object can also be one of the standard objects such as Solutions or Products.

For example: ‘MyObject__ ¢’ or ‘Solution’.

4. Parent Object Prefix: Namespace prefix for the parent object for the attachments.
This attribute is required if the object has a namespace. For example: ‘cg_’

5. File Object Title: Title for file detail tab. For example: ‘Account File’.

60 All Rights Reserved - CyanGate LLC



£S:DRIVE CyanGate

6. File Object Name: APl Name of the custom object that will represent the file. This
custom file object is required to include fields indicated in the installation guide of

7

S-Drive. For example: ‘MyFile__c’.

7. File Object Prefix: Namespace prefix for the file object. This attribute is required if
the object has a namespace. For example: ‘cg_ ’

8. Relationship Field Name: Master-detail relation used for selected
standard/custom object. For standard objects, this is Account__r, Case__r,
Contact__r, etc. For custom objects, it is ‘Parent__r’.

After configuring these fields, you can use your S-Drive For File Object’s component to reach your
S-Drive files and folders with one click of a button.

7.3 Creating Custom HTML Upload Page

You can create S-Drive HTML Upload Widget Page for custom object files (cg__ S30bject_ ¢,

cg_ CaseFile__c, MyExampleObject__c, etc.). This page can be used to add the S-Drive HTML
upload widget to the place wherever you want. So, you can upload your files to "S-Drive Folders"
or "S-Drive Attachments" easily without opening object's page and clicking "Upload file(s)" button.
To create a custom HTML upload page, follow these steps:

1. Go to Setup -> App Setup -> Develop-> Pages and click the New button at the top of the page
(Figure 7-31).

Visualforce Pages

Visualforce Pages provide a robust and easy to use mechanism to create new and exciting user experiences for your application or to enhance exig

\ AlBlc|D/E[FIGIH

Developer Console |  New

View: | Al v | Create New View

Action Label Name Namespace Prefix Api Version Description Create

Edit | Security | (2] SDrive SDrive cg 27.0 SDrive CBrow
SDrive
Edit | Security | [ SDrive Activation SDriveActivation cg 27.0 Activation CBrov
Pane
Figure 7-31

2. Inthe "Page Edit" screen you’ll create your new page. Give an appropriate name to your page.
For our example, we will use "MyCaseHtmIUploadPage" name. Type
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"MyCaseHtmlUploadPage" inside Label field (Figure 7-32-a). Type "MyCaseHtmlUploadPage"
inside Name field (Figure 7-32-b).

Visualforce Page

Page Edit Save | |Quick Save Cancel| Where is this used? | |Component Reference| |Preview

Page Information

Label |MyCasthmIUpIoadPage o

Name |MyCasthmIUpIoadPage o

Description

Available for Salesforce mobile
apps

Require C SRF protection on GET
requests

Visualforce Markup = Version Settings

QA 5 A A a
<apex:page>
<!-- Begin Default Content REMOVE THIS --»
¢<hl>Congratulations</hl>
This is your new Page o
¢<!-- End Default Content REMOVE THIS --»
</apex:page>

Figure 7-32

You need to set the "Salesforce.com API" version to 22.0 or above to use S-Drive 2.0 features.
To set the version number click the "Version Settings" tab next to the "Visualforce Markup"
tab and change the version number from drop-down (See Figure 7-8).

Now we need to create our page content. We will be using custom components in our page.
Basically, our page skeleton will be as follows:

<apex:page standardController="Case" tabStyle="Case">
<cg:HtmlUploadComponent
objectId="{!Case.Id}"
customObjectFileName="CaseFile c"
fileNamespacePrefix="cg "
relationshipName="Case r"
privateEnabled="true"
allowedFileExtensions="="*.avi;*.txt""
isUsePopup="true/false"

returnUrl="https://na6.salesforce.com/home/home.jsp"
debug="true/false"
currentFolderId = " a068000000xgAAEAA2"
/>
</apex:page>
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As an example, the following will be a typical Visualforce page:

<apex:page standardController="Case" tabStyle="Case"
showHeader="false" sidebar="false"
standardStylesheets="false" applyHtmlTag="true"
applyBodyTag="true" docType="html">

<html>
<head>
<meta charset="utf-8" />
<title>
Case Files Html Upload Page
</title>
</head>
<body>

<cg:HtmlUploadComponent
objectId="{!Case.Id}"
customObjectFileName="CaseFile c"
fileNamespacePrefix="cg "
relationshipName="Case r"
privateEnabled="true"
isUsePopup="true"
debug="true"
/>
</body>
</html>
</apex:page>

You need to set these component attributes based on your configuration. Let’s discuss these
component attributes:

1. standardController
You need to set this standard controller to the object that you want to use with. For our
example this is the custom object name: "Case". As you can see from the example we do
not appended "__c" to the end of the name. This means this object is a not custom object.
You can use custom objects also. For custom objects you will append "__c" at the end of
the object name (e.g. ExampleObject__c). Also, do not prepend your account’s namespace
prefix.

2. tabStyle
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This is the tab style of the page. Normally you can set it same with standardController.
That means tab style will be derived from the standard controller you chose.

3. customObjectFileName
This is the name of the custom object file that existing, or we have created in previous
sections or. This object will be holding the information regarding the attached files. For
our example, it is "CaseFile__c". If this is a custom object you need to append "__ c" to the
end of the name. Also, do not prepend your account’s namespace prefix.

4. objectld
You need to pass in the "{!ld}" value or hardcoded value for this attribute. This attribute is
required to retrieve object id.

5. fileNamespacePrefix (optional)
This is the file object’s namespace prefix that your Salesforce.com organization uses. If
your organization has a namespace prefix and you created this custom object file inside
this organization, your file namespace prefix is same with your organization namespace
prefix. If this file object belongs to a managed package, you need to use that managed
package’s namespace prefix. If your file object does not belong to any namespace you do
not need to set this attribute. If your namespace prefix is "exampleprefix" you need to set

fileNamespacePrefix as "exampleprefix__".

6. privateEnabled (optional)
This option is used for enabling public/private file access to the S-Drive attachments and
commonly used to limit the customer portal users’ access to individual files. Before setting
this property, you need to add a new field to your custom object file named ‘Private’ (See
‘Creating Custom Obiject Files’ section for more information). Set this attribute to true if
you want to enable private/public flag. Setting the private flag on a file hides the file from
customer portal users. There are two possible values for this attribute: "true", "false". The
default for this attribute is "false" except for the Case Files custom page.

7. allowedFileExtensions (optional)
You can use this option, if you want to limit the file types to be uploaded into selected
object’s S-Drive attachments and folders. Semicolon separated list of file extensions that
are allowed to upload. This attribute is optional and leaving this empty will allow all kind
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of files to be uploaded. For example: "*.jpg;*.txt" will limit the files to be uploaded to jpg
and txt files.

8. relationshipName (optional)
Master-detail relation used for selected standard/custom object. This attribute is optional

and default value is "Parent__r".

9. currentFolderld (optional)
Id of the parent folder for the files to be uploaded. It is not provided by default.

10. isUsePopup (optional)
Set this attribute to true if you defined useUploadAsPopup attribute to true on the
AttachmentComponent. The default for this attribute is false. This value overrides the
"Default Upload Manager" configuration in "S-Drive Configuration".

11. returnUrl (optional)
Set this attribute to a url to be directed this return page after closing upload screen.

12. debug (optional)
Set this attribute to true to enable logs debugging on bottom of upload screen. The
default for this attribute is false.

@No tes

You can add &debug=true query parameter on the URL of upload page to enable log
debugging.

If you want to get more information about component attributes, you can click "Component
References" button and find cg:HtmlUploadComponent reference from the list (Figure 7-32-
d).

After setting the page based on above component attributes, click "Save" button.

Lastly set the security for your page on other profiles. Go to Setup -> App Setup -> Develop ->
Pages and click Security link next to your page name (Figure 7-33).
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Action

Edit De

Label

MyCaseHtmlUploadPaage

Name

MyCaseHtmiUp

loadPaage

Mamespace Prefix ApiVersion Description

cg 330

Figure 7-33

Move all profiles (or select based on your needs) from "Available Profiles" to "Enabled

Profiles" as shown in Figure 7-34. If you skip this step, your users that belong to the disabled

profiles will see an error page like Figure 7-13.

Now we have a custom HTML upload page. At this point, you can use this HTML upload page

Enable Profile Access for Visualforce Page

MyCaseHtmlUploadPage

Available Profiles

—-None- «

Add

Remove

Save

Enabled Profiles

Cancel

System Administrator
Cloned Standard
Cloned Standard Platform User
Cloned System Administrator
Contract Manager

Cross Org Data Proxy User
Custom: Marketing Profile
Custom: Sales Profile

Custom: Support Profile
Customer Community Login User
Customer Community User
Customer Portal Manager
Marketing User

Partner Community Login User

[3

Figure 7-34

wherever you want like below figure ( Figure 7-35) if you give appropriate parameters.

. Case
¢ 00002034

H- Show Feed

Case Detail
Case Owner
Case Number
Contact Name
Account Name
Type
Case Reason
Date/Time Opened
Product
Potential Liability
Created By
Subject

o

Case Files[21] | Solutions[0] | Emails[ig | Attach

Customize Page | Printable View | Help for thi:

ts 0] | Open Activities 0] | Activity History [16] | Case History [1]

Edit | | Delete| Close Case || Clone

Case Files | Case Html Upload

E CvanGate CvanGate [Changel
00002034

1212012013 4:37 AM

CyanGate CyanGate, 12/20/2013 4:37 AM
Test

Status

Priority
Contact Phone
Contact Email

Case Origin

Date/Time Closed
Engineering Req Number
SLA Violation

Last Modified By

New

Medium

Email

CyanGate CyanGate, 12/20/2013 4:37 AM

Figure 7-35
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8 S-DRIVE CONFIGURATION TAB

Organization administrators can use S-Drive Configuration tab to set organization-wide
configurations and get information about S-Drive credentials, usage and billing.

You can refer to "B. Displaying "S-Drive" and "S-Drive Configuration" Tabs" section of "S-Drive
Installation Guide" to display "S-Drive Configuration" tab in your custom app.

S-Drive Configuration is separated into six sections: S-DriveAuthentication Settings, General
Settings, Customization Settings, Micro Services, S-Drive Documentation and Video Tutorials
(Figure 8-1).

Home Chatter Files Accounts S-Drive BEEUIWTASCINTEINN S30bjects Cases Contacts Opportunities Campaigns Reports Leads My Example Objects  S-Drive Mobile # v

S-Drive Configuration m Cancal

S-Drive Authentication Seftings. | General Settings | Customization Settings | Micro Services 1 §-Drive Documentation I Video Tutorials

Amazon 53 Credentials

Bucket Name  |mysorvesmsbucket 2

Update Amazon 33 Credentials( Click here to update
Key, Secret Key) and Bucket Name

S-Drive Portal Credentials

S-Drive Account, Usage and Billing  Click here to access S-Drive Portal
Information

- 1B

Figure 8-1
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8.1 S-Drive Authentication Settings
$-Drive Configuration E Cancel

S-Drive Authentication
Settings General Settings | Customization Settings

Amazon S3 Credentials

Bucket Name© ~ . - P

Update Amazon 53+ Click here to update
Credentials{Access Key, Secret Key)
and Bucket Name

S-Drive Portal Credentials

$-Drive Account, Usage and Billing= Click here to access 5-Drive Portal
Information

m Saned

Figure 8-2
8.1.1 Amazon S3 Credentials

8.1.1.1 Bucket Name
Amazon bucket name used for S-Drive is displayed here.

8.1.1.2 Update Amazon S3 Credentials (Access Key, Secret Key) and Bucket Name
Users can display and update their Amazon S3 credentials and bucket name. See section 2.1.1
Access Key and Secret Key for more details.

8.1.2 S-Drive Portal Credentials

8.1.2.1 S-Drive Account, Usage and Billing Information
Users can access their S-Drive portal account for account, usage and billing information.

8.2 General Settings
This section allows a system administrator to change several system wide configuration options.
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s-Drive Configuration

S-Drive Authentication Settings

S-Drive Tab Settings

e

Customization Settings | Micro Services | so

00 Tutorials

Enable Download
Enable Chatter
Disable Copy URL on $.0rive Tab

Enable Email on §.Drive Tab @

Mail Settings

dmable for portal users

Custom Email Footer

Defauit Email Footer

Default Email Expiration Time Uniirmited
Embed Thread id In Case Emails v
(Case Email Reply-To Address.
Object Field Settings
Update . Drive obi new fields
Sync File Object Fiids 5,

File Settings

Max File Size in MBs (Uncheck o remove file size limit)

Enable File Activites

Select page size for S.Drive tab

User Settings

Unlimited File Size

Change File Click Behavior
Restricted Portsl User Profiles.

Only Allow Users with Modity All Permissions to
Create ltems at the Top Level

Restrict Sharing Categories for Community users

Url Settings

(Customer Portal Users Porta

Copy Url expiration date

Upload Settings

year(s)

Enable Auto Upload
Enable Dropzone

Enable Version Upload

¥ Mark s checkbox in ceder 1 enable drogzone.

Default Upload Manager | Fimi
Tag Settings
Banned Tags | o tog1. b
Other Setlings
Daly batch jobs execution tme (o, 42 an

Enablo copying S-Orive fles and folders when
Converting Leads to

Contacts | Accounts ¥ Oppoduniies

e e

Figure 8-3

8.2.1 S-Drive Tab Settings

8.2.1.1 Enable Download
This configuration enables "Download", “Open” and “Zip & Download” for S-Drive Folders.

8.2.1.2 Enable Chatter
This configuration enables Chatter feature for S-Drive folders.
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8.2.1.3 Disable Copy URL on S-Drive Tab
This configuration is used to disable Copy URL item menu action for S-Drive tab ("S-Drive
Folders"). Default is enabled (unchecked).

8.2.1.4 Enable Email on S-Drive Tab
This configuration is used to enable Email feature for S-Drive tab ("S-Drive Folders").
Default is enabled (checked).

8.2.1.5 Disable for portal users
This configuration is used to disable email feature only for portal users if it is enabled for
internal users. So, if it is disabled for all users ("Enable Email on S-Drive Tab" is checked), it
cannot be checked/unchecked.

8.2.2 Mail Settings

8.2.2.1 Custom Email Footer
This configuration will allow a system administrator to change the system wide S-Drive
Email footer. The default email footer that is added to your email messages is
"Attachment is stored online at S-Drive. To open this file, just click the link above."

8.2.2.2 Default Email Expiration Time
This configuration will allow a system administrator to change the system wide S-Drive
Default Email Expiration Time. If you do not set this value "Never Expires" is selected by
default in the email screen. If you set a value, it will be displayed to all users that are
using email screen (Figure 8-4). Users can always modify the email expiration time while
sending the emails.
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|: To... :I ‘ | [ Clear :I

|: Additional To... :I ‘
e N |
)|

l: BCC... ! ‘
Attachment Expiration: D |3|:| | l minute(s) | v J-\‘

MNewver Expires
1 attachment [ minute(s)
hour(s)
day(s]) L
Subject: | manth{s) :I
Message Body: | year(s) j_|

Figure 8-4

8.2.2.3 Embed Thread Id in Case Emails
By setting this configuration, it adds thread id into the email of the case file. So,
replies to that e-mail message are recorded in the Activity History of the same case
and attachments in the replies are saved in the same case. This configuration is useful
for the organizations that are using S-Drive Email Agent.

8.2.2.4 Case Email Reply-To Address
Reply-to address for case related emails sent out via S-Drive. Usually this email

address is the general support email address. This configuration is useful for the
organizations that are using S-Drive Email Agent.

8.2.3 Object Field Settings

8.2.3.1 Sync File Object Fields
This button is for syncing Salesforce File Object fields for S-Drive version upgrades.
Instead of creating each field on S-Drive upgrades, this button creates the missing
fields for your file objects you use for S-Drive.

When upgrading to new version of SDrive, sometimes there are fields added to file
objects for new feature of SDrive platforms. Instead of adding these fields manually,
SDrive supports this process automatically. When upgrading to 2.x from any version,
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custom file objects will have the missing fields added for you just after clicking the
sync button.

For this feature to be available, you must configure remote site settings.

Go to Setup -> Security -> Remote Site Settings and create a new remote site named
anything let’s say “SDriveMeta” and copy your organization domain for example as:
“https://cgsdrive-dev-ed.my.salesforce.com”.

8.2.4 File Settings

8.2.4.1 Max File Size in MBs
This configuration will allow a system administrator to change the system wide
behavior of max file size limit for uploads. File size limit is actually 5TB per file;
however, due to Flash plug-in and browser limitations, the practical limit for file
upload size via the browser is 2GBs. With this option, the user will be limited to a file
size for each file. So, if you set maximum file size to "10". Users won’t be able to
upload files greater than 10 MBs.

You need to set this option in megabytes (MB). So if you want to limit the size to 12
MB, Max File Size option must be 12. If you want to set it to 1 gigabyte (GB), you need
to set it to 1024, if you want it to be 0 byte, you need to set it to 0 etc. If you don’t
want to specify a file size limit, uncheck the checkbox.

If users try to upload a file greater than the limit, they will see an error message like
below saying "Files greater than XYZ cannot be uploaded! (File name, File size) (Figure
8-5):

Error

OK

Figure 8-5
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Note that this option is account-wide. So, this setting will be applied to all S-Drive
Attachments and S-Drive Folders. Users won’t be able to upload files greater than
allowed file size limit. Also note that this won’t affect previously uploaded files.

8.2.4.2 Enable File Activities
Activities like download and email are recorded to File Activity object in managed
package. You can disable recording these activities by using this setting. If you disable
it, previous records will remain, and new records will not be created. If you want, you
can delete all records on cg__File_Activity __c objects manually.

8.2.5 User Settings

8.2.5.1 Change File Click Behavior
This configuration is used to enable users to choose the action after a file is clicked on.
Check the checkbox to open a file after it is clicked on, uncheck it to preview a file
after it is clicked on.

8.2.5.2 Restricted Portal User Profiles
These are Salesforce.com user profiles that are specifically for portal users. User
profiles can be "Standard", "Partner", "High Volume Portal", "Customer Portal User",
"Customer Portal Manager" and must be separated by comma. By specifying a profile
in this configuration, you can prevent access to "private" content for these profiles.

8.2.5.3 Only Allow Users with Modify All Permissions to Create Items at the Top Level

This configuration is used to only allow users with "Modify All" permissions (mostly
system administrators) to create items at the top level (Home). If this is unchecked all
users can create files/folder at the top-level if they have enough permissions. If this is
checked standard users won't be able to see "Create Folder" and "Upload File(s)"
buttons in the "Home" page of "S-Drive Folders".

8.2.5.4 Restrict Sharing Categories for Community User
You can modify the sharing rule categories that are displayed in the Share Page, for
Community Users. Types can be “Customer Portal Users”, “Portal Roles”, “Portal
Roles and Subordinates”, “Public Groups”, “Roles”, “Roles and Internal Subordinates”,
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“Roles, Internal and Portal Subordinates”, “Users” and must be separated by
semicolon. An example input is: Customer Portal Users;Portal Roles

8.2.6 URL Settings

8.2.6.1 Copy URL Expiration Date
This configuration is for setting the expiration date of created URL of file. You can give
static date (i. e. 3 years) or you can select 7 years document retention rule that is
accessible for 7 years from the file created date.

8.2.7 Upload Settings

8.2.7.1 Enable Auto Upload
This configuration is used to enable Auto Upload files without clicking Upload
button in file upload window. Check the checkbox to enable this feature.

@Important Note

If there is a required field in one of your objects, auto upload will be disabled. For this

setting to work properly, you must refresh all displayed fields and add the required fields
to Displayed Fields from Customization Settings.

8.2.7.2 Enable Version Upload
This configuration is used to activate versioning. After enabling versioning, S-Drive
will allow you to upload different versions of files. You will be able to see and

manage the versions of your files. Please note that once versioning is enabled,
you can't disable.

8.2.7.3 Default Upload Manager
This configuration is used to set the default upload manager for the whole

organization. Possible values are "Html", "Html with Popup" (Figure 8-6). Default
value is "Html".

@Note

Flash and Java upload has been deprecated in S-Drive with 2.0.
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Default Upload Manager

Html

Disable Copy URL on S-Drive Tab Html with Popup

Copy Url expiration date 20

| year(s)

Enable Version Upload

Version Enabled

Figure 8-6

8.2.8 Tag Settings

8.2.8.1 Moving Tags from Hidden to Displayed Fields:
Go to S-Drive Configuration>Customization Settings.

o R ot s

s-Drive Configuration

S.Drive Authentication Settings |

Video Tutorials

Display Object Fields

1 Lokl koo £ S e el 5 My b B D i
You can add several the object fie reen columas based on your custom fieids,
For more i hack & Dive Advanced Canlipaaion B

STEP 1:

STEP 2: Avallable Fields of Selected Object

Hidden Fieids ﬂIIN!MFWI

Account File Name e N
Deleted Creaied Dote
Last Modified By 1D Created By ID
Last Modified Date Description

Account File v Page Count > | File Size (=)
Private ) (=]
Record ID
Sync id

System Modstamp
=

Custom Object S-Drive Config

Under the Custom Gbject S-Diive Config part of the page, user is expected to da the followings
Object List: Objects of the organization except for cusiom file uh|e(1! are lsted n o
Related Objects: Any related objact to th

table, related object the tabls will bs shown ampty.
ustom jecthame: Liser is supposed to input the name il object
Generate File Object: Used 1o creale @ custom file object which is related to the object selected in object list

Object List

Search for Object.

search

Figure 8-7

Move Tags field from Hidden Fields to Displayed Fields.

On Display Object Fields section, choose the Account File object. (or the object that you want
to use Tags feature)

75

All Rights Reserved - CyanGate LLC



CS-DRIVE CyanGate

ome S.Drive Advanced Search  S.Drive %

S-Drive Configuration Bl

5 Drive Authentication Settings | General Setings

$-Drive Documentation

Display Object Fields

This seclion allows a system adminisiiator to change field display settings of S-Drive Attachment and S-Drive Folders objects
You can add sevaral custom fiskds to the abjact fila and customize your attachmants screen colimins basad on your custom fisids.
For mare information pleass check S- Drive Agy i

STEP 1: STEP 2: Available Fields of Selected Object
Midden Fiekds Oinplayed Fiekds
Aceount - lle Narm
Account File Name Created Date
Deleted Created By ID
Last hodified By ID Description

Account Fils ¥ Last Modified Date Y | Flle Siza
Pags Count «) Mags ~
Private =
Record ID
Sync Id

Systom Modstamp

Custom Object S-Drive Config

Under the Custom Object S-Driva Caniig part of the page. user is expacted to do the folowings

Object List: Objects of the organization except far custom fil objects are listed in the list
selected one on vill b jects table, If there were no related abject the 1able will e shawn emply

Custom File ObjectName: User is supgosed to input the name of the fila object

Generate File Object: Used to create a custom file objact which is relatad 1o the object salected in object st

Object List

Search for Object sewrch,

Account

Account Contact Rels
Account Fead
Account Histary
Account Fariner

Figure 8-8

Click Save button, and you are ready to use Tags feature. See the S-Drive User’s Guide for
more information on using the Tags feature.

s  Albert Einstein |
Activity History ipg Bn

Action  Subject Details Chatter Last Modified Date/Time
Edit| Del Emait asdasd 05.08.2019 19:22

05.08.2019 18:27

Edit| Del Email denemee

File Name: Albert Einstein.jpg

Notes & Attachments. File Type: imagel/jpg

Action v ated Date: 06.08.2019 11:35 Created By
Preview | Download | Del Fill Kadir Giltekin

Created By ID: Kadir Guitekin

Preview | Download | Del Fill Kadir Giiltekin
Preview | Download | Del Fill Description: Kadir Giiltekin
Preview | Download | Del Fil| . 47.07 KB Kadir Gilltekin

Partners

No records to display

A Back To Top

Account Files

Home 1items in 1 page

O« 1av]i[ s
Actions. 1

File Size Tags
i|z|al|lv ! 85 Open | & Download || (Z'Copy URL i (& Edit || (£ Rename | [ Delete 47.07KB

modern physics

1items in 1 page

Figure 8-9
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8.2.8.2 Banned Tags:

Enter tags here to ban them from being used to tag files and folders on S-Drive. Separate

banned tags with commas as you enter them, as shown below.

Tag Settings

Banned Tags ! 5

Figure 8-10

After specifying the banned tags, if a user tries to enter a banned tag they will get see a

message that the tag has been banned by the system administrator as shown below.

S Drive Aves =

Figure 8-11

8.2.9 Other Settings

8.2.9.1 Select SQueue -Daily Batch Jobs - Execution Time

B Albert Einsteinjpg [a]<]afols]cH-]=H - BN

« Back

SQueue is a an S-Drive service that executes batch jobs at 00:00 automatically if
there are any. You can change execution time of batch jobs in this section. Check

your Salesforce system time to set this value. You can check your default system

time from Setup > Company Settings > Company Information > Default Time
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Zone. Daily batch jobs execute both the deletion of previews of the files having
multiple pages, and the copying of files during the lead conversion process.

Note: If files have shortcuts, they will be put in the SQueue until the batch job
execution time and shortcuts belonging to deleted files will be deleted when the
batch job runs.

Daily batch jobs execution time | 55. 55

Figure 8-12

8.2.9.2 Enable Copying S-Drive Files and Folders When Converting Leads To
This configuration is used to enable users to choose where to copy S-Drive files in
Leads when a lead is converted. Available options are Accounts, Contacts and
Opportunities. See Section 9.3 Lead Conversion for details.

Enable copying S-Drive
files and folders when
Converting Leads to

Contacts ¥/ Accounts ¥ Opportunities

Figure 8-13
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8.3 Customization Settings
In this section, you can configure your field display settings and create custom S-Drive file objects.

$-Drive Configuration m Cancel

| S-Drive Authentication Settings | General Settings | Customization Settings [ Micro Services

Display Object Fields

This section allows a system administrator to change field display settings of S-Drive Attachment and 5-Drive Folders objects.
You can add several custom fields to the object file and customize your attachments screen columns based on your custom fields.
For more information please check S- Drive Advanced Configuration Documentation

STEP 1z STEP 2: Available Fields of Selected Object

Hidden Fields Displayed Fields
| Account = | File Name -
| Deleted Created Date
| File Size Created By ID
i Is Archive Approved Description |

Account File v | | s Archive Candidate lLJ Private ' LLJ
| Is Archive Exempted w Account File Name | lLJ

| Last Modified By ID

| Last Modified Date

| Page Count

| Received Connection ID » | -

Custom Object S-Drive Config

Object List: Objects of the organization except for custom file objects are listed in the list.
Related Objects: Any related object to the selected one on will be displayed related objects table, If there were no related object the table will be s

Custom File ObjectN User is supposed to input the name of the file object.

Generate File Object: Used to create a custom file object which is related to the object selected in object list
Object List
Account

Account Contact Role
Account Feed

Account History

Account Partner

Account Share

Activity History

Additional Directory Number
Aggregate Result

Apex Class

Related Objects

Custom File ObjectName |

Generate File Object

Figure 8-14
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8.3.1 Display Object Fields
This section allows a system administrator to change field display settings of S-Drive Files and S-
Drive Tab objects. By default, the S-Drive file areas of all objects have these columns: "File Name",
"Created Date", "Created By ID", File Size", "Description" (Figure 8-15).

My Example Object Files New Folder | |Upload File(s) | Attach from S-Drive Folders  Email Selected Delete Selected Download Manager
Home Search Q
"] Actions @e Name Created Date Created By ID File Size Description )
| Download | Copy URL | Edit | Del My Test File bd 8/9/2011 8:11 AN CyanGate CyanGate 21 bytes
Figure 8-15

To set the field display settings for an object, select the object from drop-down. Select the fields
from "Available Fields" and click right arrow button to move these fields to the "Displayed Fields"
section. You can also change the order of the fields by using Up-Down arrows. Click "Save" button
to save changes. (Figure 8-16). Note that you cannot change the first column of the file list, it is
fixed as the "File Name" field.

Note: If you allow users to set files to Private, you must display the Private field here.

Note that you can configure custom fields for S-Drive Folders (S30bject) after v2.0.

s-Drive Configuration [ s [

§-Drive Authentication Settings | General Settings | Customization Settings |

Display Object Fields

This section allows a system administrator to change fild display settings of S-Drive Attachment and 5-Drive Folder
You can add several custom fields to the object file and customize your attachments screen columns based on your
For more information please check S- Drive Advanced Configuration Documentation.

STEP 1: STEP 2: Available Fields of Selected Object
Hidden Fields Displayed Fields
Account File Name
Account File Name Created Date
Deleted Created By ID
Is Archive Approvad Description
Account File v Is Archive Candidate QJ File Size tJ
Is Archived 4 CJ

Is Archive Exempted
Last Modified By 1D
Last Modifiad Date
Page Count -

Figure 8-16
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You should see the "You have successfully saved configuration changes!!!" message at the top of

the S-Drive Configuration page (Figure 8-17).

S§-Drive Configuration Save | | Cancel

=
‘ @ You have successfully saved configuration changes!!!

S-Drive System Information

Figure 8-17

Now if you go to your custom object's page, you should see the displayed fields are changed
(Figure 8-18).

My Example Object Files New Folder  Upload File(s) Attach from S-Drive Folders |Email Selected | |Delete Selected  Download Manager
Home Search Q
7] Actions ile Name TestDate TestURL TestCheckbox TestCurrency )

[} Download | Copy URL | Edit | Del My Test File.btd

Figure 8-18

Widgets will be displayed based on your selection in the upload screen (Figure 8-19):

Upload Files

TestCheckbaozx | TestCurrency Status

File TestDate | TestURL

Testing.txt 08/09/2011 @ August 2011 @ 4 4

S M T w T F S

1 2 3 4 5 6
7 =) H 10 11 12 13
14 15 18 17 18 1% 20
21 22 23 24 25 26 27
28 29 30 31

Figure 8-19

And if you edit the files, you will also see the correct widgets based on the types of the fields
(Figure 8-20):
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Testbate  [gr9/2011 [8/9/2011]

TestCheckbox

TestCurrency

Figure 8-20

8.3.2 Custom Object S-Drive Config

This is used to generate an S-Drive file object for an object other than Account, Case, Contact,
Opportunity or Lead. Those come standard with S-Drive. To use S-Drive with any other standard or
custom object, you must create a corresponding S-Drive file object. This can be done here with one
click.
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8.4 Micro Services

S-Drive Configuration

3

| 5-Drive Authentication Settings | General Settings | Customization Settings | Micro Services | S-Drive Docu

Amazon S3 Transfer Acceleration (Free on S-Drive)

Enabling Amazon S3 Transfer Acceleration is free from the S-Drive side but there is a pricing plan on the Amazon side. Please visit the site for the pricing. hitps./docs.aws
acceleration html

Enable Amazon 53 Transfer (&
Acceleration

Zip and Download (Free)

This configuration is enabled for "Download”. “Open” and “ZipDewnload™ for 5-Drive Folders

Attachment Sync (Free)

This configuration is for syncing Salesforce Attachments of any standard/custom object with 5-Drive. After enabling Attachment Syne, new attachment will be uploaded to !

Sync Salesforce Attachments with S-

] Configure AttachmentSync
Drive —————

S-URL(Free)

S-URL: File URLs generated by Amazon S3 services are too long. It causes problems in some mail programs such as MS Outlook, and it is not easy to share. In order to u
S-Drive. Please check S-URL saction for enabling the short URL feature on S-Drive. In order to use Sharing S-Drive files in Public Site feature, you need to enable Short U

Enable S-URL ¥/ Base URL http://sdrive-developer-editio

S-Action(Free)

You can create and add your custom actions to S-Drive. Please see documentation to get details: http/iwww.sdriveapp.com

Add S-Action

Add S-Action Name Label Active Multiple Display
Delete | Edit] selectall Select All Fields v v Hidden
Delete | Edit| lightning lightning ¥ v Lightning Companent
Delete | Edit classic display classic ¥ v Display

Preview and Thumbnail (Paid)

To enable this configuration, click on “Cenfigure Preview and Thumbnail” butten. Using this configuration;
* You can enable/disable preview and thumbnail conversien per object.

* You can enable/disable preview and thumbnail conversion per file type

* You can monitor conversion status and retry failed conversions.

* You can generate preview and thumbnail of pre-existing S-Drive Attachments

Preview & Thumbnail Configure Preview & Thumbnail

(o

Figure 8-21

8.4.1

Enable Amazon S3 Transfer Acceleration

This configuration is used to enable/disable S3 Transfer Acceleration feature. Amazon S3
Transfer Acceleration is a faster way to move data into your Amazon S3 bucket over the
internet. It is designed to maximize transfer speeds when you need to move data over long

83 All Rights Reserved - CyanGate LLC



£S:DRIVE CyanGate

distances, for instance, across countries, or continents to your Amazon S3 Bucket. Transfer
Acceleration takes advantage of Amazon CloudFront’s globally distributed edge locations. As
the data arrives at an edge location, data is routed to Amazon S3 over an optimized network
path.

Enable Amazon 53 Transfer Acceleration

Figure 8-22

You might want to use Transfer Acceleration on a bucket for various reasons, including the
following:

e You have customers that upload to a centralized bucket from all over the world.

e You transfer gigabytes to terabytes of data on a regular basis across continents.

e You underutilize the available bandwidth over the Internet when uploading to
Amazon S3.

When you enable Amazon S3 Transfer Acceleration using S-Drive Configuration Tab, it will also
be enabled in Amazon Web Services and you will have a new S3 bucket endpoint in the form
“BUCKET_NAME.s3-accelerate.amazonaws.com”. Afterwards, S-Drive starts using this
endpoint for uploads and downloads. You can see the transfer acceleration at bucket
properties, and you can enable/suspend S3 Transfer acceleration using AWS Management
Console. But whatever the status is your acceleration endpoint in your bucket, it must be the
same in S-Drive. We recommend you, enable/suspend acceleration endpoint only using S-
Drive. To see this bucket property, click on S3 service and then click on your bucket name from
AWS Console and click on “Properties” tab at top right corner (Figure 8-23).
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Q None Properties Transfers

Bucket: mysdriveawsbucket

Permissions

Static Website Hosting

Logging

Events

Versioning

Lifecycle

Cross-Region Replication

» Tags

Requester Pays

~ Transfer Acceleration

i

Enabling Amazon S3 Transfer Acceleration on this bucket will provide you with a new endpoint that you can use in your applications for faster data tra|
from and to Amazon S3. Unlike data transfers using regional and global Amazon S3 endpoints, data transfers using an Amazon S3 Transfer Acceleratifjs
endpoint will incur an additional fee

Endpoint: mysdriveawsbuckel s3-accelerate.amazonaws.com

Suspend

Want to compare your data transfer speed by region?

@Notes

When using Transfer Acceleration, additional charges may apply for transfer where Transfer
Acceleration can potentially improve performance. For more information about pricing, see
Amazon S3 Pricing. S-Drive won’t charge you for this service.

Figure 8-23

Only HTML Upload Manager supports Amazon S3 Transfer Acceleration. When you enable
acceleration endpoint, it will be used for both downloads and uploads in S-Drive. To learn more
about S3 Transfer Acceleration, please visit here.

8.4.2 Zip and Download
This configuration is enabled to Download and Open files. Multiple files can be selected and
downloaded by Zip Download functionality.

85 All Rights Reserved - CyanGate LLC


http://aws.amazon.com/s3/pricing/
http://docs.aws.amazon.com/AmazonS3/latest/dev/transfer-acceleration.html

£S:DRIVE CyanGate

8.4.3 File/Attachment Sync
File/Attachment Sync takes files that are uploaded to Salesforce Files or Salesforce Attachments and

syncs them with S-Drive for the selected object. Sync is processed based on a queue, so new items will
appear in S-Drive in a few seconds/minutes.

After configuring File/Attachment Sync, new file/attachment will be uploaded to S-Drive
automatically. You can also configure deleting the Salesforce files/attachments after successful

configuration.

To sync file/attachments to S-Drive, click the “configure sync” button. You will see a message that it is
processing objects. This is processing that is done in order to display next configuration screen shown

below.
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Save Cancel

Synced Objects

Object o Object File o Object File Relationship e Altachmento File°

Account [cg__AccountFile__c -| |cg__Account__c |
Case | | - o
Contact | | = o
Lead | | B o
Opportunity \ cg__OpportunityFile_ ¢ V| | ‘ o =
Project | | - o
Student | | o o

General Settings

Enable To Handle Email O °
Files/Attachments

Enable To Delete m] o

Files/Attachments After
Upload

Save Cancel

Sync Status

Failed Sync Failed sync count: 1 @

Ry @

In Progress Sync @

Refresh Sync Status Q

Configure File Sync of Pre-existing Files

0 If you already attached some files to your object, you can also configure File Sync of these. First enable File Sync on your object.
Then click on 'Go' button to configure File Sync of pre-existing files.

Configure File Sync of Pre-existing Files Go @

Figure 8-24

For each Object (1) for which you want to sync files or attachments, select the S-Drive file object you
want to use for syncing from the dropdown list (2). There will usually only be one choice.

In the Object File Relationship field (3), enter the APl name of the field that relates to the parent
object. For the S-Drive File Objects that come bundled with S-Drive, these will be cg_ Account__c,
cg__Case__c,cg_ Contact__c,cg_ Lead_ c,cg_ Opportunity__c. For S-Drive file objects created
through S-Drive Configuration Customization Settings (those that didn’t come standard with S-Drive),
it will be Parent__c.

Check the checkboxes (4) and/or (5) to indicate whether you want to sync files, attachments, or both.
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Click Save.

In "General Settings" section you can enable handling files/attachments in email messages by checking
"Enable to Handle Email Files/Attachments" (6). You can check "Enable to Delete Files/Attachments
After Upload" configuration, if you want to delete the Salesforce Files/Attachments after successfully
syncing to S-Drive(7). If you uncheck this option, both Salesforce Files/Attachments and S-Drive will be
available after syncing.

Click Save (8).

In "Sync Status" section, you can see failed sync job (10) and progressing sync job (12) counts and can
click to retry failed jobs (11). After clicking this button, you can see updated sync status You can
refresh the failed and progressing file/attachment sync count status by clicking "Refresh Sync Status"
(13) button.

In "Configure File Sync of Pre-existing Files" section, you can sync older Salesforce Files with SDrive. If
you want to enable pre-existing Salesforce file sync for an object, you just need to select the "Object
File”, fill the “Object File Relationship” field and check the related "File" checkbox. You can go to the
configuration page by clicking "Go" button (14). This takes you to the screen below.

Generate File Sync | Cancel

File Sync Enabled Objects Related S-Drive

‘ G To create File Sync of existing Salesforce files of an object, select Create checkbox next to an object and click on Generate File Sync

button.
Object o Object File e Createe
Account cg__AccountFile__c ~ 0
Case cg__CaseFile__c v O
Contact cg__ContactFile__ ¢ ~ O
Lead cg_ Lead File_ ¢ ~ 0
Opportunity cg__OpportunityFile__c ~ O
Project Project File ¢ ~ 0
Student Student_File_ ¢ ~ 0

Generate File Sync | | Cancel

If you want to sync pre-existing Salesforce Files for an object, Look for the desired object in the
Object section (1) and select the “Object File”(2) to be used for syncing. Check "Create" (3)
checkbox. Click "Generate File Sync" button (4).
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You can inspect individual "AttachmentSync" objects to see more details and see "File/Attachment
Sync" section of this document for more details about the sync process.

8.4.4 S- URL (Short URL)
In order to use Sharing S-Drive files in Public Site feature (configured from the S-Drive Lightning
component), you need to enable Short URL. Please check the checkbox in S-URL section for enabling
short URL feature on S-Drive.

Public Share & S-URL features can be used separately but they have the same configuration.

S-URL: File URLs generated by Amazon S3 services are too long. It causes problems in some mail
programs such as MS Outlook, and it is not easy to share. In order to use a shortened URL, you can use
S-URL feature of S-Drive.

Public Share: You can share your files & folders to public users. You can set password, IP Range, Expire
dates and so on.

Public Share & S-URL uses force.com Sites to create short URL with your brand name. You may need
to buy force.com Sites license to use this feature. (To get more information please visit
https://developer.salesforce.com/page/Sites)

8.4.5 S-Action
This configuration enables users to create and add custom actions to S-Drive. Please refer to S-Actions
(Custom Actions) for detailed configuration.

8.4.6 Preview and Thumbnail
You can find this configuration under General Settings section in S-Drive Configuration Tab. To open
this configuration, click on “Configure Preview & Thumbnail” button (Figure 174). Using this
configuration;

e You can enable/disable preview and thumbnail conversion per object.

e You can enable/disable preview and thumbnail conversion per file type.

e You can monitor conversion status and retry failed conversions.

e You can generate preview and thumbnail of pre-existing S-Drive Attachments.
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Preview and Thumbnail (Paid)

To enable this configuration, click on “Configure Preview and Thumbnail® button. Using this configuration;
*You can enable/disable preview and thumbnail conversion per object.

*You can enable/disable previaw and thumbnail conversion per file type.

* You can moniter conversion status and retry failed conversions.

*You can generate preview and thumbnail of pre-existing S-Drive Attachments

\

Preview & Thumbnail Configure Preview & Thumbmnail

Figure 8-25

Enable Preview and Thumbnail Per Object Related S-Drive

After a successful file upload, S-Drive can generate preview and thumbnail of your file, if this
feature is enabled on your object and file types are configured. To enable preview and thumbnail
on your object, you should click on the enabled checkbox next to the object and save it (Figure
8-26). To disable it, you should uncheck the enabled checkbox and save it. Preview and Thumbnail
conversion will not be performed, and your file types configuration will be ignored, if object is not
preview and thumbnail enabled.

Save |Cancel

Objects Related S-Drive

0 In this section, you can enable/disable Preview and Thumbnail conversion for your objects related S-Drive. To enable it, click on the enabled checkbox next to the
abject and save the configuration. To disable it, uncheck the enabled checkbox and save the configuration.

Object Object File Enabled
Account cg__ AccountFile_c v =
Case cg__CaseFile__c ¥ i
Contact cg__ContactFile__¢ b4 5
Contract cg__Contract_File__c *

Lead cg lead File c~

My Example Object cg__My Example_Object_File_ c v

Opportunity cg__OpportunityFile__c v 5
Package cg__Package_File_ c v

S30bject cg S30bject c v G
Upload Request cg__MyCustomFile__c ¥

© Additional S3 storage will be consumed by the previews and thumbnails.

Figure 8-26
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Enable Preview and Thumbnail Per File Type

You can choose which file types will be allowed for preview and thumbnail conversion on your
objects related S-Drive. To enable a file type, select your object from “Object Types” select list and
move desired file type from “Conversion Available File Types” box to “Conversion Allowed File
Types”. Then save configuration before changing the object type. To disable a file type, move
desired file type from “Conversion Allowed File Types” box to “Conversion Available File Types”.
Then save configuration (Figure 8-27).

File Types To Be Converted

0 In this section, you can configure which one of the file types should be considered for Preview and Thumbnail conversion on your preview enabled objects. For
example, If you enable Account File object above and if you allow conversion of a 'jpg' and 'mp4' file for Account File Object in this section, a preview and a thumbnail
will be generated after a 'jpg' or 'mp4' file upload to Account File Object and you will be able to display or stream them in your page. File types configuration will be
ignored and conversion will not be performed if the object is disabled above. To configure file types, select an object from the selectlist below and move desired file
types from Available List to Allowed list. Then save the configuration. S-Drive has already configured some commeon file types for you!

Object Types

Case File M

Conversion Available File Types Conversion Allowed File Types
3fr avi

392 doc

3gp |.? J /docx

3gpp gif

abw lil ipeg

ai iPg

arw mov

bmp mp4

cavs mpeg

cdr - mpg -

@ Please save the current configuration before changing the object type

Save Cancel

Figure 8-27

“Conversion Available File Type” is a file type that S-Drive can generate it’s preview and
thumbnail but needs your permission to perform conversion. That’s why you should allow the file
type by adding it to “Conversion Allowed File Types” box. S-Drive has already pre-configured
some common file types for you. If you preview and thumbnail enable an object and do not
configure a file type for it (accept the defaults), “avi, doc, docx, gif, jpeg, jpg, mov, mp4, mpeg,

mpg, pdf, png, ppt, pptx, psd, wmv, xls, xlsx” types will be auto enabled. You can allow more file
types or disallow some of them.

Let’s say you have enabled “Case File” object for preview and thumbnail conversion and also
enabled “jpg” and “mp4” types for Case File. If you upload a “jpg” file to Case File object, you will
be able to display it’s preview and thumbnail. If you upload an “mp4” file to Case File, you will be
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able to stream it. In this case, no conversion will be performed for any other (not allowed) file

type even if your object is preview and thumbnail enabled.
Monitor Conversion Status

In this section, you can monitor status of your preview and thumbnail conversions and retry failed
ones (Figure 8-28). For more information, you can create “Preview” object tab and check related
records.

Conversion Status

‘ 0 In this section, you can monitor status of your conversions and retry failed ones. To see more details about failed previews, you should check Preview object.

Failed Preview :  Failed preview count: 7

Retry

In Progress Preview :

Refresh Preview Status

Figure 8-28
Generate Preview and Thumbnail of Pre-existing S-Drive Attachment

If you already have attachments in S-Drive before preview and thumbnail feature released, then
you can bulk generate preview and thumbnail of your pre-existing attachments. First, you must
preview and thumbnail enable your object and configure file types for it, then you should click on
the “Go” button in “Generate Preview and Thumbnail of Pre-existing Attachment” section (Figure
8-29).

Generate Preview and Thumbnail of Pre-existing Attachments

G If you already attached some files to your object, you can also generate Preview and Thumbnail of these. First enable Preview and Thumbnail conversion on your
object and configure file types if needed. Then click on 'Geo' button to generate Preview & Thumbnail of pre-existing attachments.

Generate Preview and Thumbnail of Pre-existing Attachments Go

Figure 8-29
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Then a visual force page will be loaded. In this page, you should select “Create” checkbox next
your object and then you should click on “Generate P&T” button (Figure 8-30). This will invoke a
batch job and S-Drive’s preview and thumbnail service will start conversion.

Generate P&T | Cancel | | Refresh Job Status

Preview Enabled Objects Related S-Drive

‘ 0 To create Preview & Thumbnail of existing files of an object, select Create checkbox next to an object and click on Generate P&T button.

Object

Object File Create
Account cg AccountFile c v
Case cg CaseFile cv 2
Contact cg_ ContactFile__c r
Opportunity cg__OpportunityFile__c ¥
S30bject

cg S30bject c v

© Additional S3 storage will be consumed by the previews and thumbnails.

Generate P&T | Cancel | | Refresh Job Status

Figure 8-30

There two main requirements to generate preview and thumbnail of a file.

e Object must be preview and thumbnail enabled.
[ ]

Type of attached file must be allowed for conversion on your object.

Important Note: Additional AWS S3 storage will be consumed by the previews and thumbnails.
Also, you can check conversion pricing at https://www.sdriveapp.com/pricing/. Once S-Drive 2.0
installed into your organization, S-Drive Folders (S30bject) will be auto enabled for preview and
thumbnail conversion of upcoming “avi, doc, docx, gif, jpeg, jpg, mov, mp4, mpeg, mpg, pdf, png,
ppt, pptx, psd, wmv, xls, xIsx” file types. You can change this configuration if you want to.
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8.5 S-Drive Documentation

This section includes a set of detailed user documentation for S-Drive configuration and usage. Each
document has different focus; therefore one might need to select carefully to look for detailed
information.

8.6 Video Tutorials

This section includes a set of videos related to S-Drive configuration with Amazon, Salesforce and
setting up the features of S-Drive. Users can benefit these videos when they need help to activate and
use S-Drive on their Salesforce organizations.

9 ADVANCED FEATURES

9.1 How to Activate Public Share Link & S-URL in Your Organization

Public Share & S-URL features can be used separately but they have the same configuration.

S-URL: File URLs generated by Amazon S3 services are too long. It causes problems in some mail
programs such as MS Outlook, and it is not easy to share. In order to use a shortened URL, you can use
S-URL feature of S-Drive.

Public Share: You can share your files & folders to public users. You can set password, IP Range, Expire
dates and so on.

Public Share & S-URL uses force.com Sites to create short URL with your brand name. You may need
to buy force.com Sites license to use this feature. (To get more information please visit
https://developer.salesforce.com/page/Sites)

9.1.1 Create A Force.com Site

In order to create a Force.com site, you need to navigate to Setup > User Interface > Sites and
Domains > Sites. In this page, you can create a new site using the New button.
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SETUP
Sites
Site Edit Save | Cancel

site Label | sUrlRedirect [
site Name | sUrlRedirect [

Site Description

L A
Site Contact |ErhanFIRAT Qs e
Default Web Add hitp:ifefirat-develop dilion.eua.force.coma'Esul‘l i o
Active o] 1
Active Site Home Page I UrlRedirect | 1@y Preview] | °
Inactive Site Home Page CM
Site Template | RS
site Robots txt | @y
Site Favorite lcon [ ] CM
Analytics Tracking Code | i
URL Rewriter Class | sUrIRewriter Qi | o
Enable Feeds |
Clickjack Protection Level |__Allow framing by any page (no protection) ¥l o
Require Secure Connections (HTTP5) i
Upgrade all requests to HTTPS =i
Enable Content Sniffing Protection i
Enable Browser Cross Site Scripting Protection L i
Referrer URL Protection =i
Guest Access to the Support API =i

Save | | Cancel

Figure 9-1

1. Site Label: This is the label of your site. You can name it any way you want.

2. Site Name: This is the name of your site. You can name it any way you want.

3. Site Contact: This is the name of the site contact. You can choose any user from
the lookup.

4. Default Web Address: This is the default web address that you will be using for
your S-URLs. You can fill in the input box the way you want.

5. Active Site Home Page: Click on lookup and search for SUrlRedirect. Click on
SUrlRedirect to choose and close the lookup page.
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6. URL Rewrite Class: Click on lookup and search for SURLRewriter (Figure 9-1-6).
Click on SURLRewriter to choose and close the lookup page.
7. Clickjack Protection Level: You can choose any protection level from this option.

Once you configure these fields, click on “Save” button at the bottom of the page.

9.1.2 Configuring the Public Access Settings of your Site

Once you create your site you should also make some configurations. From Setup go to the
Sites section again and find your site. Click on the site name to open the site detail page. Click
on Public Access Settings in this page.

3. Site Details

. Surl

« Back to List: Sites

Site Detail Edit || Public Access Settings || Login Settings | | URL Redirects | | Deactivate

Site Label  SUA
Site Description

Active

Figure 9-2
There are 3 important sections in the Public Access Settings Page.

1. Enabled Apex Class Access: Click on Edit button when you navigate to this section by
scrolling down. A new page will be opened. In this page choose all classes with prefix “cg”
and add them to Enabled Apex Classes.
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[
Enable Apex Class Access

Select the Visualforce pages that you want to make accessible at this Salesforce site

Available Apex Clazses

[ChangePasswordController
|ChangePasswordControllerTest
|CommunitiesLandingController
|CommunitiesLandingControllerTest

Save Cancel

Enabled Apex Classes
cg.SDriveConfigUtil
cg.S0riveController
cqg.SDrive ControllerExtension
cg.S0rivelnstallHandler

| CommunitiesLoginCaontroller Add  |€9.SDriveTools
CommunitiesLoginCentrellarTest [») cg.S0OriveWehServiceUtils
CommunitiesSelfRegConfirmController cg.SQueueBatch
| CommunitiesSelfRegConfimControllerTest 4 cg.SQueusScheduler
|CommunitiesSelfRegController St cg.ShareController
| CommunitiesSelfRegContrallerTest cg.ShareUtil
|ForgotPasswordController cqg.UpdateSDriveObjectBatch
|ForgotPasswordControllerTest cg UploadRequestinfo
|LightningForgotPasswordController cg.sUriController
|LightningForgotPasswerdControllerTest - cg.sUrRewriter

Figure 9-3

Once you add them to the enabled apex classes list, click Save button.

2. Enabled Visualforce Page Access: Click on Edit button when you navigate to this
section by scrolling down. A new page will be opened. In this page choose
cg.EmailPage, cg.HtmlUploadPage, cg.SDrive, cg.SUrlRedirect, cg.UploadPage
visualforce pages and add it to the Enabled Visualforce Pages list.
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Enable Visualforce Page Access

Select the Visualforce pages that you want to make accessible at this Salesforce site.

Available Visualforce Pages

Save Cancel

Enabled Visualferce Pages

cg.MobileCaseFilePage
cg.MobileContactFilePage
cg.MobileFileDeatailPage
cg.Mobile OpportunityFilePage
cg.MobileSDriveDetailPage
cg.MobileSDrivePage
cg.OpportunityFilePage
cg.PreviewAndThumbnailConfigPage
cg.S0riveActivation
cg.SDriveConfiguration
cg.SDriveError
cg.SDriveManualAuthorization
cg.UpdateSDriveObjectsPage
cg.SharePage

Add
L
&)

Remove

Figure 9-4

FileNotFound -
ForgotPassword
ForgotPasswordConfirm
InMaintenance
SiteLogin

SiteRegister
SiteRegisterConfirm
SiteTemplate
Unauthorized
cg.EmailPage
cg.HimlUploadPage
cg.SDrive
cg.SUrRedirect
cg.UploadPage

Once you add the Visualforce page to the enabled list, click Save button.

3. Custom Object Permissions: For editing the Custom Object Permissions, click on the
“Edit” button at the top of the page.

Profile

SUrl Profile

Profile Detail

Login IP Ranges o]

| Users with this profile have the permissions and page layouts listed below. Administrators can change a user's profile by editing that user's personal information
If your organization uses Record Types. use the Edit links in the Record Type Settings section below to make one or more record types available 1o users with this profile

Enabled Apex Class Access [2) | Enabled Visualforce Page Access [12]

Name SUr Profile
User License Guest

Description

CreatedBy  Yasemin Doganci 30/01/2018 13:33

Edit || View Users

Enabled External Data Sod

Figure 9-5

Scroll down to the Standard Object Permissions section and enable Basic Access for SUrls and SUrl Hits

objects.
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l Standard Object Permissions

The permissions defined here confrol access at the object level Access to individual records within that object type is controlled by the sharing model. Set access levels based on the functional requirements for the profile. For example, create different
How do | choose? ?

groups of permissiens for individual

managers, and

Accounts

Assets

Campaigns

Cases

Coaching

Contacts

Contracts

Documents

Feedback

Feedback Questions

Fesdback Question Sets

Feedback Requests

Goals

Read Create
4 4
[l [l
[l [l
[l [l

Edit

Delete

ViewAll ;| Modify All
i
Goal Links
ideas
Leads
Metrics

Metric Data Links

Opportunities

Orders

Performance Cycles

Price Books

Products

Quick Text

Solutions

Read

&

®

®

Create

®

®

Edit Delete

ViewAll ;| Modify All
i

If you want to share an object’s files, please first give permission for its parent object. For
example, if you want to share Account Files, you should also give permission to Account

object.

Choose objects you want to share publicly.

Scroll down to the Custom Object Permissions section and enable Basic Access for SUrls and
Surl Hits objects.

Custom Object Permissions

Account Files

ATrials

ATrial Files
AttachmentSynes
Case Files

Contact Files
ExternalFileMessages
File Activities

Lead Files

Basic Access

Read Create
v v
v v
v v
v v

Edit

4

Delete

v

View All - Modify All

My 530bjects

Opportunity Files

S53Configs

530bjects

SDriveCustom Actions

SUrls|

N N N R N

5Url Hits

Basic Access
Read Create
v v
v v
v v
v 4
v v
v v
v v
v v
v v

View Al Modify Al

v v

Edit Delete

ESEAENEAE A
NN O RN
RN R RN

Figure 9-6
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In the Figure 9-6, red lined objects must be selected. Yellow lined objects are selectable file
objects. You should choose object that you plan to share publicly. Don’t forgot that, if you plan
to share Account Files, permissions should be set Account Files and Account object.

S30bject refers to files on Sdrive Tab, MyS30bject refers to files on MyDrive.

Once you give the access, click on “Save” button at the top of the page.

9.1.3 S-Drive Configuration

When you create the force.com site with these configurations, navigate to S-Drive
Configuration page. Check the “Enable Short URL” checkbox and write the URL of your site to
the “Base URL” input box.

Update Amazon 53 Credentials and Bucket Name  Click here to update

Enable Checksum Verification

Restricted Portal User Profiles

Custom Email Footer (Uncheck to use default email footer) Default Email Footer

Default Email Expiration Time Unlimited

Only Allow Users with Modify All Permigsions to Create ltems
at the Top Level

Enable Email on S-Drive Tab ¥ disable for portal users

Sync Salesforce Attachments with 5-Drive Configure AttachmentSync

Enable Amazon 53 Transfer Acceleration

HEEE W Configure Preview & Thumbnail
-

Enable S-URL ¥ Base URL http://sdrive-developer-editio

Figure 9-7
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Enable S-URL ¥/  Base URL |http://sdrive-developer-editio

Figure 9-8

9.1.4 Checking File Audits

After these configurations, you will be able to use short URLs and also the “Audit” tab in “Details”
page of files and folders will be available. In this page there are different fields of information such as
Short URL, Created Date, Expiration Date, Hit and Download counts, and Total Hit Count.

SHORT URL DAT
w350 ComMalWEOOCOODUDIGMEAT Jan 15, 2018 60940 AM
v, 220 oM A0WS000000URLIBEA) Jan 17, 2018 3:18:06 AM Jan 12, 2038 31806 AM o
w258 o A0WED00000URLIVEAT Jan 17, 2008 522:21 AM Jam 12, 2038 5:72:21 AM
. a5 com a0WEO00000DURLIREAZ 1an 12, 2038 52251 AM o
2 lan 12, 2038 $:233:16 AW &
Jan 17, 2018 73805 AM dan 12, 2038 7-38:05 AM (]
1an 18, 2018 34249 aM sani3 3 34240 AM

2018 T:31:12 AM o

wvew, 250 COm I A0WEO00000UGIGEEAT

nitp Nsdrive-geveloper-adition nat force com fuploadrequest/s0WB000000Ug IHUEAS an 30, 2018 908:03 AM lan 2033 9:08:03 AM

0 AM san 8 7:58.50 AM 1

diition. nat force comyuploadrequest/ 1jrcy| Jan 31, 2018

oB
2

pclition. rad fone. com uphoddreque T2 Jan 31, 2018 302:37 PM Jan 31, 8 31237 P

dition naG force com . upoddrequest wikisy Jan 31, 2016 308:29 PM Jan 31, 2018 3:18:29 PM o

i pdlition. nat force com fuploadnequest fwizgal Jan 2008 308:41 PM Jan 31, 2018 3:18:41 PM 1
i ecition rab force. com fuphoadreque Jan 31, 2018 308.49 PM lan 31, 2018 3 18:49 PM 1
nt pclithon Nal fore com fuploadrogque Jan 31, 2018 308:55 PM lan 2038 3:08:55 PM 2

Lt e-developer-sdition maf fonce com fuploadnequest | Fob 1, 2018 6:15:21 PM 2038 £:14:20 PM o

S0 i uploadiequest/cqani3 Fen 1, 201B6:16:14 PM lam 27, 2038 6:16:14 PM
sdrivetans com/upload,/kjxd Sy Feb 5, 20187 20:54 AM 1an 31, 2038 7:20:54 AM

er-pdition nat force com fuploadreques fedyuln Fen 5, 2018 7-53:32 aM jan 31, 2038 7:33:32 AM i

Q fﬂﬁl'awﬁ' = (1h $11.pdf Ennuﬂﬂm

HITS DOWHNLOADS

Figure 9-9

9.2 S-Actions (Custom Actions)
S-Actions is the new exciting S-Drive feature released on version 2.1. Customers can develop their
custom codes on VF Pages, Lightning Components or Static Resources Scripts and these code
blocks can be embedded to S-Drive component as S-Action.
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S-Drive identifies your VF Pages, Static Resource Scripts or Lightning Component via S-Action
definitions. S-Drive can import your custom action code blocks to S-Drive component in 4 different
types which are Hidden, Display, Redirect or Lightning Component.

According to your S-Action definition, it is added on related objects Action Menus (

| El B ") and Toolbar S-Actions button (el I =) as an option.

When a custom action is selected from menu, S-Drive runs your code blocks sending selected files
id list with action name as parameters. After action is done, S-Drive inform users about action
status.

Let’s add a new S-Action by clicking Add S-Action button on Figure 9-10-1

&
You can create adn add you custom actions to S-Drive. Please see documentation to get details: http:/iwww.sdriveapp com
Name Label Active Multiple Display Interface Objects FileTypes
Delete ﬂ displayFrame Display Frame: Resource v v Display Both All All
Delete || Edit| DisplayFrameVFPage Display Frame: VF Page v v Display Both All Al
Delete ﬂ lightning Lightning Component v v Lightning Component Lightning All All
Delete ﬂ demoActionResource Hidden Frame: Resource v v Hidden Both All All
Delete ﬂ demoAction Hidden Frame: VF Page v v Hidden Both All All
Delete ﬂ redirectSample Redirect Sample v v Redirect Both All All
Figure 9-10
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Save | |Cancel

Name o Label I o
Is Active? | o Multiple o
url I ° Display || —_None-- v o

Interface Type I --None-- v o File Types o
A

OBJECTS * No selection means all objects are available USERS * No salection means 3!l users are available
Available Objects Selected Objects o All Users Selected Users 0
[Account File iz I = [User: CyanGate CyanGate | >
Case Flle‘ 13 ;User: Erhén FIRAT »
| Contact File ‘User: SDrive Dev
Contract File [ 4] |User: Chris Brown 4|
Lead File L) |User: Gabby Dogan u

|MyCustomFile
My Example Object File

| MyS30bject
| Opportunity File 2] ]|
| Package File v v
Save | |Cancel
Figure 9-11
1. Name

Your custom action name should be action definition without space and special characters (i.e.
“deployToWebsite”). This will be sent to the Action code blocks as a URL parameter.

2. Llabel
Label will be listed on “Action Menu” and Toolbar S-Actions menu button. (i.e. “Deploy To Website”)
3. IsActive

This Boolean field holds S-Action is currently active or not. If it is set to unchecked, it won’t be listed
on Actions menu.

4. Multiple

This Boolean flag determines whether the action is for multiple files or not. If it is just for single files, it
will not be listed in Toolbar S-Actions menu button.

5. URL

This field holds URL information of you VF pages, Static Resource Scripts, Lightning Component name
or URL to Redirect. For;
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e VF Pages: “/apex/[YourPrefix__YourVFPageName]” i.e. “/apex/cg__CustomActionSampleVF”.
If your organization does not have any prefix, please write “c__” prefixoniti.e.
“/apex/c__CustomActionSampleVF”.

e Static Resource Scripts: “/resource/[ResourceName]/[ScriptFile]”. i.e.
“/resource/cg__caDeployFrame/caDeployFrame.html”

If your organization does not have any prefix, please write “c__” prefixoniiti.e.
“/resource/c__caDeployFrame/caDeployFrame.html”.

e Lightning Component: “[YourOrganizationPrefix]:[YourComponentName]” i.e.
“cg:MyCustomActionComponent”.

If your organization does not have any prefix, please write “c” prefixon it i.e.
“c:MyCustomActionComponent”.

e URL to Redirect: It is simple web URL of your service. i.e. “https://cgsdrive-dev-

ed.lightning.force.com/one/one.app”

NOTE! For VF Pages, Static Resource Scripts and URL Redirect options, selected file Ids and action
name are sent as URL parameters. For example, if you have deploy action on VF page, and URL is set to

“/apex/cq__deployPage”. On action fire, URL will be similar to this example: “/apex/cg__
deployPage?actionName=deplotTolWebsite&104ields=a038000000mqyR6AAL, a038000000sx1QDAAY? .

6. Display

There are four display types bond to script type and behavior of S-Action. You can set an action work
on background with nothing to display except for informational toaster message, or you can embed
your custom action scripts within Iframe.

a) Hidden Frame

On this type of S-Actions, your VF Pages or Static Resources can be embedded to S-Drive Component
as a hidden Iframe. This type of S-Actions is suit for running on background process without any
feedback of users. For example, you want to upload selected files to your personal website by one
click. After you write your apex code and VF page, just select files on the list and click your custom
action on the toolbar. And it will work on background to complete process, after completed it will
inform user by a toaster message.

S-ACTION URL: When a hidden type action is clicked this URL will be created:

[YOUR_S-ACTION_URL] + ?actionName=[S-ActionName]&componentld=1&104ields=[selectedFilelld,
selectedFile2id]
“/apex/uploadToServer?actionName=uploadToServer&componentId=18&104ields=0018000001UeY2TAAV, 00
18000001UeR44EEY”
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b) Displayed Frame

For this one VF Page is shown on the component main screen within Iframe (Figure 9-12 — 1).
After S-Action is done, you can give information to users by postmessage method (Figure 9-12
—2). You can close Iframe by using Back button (Figure 9-12 — 3).

&Sy S-Drive

Animals

Archive

Test Query Limits
tree

trial

try try try

upload test folder

vV VvV VvV VYV YV

'a' Recycle Bin

Response message for users

| @ Deploy Action

| HOME
i §
8 n §

Custom Action Display Frame

DO!

Figure 9-12

S-ACTION URL: When a hidden type action is clicked this URL will be created:
[YOUR_S-ACTION_URL] + ?filelds=[selectedFilelld, selectedFile2ld]&actionName=[S-ActionName]
“/apex/uploadToServer?fileIds=0018000001UeY2TAAV, 0018000001UeR44EEY&actionName=upload

ToServer”
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VISUALFORCE PAGE SAMPLE:

<apex:page controller="CustomActionSampleController" >
<apex:form >
<apex:actionFunction name="updateFilesAF"
action="{!updateFiles}" rerender="actionResults"
oncomplete="updateFilesFinished();" />
</apex:form>

<apex:outputPanel id="actionResults">
<script>
function updateFilesFinished () {
var result = {
process: 'S-Action', // Required field to show
toaster
actionName: '{'!'actionName}',
componentId: '{!componentId}',
type: '{lactionResult}', // ['error', 'warning',
'success', 'info’]
title: 'Select All Action',
message: '{l'actionMessage}',
refresh: true // refresh file list on S-Drive
}i
var resultStr = JSON.stringify(result);
parent.postMessage (resultStr, "*");
}
</script>
</apex:outputPanel>

<apex:outputPanel rendered="{!actionName == 'updateFiles'}">
<script>
updateFilesAF () ;
</script>
</apex:outputPanel>
</apex:page>
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CONTROLLER:

public class CustomActionSampleController {
public String actionName {get;set;}
public List<String> filelIds {get;set;}
public String componentId {get;set;}
public String actionResult {get;set;}
public String actionMessage {get;set;}

public CustomActionSampleController () {

actionName =
ApexPages.currentPage () .getParameters () .get ('actionName') ;

componentId =
ApexPages.currentPage () .getParameters () .get ('componentId') ;

fileIds = new List<String>();
String fileIdsStr =
ApexPages.currentPage () .getParameters () .get ('filelds');

if (!String.isEmpty(fileIdsStr))
fileIds = fileIdsStr.split(',");

public PageReference updateFiles () {

actionMessage = '';
if (filelIds.size() >= 1) {
String queryStr = 'SELECT id, cg File Name c,
cg_ Description ¢ FROM cg AccountFile ¢ WHERE id = :filelds';

List<cg AccountFile c¢> files =
Database.query (queryStr) ;

for (cg_ AccountFile c¢ file: files)

file.cg Description c¢ = 'S-Action';
try {

update files;

actionResult = 'Success';

actionMessage = 'Files are updated

successfully!';

}

catch (Exception e) {
actionResult = 'Error';
actionMessage = e.getMessage () ;

}

return null;

DRIVE CyanGate
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As you can see, after CustomActionSampleController instantiated, we get parameters from page URL.
On VF Page output panel renders if action name is right, and it executes the Action Function named
“updateFilesAF”. After action is completed, “actionResults” panel is re-rendered to inform S-Drive
component on parent page via parent.postMessage(). S-Drive component catches message and do
necessary reaction.

c) Redirect

In this option, you can redirect users to given URL in a new tab with parameters 108ields and
actionName.

URL will be: [YOUR_S-ACTION_URL] + ?filelds=[selectedFilelld, selectedFile2ld]&actionName=[S-
ActionName]

i.e. https://cgsdrive-dev-ed--
cg.nab.visual.force.com/apex/TestSActionPage?actionName=redirectSample&filelds=a038000000mgyR
6AAI,a038000000sx1QDAAY,a038000000sx1iEAAQ

d) Lightning Component

You can also embed your custom Lightning Component into S-Drive by S-Actions. Please be sure you
map your S-Action URL correctly for Lightning Component (Please see URL Section).

For lightning component Filelds and ActionName parameters are sent to component as component
attribute. Here is an S-Action Lightning Component sample:

<aura:component access="global" >

<aura:attribute name="fileIds" type="String[]"
access="global" />

<aura:attribute name="actionName" type="String"
access="global" />

NOTE! Make sure your Lightning component and 108ields & actionName attributes are set to
access="global”.

7. Interface Type

You can select your custom action interface type here. It can be just for Salesforce Classic, it can be
just for Lightning or it can be for both interface types of Salesforce. Note that on 2.2.8 release all S-
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Action types are available in Lightning. Additionally, hidden type action is available in Classic
Attachment Component.

8. File Types

You can limit your S-Action to work defined file types only. If leave this field empty, it means action is
available for all file types and Folders. If you write file extensions comma separated, it will be shown
only these file types. i.e. if you put “jpg,png,gif,Folder”, the action will be listed only these file types’
action menu. As you can see on the example, you can define folders as “Folder” text.

9. Objects

You can limit your S-Action to work with only selected file object types. If you leave this field empty, it
will mean the action is available for all object types.

On the left box, named Available Object, you can see all file objects that is related to S-Drive

component. For example, if you got an action which is only for Case File, you should move Case File
option to the right box named Selected Objects. Please see Figure 9-13.

S-Action Panel

Save | Cancel

Name  llightning
Is Active? 7
url |cg:CuslomerComponent’éarrA

Interface Type | Lightning v

OBJECTS * Mo selection means all objacis are available USERS " No:
Available Objects Selected Objects All Users
Account File A Case File - |User: Cyant
|Contact File » User: Erhan
Contract File |User: SDrivt
»Lead File ] w User: Chris
|MyCustomFile User: Gabb
My Example Object File

MyS30bject

Opportunity File

|Package File

|S30bject v v

Save | Cancel

Figure 9-13
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10. Users

You can limit your S-Action to work for only some users. Empty list means action is available for all
users. For example, if you got a Web site manager, and you want to give deploy action permission only

for her/him. Then, you should select the user on the All Users list and you should move User to the
Selected Users list. Please see Figure 9-14.

Display | Lightning Component ¥

File Types
VA

USERS * No selection means all users are availaoie
All Users Selected Users
User: CyanGate CyanGate 5 |User: Erhan FIRAT R
User: SDrive Dev L P
User: Chris Brown
User: Gabby Dogan (4]

| )

|
Figure 9-14

9.3 Lead Conversion

This section explains how to enable/disable copying files that are attached to a Lead, to Accounts /
Contacts / Opportunities.

Enable copying S-Drive
files and folders when
Converting Leads to

Contacts ¥ Accounts ¥ Opportunities

Figure 9-15

If you want to copy the files in one of your leads to converted contact, account or opportunity, all
you have to do is to check the required checkboxes in S-Drive Configuration page, shown in Figure
9-15. (Also refer to section 8.2.9.2 Enable Copying S-Drive Files and Folders When Converting
Leads To). Checking these boxes will activate a trigger called ConvertLead on Lead object.
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ConvertlLead trigger works for copying files from cg__Lead_File__c object to cg__AccountFile__c,
cg__ContactFile__c, and cg__OpportunityFile__c based on your selection. If you enabled S-Drive
for Leads, Accounts, Contacts or Opportunities by using your own custom file objects, this trigger
will not be able to move your files from the lead to converted contact / account / opportunity.

You will be able to see your folders immediately after the conversion process, but for being able to
see the files, you need to execute batch-jobs. For more information on daily batch-jobs and
SQueue, please see ‘Select SQueue — daily batch jobs — execute time’ section. The conversion of
lead files is handled with SQueue, and when the queue is executed, the files will be copied to the
converted contact / account / opportunity, and you will be able to display your files.

9.4 Hidden Custom Settings
This section explains the hidden custom settings that are not exposed to the end users via "S-Drive
Configuration" page. You can manage these configuration objects via Setup -> App Setup ->
Develop -> Custom Settings menu. Then you can click "Manage" next to the "SDriveConfig" label
and add these custom settings with appropriate values.

MultipartUploadThresholdSize: This configuration is used for HTML Upload and Java Upload
Widget to decide normal upload or multipart upload based on the file size. Default is 5 MB. So,
files above 5 MB (or configured value) will be uploaded via multipart upload mechanism, below 5
MB (or configured value) will be uploaded via normal upload mechanism that is used same way in
Flash Upload Widget.

MultipartUploadPartSize: This configuration is used for HTML Upload and Java Upload Widget to
split the file to be uploaded into parts for multipart upload. Default is 5 MB. This value can be
between 5 MB and 5120 MB. So, if you'll upload a 50 MB file while this configuration is set to 5
MB, it'll split the uploaded file into 10 parts while uploading.

CustomPopupMessage: This configuration is used for HTML Upload to customize the default
message in it. If you do not add this configuration, "Drag files here or click Add (+) button to select
files for upload." message is displayed by default.

9.5 External Files

First, enable Files Connect, and let users access related external data sources Let Users and
Administrators Access Files Connect Data Sources. For cloud-based data sources, create an
authentication provider, and then define the source. Now users can access and share external files
via the Files tab and feed, and search for them right alongside their Salesforce content.
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Auth. Provider

Auth. Provider Edit

Auth. Provider ID
Provider Type
Name

URL Suffix

Consumer Key
Consumer Secret
Authorize Endpoint URL
Token Endpoint URL
User Info Endpoint URL
Token Issuer

Default Scopes

Send access token in header
Custom Error URL
Custom Logout URL

Registration Handler

Execute Registration As
Portal

leon URL

Created Date

Detailed explanation on how to configure files connect with external storage platforms and
synchronize with salesforce is given in the following link;

https://help.salesforce.com/articleView?id=admin_files_connect_overview.htm&type=5

After configuring the data sources and objects, user is expected to create a new workflow rule for
external outbound message trigger. That is, go to setup-> workflow rules, and select new button.
And select object as ExternalFileMessage given the figure below. (Figure 9-17).

Save | Save & New | Cancel

0S0B0000000GMdX
Open ID Connect
I Mert'sGoogleDrive

I Mert_sGoogleDrive
|7
|-

I https:faccounts.google.comfofoauth2fauth?access_type=offline&approval_prompt=force

I https:/faccounts.geogle.comfo/oauth2/ftoken

https:/jwww.googleapis

i

Lt ically create a ion handler template

--None--

Choose one of our sample icons
2/23/2018 1:57 AM

Save | Save & New | Cancel

Figure 9-16

Send client credentials in headar
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Workflow Rule

New Workflow Rule

Step 1: Select object

Select the object to which this workflow rule applies.

Object | ExternalFileMessage

Figure 9-17

When save is clicked, user is now able to configure workflow, and supposed to fill the fields as
given in the following figure. (Figure 9-18)

New Workflow RM.
ExternalFileMessage

Enter the name, description, and criteria to trigger your workflow rule. In the next step, associate workflow actions with this workilow rule.

Edit Rule
Object  ExtemalFileMessage

Rule Name | xDriveMessageRule

Description ‘

Evaluation Criteria

Evaluate the ruls whon a record is: () created
() created, and every time it's edited
b © crested, and any time if's edited to subssquently meet criteria ;|

How do | choose?

Rule Criteria
Run this rule ifthe | criteria are met B:C
d Field Operator Value
| Created Date [noteauaie [ AND
--None-- --None-- AND
~-None -~ B --Nore-- AND
--None-- --None-- AND
--None-- --None--
Add Filter Logic...

Figure 9-18
(a) “RuleName” : can be chosen anything but unique name for this defining rule.

(b) “Evaluation Criteria”: expected to be chosen as created.
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(c) “Run the rule if the” : criteria are met

(d) “Field — Operator - Value”: field is chosen as Created Date, and operator is ‘not equal to’
and value is set to blank.

In the next page user is expected to add workflow action to this rule.

Edit Rule xDriveMessageRule

Specify the workflow actions that will be triggered when the rule criteria are met. See an example

Rule Criteria  ExternalFileMessage: Created Date NOTEQUALTO null
Evaluation Criteria  Evaluate the rule when a record is created, and any time it's edited to subsequently mest criteria

Immediate Workflow Actions
No workflow actions have been added
T |

Time-Dependent Workflow Actions See an example

I @ Noworkfiow actions have been added. Bafore adding a workfiow action, you must have at least ane time trigger defined

| Add Time Trigger|

Figure 9-19

(a) “Immediate Workflow Actions”: Add workflow action is chosen as new outbound message

The new Outbound message should be configured as in the following figure.
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New Outbound Message

Enter the details of your outbound message and select the fields you want included in this message. Note thal the fields available depend on the type of record previously selected.

Edit O ge: Externalf a

Name  [yDriveMessage

Unique Name | yprivemessage i

e b
4 —

Endpoint URL | https:/jportal.sdriveapp.com/externalfiles/download
Usartosandas | pamo SDrive @
Protected Gomponent

Send Session ID d

ExtarnalFileMessage fislds to send -
Available Fields Selected Fields

CreatedByld id
IsDeleted CreatedDate
LastModifiedByld cg_filelds_c
et S e @
Name Add  og namespace_c
Ownerld |.» ] |ca_organizationid_c
SystemModstamp 4 cg__parentld_c
(4] e s e
Remove | g sDriveFolderld_c

Figure 9-20
(a) “Name”: Unigque name for the outbound message
(b) “Endpoint URL”: should be given as https://portal.sdriveapp.com/externalfiles/download
(c) “User to send as”: should be chosen as system admin
(d) “Send Session 1d”: should be checked

(e) “Fields to Send”: Created Date, and all the fields start with prefix cg__ should be chosen

And finally, user is expected to activate this workflow rule as given in the following figure. (Figure
9-21)
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Workfiow Rula
xDriveMessageRule

Workflow Rule Detail Edit | | Delete | | Glone | | Activate
Ruls Name  xDriveMessageRule Object  ExternalFileMessage
Active Evaluate
Doscription

RuleGritria  ExternalFileMessage: Created Date NOTEQUALTO null

Greated By  Demo SDiive, 6/7/2018 12:14 AM Modified By  Demo SDrive, 61712018 12:14 AM
Workflow Actions Edit

Immediate Workflow Actions.

Type Doscription

Outbound Message xDrveMessage

i Actions

[ @ Noworkfiow actions have been added. Before adding a workfiow action, you must have at least one fime trigger defined.

Figure 9-21

By clicking the button Activate as given in (a), user should observe the Active checkbox to be
checked in given (b).

After configuration, before starting the process, user is expected to go to FILES tab and activate
files connect by clicking on according cloud storage platform and authenticating.

9.6 File /Attachment Sync

File/Attachment Sync takes files that are uploaded to Salesforce Files or Salesforce
Attachments and syncs them with S-Drive for the selected object. Sync is processed based on a
gueue, so new items will appear in S-Drive in a few seconds/minutes.

Once you configure File/Attachment Sync with S-Drive, you can start using File/Attachment Sync
features. See section 8.4.3 File/Attachment Sync to configure this feature.

Below is an example screenshot after user uploads an attachment to the Attachments section of
the Cases. Attachment is uploaded into the S-Drive immediately.

Attachments Adtach File | | View All
Action File Name size Last Modified Created By
Edit | View | Del notes.ong 143KB 111312014 412 Al Demo CvanGate

Case History

No recerds to display

Case Files New Folder | Upload File(s)  Attach from S-Drive Folders |Email Selected Delete Selected
Home Totalttems: 1 ( Search Q)
[T Actions I File Name & Created Date _Created By ID i File Size Case Case File Name_Deleted Last Modified By ID_Last Modified Date _Record ID System Modstamp Private
~ 11312014 Demo 14341 .
= @ pna E s M a0s! ! 1
B tem Actions ) notes.on et b o4t 00001024 201401144 DemoCanGate  1113/2014 412 Al a05A000000CNSHI 11132014 412 AM

Total Items: 1

Figure 9-22
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Below is an example screenshot after user uploads a File to the Files section of the Accounts. It
creates into the S-Drive.

&) Files Upload Files
Action Title Last Modified Created By
Preview | Download | Del sample 26.07.2019 15:01 Mustafa Asql
~BackTo Top Y Always show me fewer 4 [ 'W more records per related list
Account Files New Folder | | Upload Download | | Attach from §-Drive Folders | | Email Delete | | Recycle Bin ut| |Copy || Paste
Drag and drap file(s)
Home 1items in1 page | Q)
O |~ | W~ |i| eview~ E
Actions T File Name ¥ Created Date Created By ID Description File Size Tags
Ol&|z|a - B sample.jog 26.07.2019 15:01 Mustafa Ascl 2164KB
1items in1 page
Figure 9-23

You should also note that sync operation only happens once the file is uploaded to the Salesforce
Files/Attachments section. Deletion or updates to the Salesforce File/Attachment do not delete or
update the synced item in S-Drive section. Sync is triggered only with addition of a new Salesforce
File/Attachment. Sync is only one way, so any changes to the S-Drive are not reflected to
Salesforce File/Attachment. After sync’ing, those files/attachments are two distinct objects.

This process also does not sync the previously created Salesforce Files/Attachments before the
sync configuration. You can sync those files with S-Drive navigating to “S-Drive Configuration - >
Micro Services -> Sync Salesforce Files/Attachments with S-Drive -> Configure File Sync of Pre-
existing Files” section. See section 8.4.3 File/Attachment Sync for details.

9.7 S-Drive Reports

You can create File Activity reports for the S-Drive files. For Accounts, Cases, Contacts,
Opportunities and S30bjects reports are enabled by default. For other standard/custom object
files you need to create a lookup relationship under File Activity object:

Go to Setup -> App Setup -> Create -> Objects and click the "File Activity" object name. Scroll to
the "Custom Fields & Relationships" for the object and click "New" button. In "Step 1. Choose
the field type" screen, select "Lookup Relationship" and click "Next" button. In "Step 2. Choose
the related object" screen, select "Related To" from the drop-down as your object file (e.g. My
Example Object File) and click "Next" button. Keep default values for other steps and click "Save"
button in the last step.
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The following file activities are recorded by S-Drive and can be displayed in standard
Salesforce.com reports:

1) S-Drive OneClick Download: When user clicks the file name or "Download" link in the S-Drive,
the activity is saved with "S-Drive OneClick Download" type. This activity does not necessarily
mean that the file has been completely downloaded to a user’s desktop, instead user has clicked
on the "Download" link and the download has been initiated. Since the "One-Click" downloads are
handled by the browser, completion of the downloads cannot be tracked.

2) S-Drive CopyUrl Download: When user clicks "Copy URL" link in the S-Drive, the activity is
saved with "S-Drive CopyUrl Download" type. This activity does not necessarily mean that the URL
has been used to download a file, instead a URL has been created by a user.

3) S-Drive Zip & Download: When user starts a download using "Zip & Download", this type of
activity is created.

4) S-Drive Email Sent: When user sent an email with attachments using S-Drive, this type of
activity is created for each attachment. The comma separated recipients of the email are also
stored in the "Additional Details" field of the File Activity.

To create S-Drive Reports, follow these instructions:

1. Click "Reports" tab and click "New Report..." button in the tab (Figure 9-24).

Home Chatter Files Campaigns Leads Accounts Contacts Opportunities Contracts Cases Solutions Products

Reports & DaShboardS Hew Report...| | Hew Dashboard...

Reports

Folders All Folders
Q Find a folder... b
Q, Find reports and dashboards...
All Folders
|1 Unfiled Public Reports Action  Name Fol
1 My Personal Custem R... || [ Cases Report My

| My Personal Dashboards
|__| Account and Contact R....
| Opportunity Reports

Figure 9-24

2. In the "Create New Report" screen, "Select Report Type" needs to be selected as "Other
Reports". Scroll to the "File Activities" section of the "Select Report Type" and select the report
type that you want to create. For example, if you want to get the report for Account Files you
need to select "File Activities with Account File" from the list and click "Create" button. (Figure
9-25).
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’ Help for thiz Page &

Create New Report

Select Report Type

2 Preview
Q Quick Find A g
Mo preview available.

I ALCUUNILS & LUHd UL

# ] Opportunities

|| Customer Support Reports

# | | Leads

# || Campaigns

# ] Activities

] Contract Reports

[#|_| Price Books, Products and Assets

[| Administrative Reports

- i Other Reports
File Activities
File Activities with Account File
File Activities with Case File
File Activities with Contact File
File Activities with Opportunity File
File Activities with S30bject
S30bjects -

m

Cancel | Create

Figure 9-25

3. After clicking "Create" button, report creation screen will be displayed (Figure 9-26). You can
drag and drop the fields that you want in your report. For example, in the below screenshot it is
displaying Account File Name, Account File Size, Activity Type, Additional Details and Created Date
columns. You can filter the results using the "Filters" section. To run the report using the actual
data, you can click "Run Report" button or you can save the report for future use by clicking
"Save" button. Please refer to the Salesforce.com documents about "Reports" for detailed
information related to report creation.

T JTTsdVeEU IEPUTT

Save Save As Close % Report Properties | o Run Report
T, W 7s)| e el ™
—

Show | my file activities B4

Date Field | File Activity: Created | ¥ | Range| allTime [w| From g T =

To add filters, click Add.

Pravie Jabular Format ¥ Show ¥  E=moye All Columns

@ Account File- Description Account File: File Name Account File: File Size Activity Type Addi Details A it File: Created Date
@ Account File: File Mame P —
# Account File: File Size in Bytes
@ Account File: File Size Mo data was retumed. Check report filters.
# Account File: WIP

# Account File: Private

@ Account File: Parent Felder Id

Figure 9-26
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In "S-Drive Reports", two fields are important: "Activity Type" and "Additional Details". Activity
types are explained at the beginning of this section. "Additional Details" field is important for the
"S-Drive Email Sent" activity type and it stores the recipients of the email sent. You can get the
details of the email by checking the contact's (or object's) Activity History.

Here is an example report for the Account Files (Figure 9-27).

€ File Activity with Account File Report

Report Generation Status: Complste

Report Options:
Time Frame
Summarize information by: Show Date Field Range
--Mone— ~ My file activities - File Activity: Created Date ~  Custom -
From To
&Rﬂon * | | Hide Details | | Customize | | SaveAs | | Printable View | | Export Details
Account File: File Name Account File: File Size Activity Type Additional Details Account File: Created Date
My Test File txt 21 bytes S-Drive OneClick Download - 8112011
My Test File.bet 21 byles S-Drive CopyUrl Download - antizon
My Test File.bat 21 bytes S-Drive OneClick Download - 8M1/2011

My Test File txt 21 bytes S5-Drive Email Sent test@cyangate com a8M1/2011

Figure 9-27
% Notes

1. S-Drive Reports can only be run only for the actual files on the system. Deleted
files are not included in the reports. Also changes to the files are reflected to the
files. This is because objects are kept as references in the system and if that
reference is updated/deleted, reference changes.
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9.8 Email "S-Drive Folder" Files from an Object using a Custom Button

Note: This feature can be enabled by using "Attach from S-Drive Folders" button on any S-Drive
object. Refer to "Emailing Files" section of S-Drive User Guide.

Instructions for Case Files are provided below, but you can follow the same instructions for
Accounts, Contacts, Opportunities or other standard/custom objects:

.1. Navigate to Setup -> Customize -> Cases -> Buttons, Links and Actions. Click New Button or
Link button.

.2. Fillin Label and Name fields, select Display Type, Behavior and Content Source areas as in
the figure below then type window.open('apex/cg__Sdrive?objectld={!Case.ld}') into the
formula area. If you would like to open S-Drive page as inline and without header, type
window.open('apex/cg__Sdrive?objectld={!Case.ld}&inline=1') instead (Figure 9-28).

Email S-Drive File

Custom Button or Link Edit Save | |Quick Save | Preview|  Cancel

Label | Email S-Drive File
Name | Email S Drive File
Namespace Prefix  cg

Description

Display Type Detail Page Link View example
» Detail Page Button View example
List Button View example
Behavior I Execute JavaScript v | View Behavil

Content Source | OnClick JavaScript ¥

Select Field Type Insert Field
Case v | |- Insert Merge Field - M Insert Operator ¥

I"i'l:dc"f-- open ('apex/S5drive?obiectcId={!Case.Id}"}

Figure 9-28

.3. Click Save button.

4. Make sure that you have added the custom button into Case page layout. You can’t see the
"Email S-Drive File" custom button on Case page, if you do not add to the Case object’s page
layout.

.5. Open acase record and click on the custom button (Figure 9-29).
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P Case
00001209

Jlk Hide Feed Click to add topics

R
@ post ] File (@ Link gfj Poll @ Folow

Write something... Followers

Mo followers.
Q| Show All Updates

There are no updates.

Case Detail Edit | |Delete | Close Case| | Clone | Email S-Drive File ¢

Case Owner EAdmin User [Change
Case Number 00001209

Contact Name
Account Name
Type
Case Reason
Date/Time Opened  12/17/2015 3:42 AM
Created By  Admin User, 12/17/2015 3:42 AM
Subject

Description

Edit | | Delete | Close Case| | Clone | Email S-Drive File

Figure 9-29

.6. Select files to send as an email and click Email button (Figure 9-30).

O ||| liw i & | & | & || 3 |i| 8 | 5§ a| | |5 2&view~

Actions i File Name « Created Date
W|&|z|a||~ 8 PuGuyai 0/4/2019 8:20 AM
S S . GIF
B (x[ala] |~ 1 L sdrive tab folder 9/18/2019 7:16 AM
o [a]z|a] [« B Shandy.jng 0/4/2018 8:20 AM
Figure 9-30

.7. You can see that "Related to" field is populated with related Case (Figure 9-31). Fill in the
other fields and click Send button.
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Email 3
send| | select Template| [Close
Email Format Text-Only [Switch to HTML]
To Test Contact =N}
| retatec 7o Case: 00001200 ||
Additional To
A%
cc ‘CS
BCC
A%
Subject  [lAbout the Case
Body
e
Attachment 7
el Never Expires
2 attachment(s) | pertailes
#| Use Email Signature
Send Select Template Close
Figure 9-31

.8. You can follow the same instructions for other objects. If you would like to create a custom
button on Account, apply all the instructions for Account object and type
"objectld={!Account.Id}" into formula area, instead of "objectld={!Case.ld}" while creating a
custom button on Account. For any object, type "objectld={!ApiNameOfAnyObject.Id}" into
formula area.
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10 PROFILE PERMISSIONS, OWD, AND SHARING RULES

S-Drive is sharing-aware, meaning that it will respect the organization-wide default (OWD) sharing
settings and sharing rules applied on S30bjects (files uploaded to the S-Drive Tab) and other S-Drive
file objects. Account Files, Case Files, Contact Files and Opportunity Files are set to “Controlled by
Parent” in the OWD and cannot be changed. S30jbects and Lead Files can be set to Private, Public
Read Only, or Public Read/Write.

Additionally, for S30bjects (files on the S-Drive Tab), you can manually share files and folders using the
“share option” on the dropdown action menu.

@ Notes

S-Drive does not remove the buttons and menus from the user interface based on restrictions.

This is due to the limitations of Salesforce.com APIs. All restrictions are enforced while users

are attempting different operations. For example, if a user tries to delete a file where the user

has read only access, the user will be able to click on the "Delete" button for that file, however

user will not be able to delete the file and a warning message will indicate that the user does

not have sufficient privileges to delete that file.Profile settings for S-Drive Objects
You can apply profile-based permissions on S-Drive custom object files. S-Drive supports four
different access levels:

e None

e Read

e Read + Create + Edit and

e Read + Create + Edit + Delete

To set these profile-based permissions go to Setup and find Profiles, and edit the profile you want
to change.

Note that you cannot change the standard profiles’ permissions. You may need to clone them
before you can edit.

Inside the Edit screen of the selected profile, scroll down to the "Custom Object Permissions"
section. You’ll see the "Basic Access" selections for your custom object files. You will need to
check/uncheck these boxes based on your needs (Figure 10-1). Note that again you can edit
"Custom Object Permissions" for just "Custom Profiles". You may need to clone your standard
profile to be able to edit a profile. Refer to the Salesforce.com documentation for more
information.
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There are four access levels: Read, Create, Edit, and Delete.

Custom Object Permissions

Create Edit Delete View Allo Modify Allo
Account Files
Case Files
Contact Files

Contract Files
My Example Objects
My Exampie Object Files

!!!!!!!i
IR B © @ &
R EE @ E
o | | W
o |

Opportunity Files

o HIEE B E & E

Figure 10-1

10.1.1 S-Drive File Object Permissions

10.1.1.1 No Permissions Enabled
If you uncheck all boxes for your standard/custom object file, your users belonging to this profile
won’t be able to see the S-Drive file area at all, so they won’t be able to do anything with custom
object files.

Note: "No Permission Enabled" is not supported for S30bjects custom object.

10.1.1.2 Just Read Permission Enabled
Allows users to

e Email files
e Download files
e copy URL of file to clipboard

Does not allow users to

e upload files
e delete files
e edit description of files

10.1.1.3 Read, Create and Edit Permissions Enabled

Allows users to

e Email files
e Download files
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e copy URL of file to clipboard

e upload files
e edit descriptions of files

Does not allow users to

e delete files

10.1.1.4 Read, Create, Edit and Delete Permissions Enabled

Allows users to

e Email files

e Download files

e copy URL of file to clipboard
e upload files

e edit descriptions of files

o delete files

10.1.1.5 Permission Combinations That Are Not Supported for Attachment Files

Permission combinations other than above examples are not supported by S-Drive and we
strongly recommend you not to use unsupported permission combinations.

10.1.2 Other S-Drive Object Permissions
In order to access all of S-Drive’s features, enable permissions for the following objects:

e AttachmentSyncs

e File Activities

e MyS30bjects

e Previews

e S3Configs

e S30bjects

e SDriveCustomActions
e SQueues
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10.2 Organization-Wide Default Sharing Settings
To set Organization-Wide Defaults, go to Sharing Settings in Setup.

Organization-wide defaults and “Grant Access using Hierarchies” work for S-Drive objects the same as
for any other object. If Grant Access Using Hierarchies is enabled, users have full access to files and
folders owned by users in roles below them in the hierarchy, including the ability to upload files to
folders of users below them and create sub-folders for users below them.

The following table shows what users can do with other users' files and folders in S-Drive, not
considering role hierarchies. If hierarchies is enabled, users can access files and folders of users in

roles below them in the hierarchy as if they owned the files/folders themselves.

Permission | See | Download | Edit | Delete | Cut | Copy | Upload | Create Folders
Private X

Public Read | x X

Only

Public X X X X X X X X
Read/Write

10.3 Sharing Rules Settings

You can give Read Only or Read/Write access levels to S30bjects by creating Sharing Rules. S-Drive
file objects are controlled by parent with the exception of Lead Files.

Go to Sharing Settings in Setup and scroll down to the "S30bject Sharing Rules" to create a new

rule.

Note that sharing rules can only be used to grant wider access to data, not to restrict access.

Sharing Rules for S30bject or other standard/custom objects are not supported for "Public
Read/Write and Hierarchy Enabled", because this is the widest access option to the data.

Setting data access to the widest and trying to restrict is not supported by Salesforce.com.

So, first you need to restrict data access using "organization-wide default sharing settings". Then,

you can apply sharing rules to S30bjects or other standard/custom objects.
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10.4 Manual Sharing with Action Menu Share option

Manual sharing is supported for files uploaded to the S-Drive Tab only—those files not associated with
a standard or custom object. If the OWD for S30bjects (representing the S-Drive Tab files) is set to
Private, then the “Share” action menu time will be available for a selected file or folder. (Figure 10-2)

&Sy S-Drive
#) asRon Ooaann
> [ sdrive tab folder HOME
&‘ Recycle Bin - | Show. 100 :;perpage
ACTIONS TYPE V FILE NAME
< R R E PurpGuy.gif

R R 4 m sdrive tab folder

R N 4 Shandy.pg

Download
Copy URL
Details
Edit

Delete

Public Share

Post to Chatter

Figure 10-2
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11 S-DRIVE IN SALESFORCE.COM COMMUNITIES

11.1. Enabling Communities for Your Organization

Click Setup -> App Setup -> Customize -> Communities -> Settings (Figure 11-1).

App Setup
B Customize
+| Tab Names and Labels
+/ Home
v Activities
v Chatier
B Communities H:«'/
Settings
Figure 11-1

In the "Communities" page, first check "Enable Communities" checkbox. Then type a unique domain
name that will be used in all your communities. Note that this name can't be changed after you save
it. Click "Check Availability" button and if "Success" message is shown click "Save" button (Figure
11-2).
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Communities

Communities are spaces for employees, customers and partners to collaborate on best practices and business processes. Learn more

To get started with communities, you must first enable it and select a domain.

Save

Enable communities
\Amportant Once you enable communities, it cannot be disabled. Enabling communities also permanently turns on the new user interface theme and the universal header. Learn more

[¥] Enable communities

Select a domain name
Important The domain name will be used in all of your communities and can't be changed after you save it

Sample Community URLs

Sample Domain Name MyCompany.force.com/customers

e MyCompany.force.com/developers

MyCompany.force.com/partners /

-developer-edition.na7 force.com | Check Availability

MyCompany.force.com

Domain “amel'c_:yangate—test

& Success! Domain name available /

Save

Figure 11-2
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11.2. Creating a New Community

Once you enable Communities for your organization, you can create new communities (Figure 11-3).

You can click "New Community" button to create a new community.

Manage Communities

=
@ Success! You can now create new communities.

[The list shows all communities in your organization. Clicking on the Community Name link takes you directly to the Community. If you're not a member, the Community Name is not a link.

All Communities New Community

No Communities

Figure 11-3

Type in the details of the new community and click "Create" button (Figure 11-4).

Create Community

* Name Test Community

Description

URL  cyangate-test-developer-edition.na? force.com/ tesﬂ

After creating a community, you can continue to customize it. It is visible only to administrators until you
publish it or share the URL.

Create | | Cancel

Figure 11-4

Once you click the "Create" button community will be created in a few seconds (Figure 11-5).

Create Community

& Community created!
Your community is only visible to administrators until you publish it or share the URL.

Edit | Close

Figure 11-5
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11.3. Configuring S-Drive for Community

After creating the community click the "Builder” link to configure the newly created community
(Figure 11-6).

Communities Visit our Trailblazer Community | Help for this Page

The list shows all communities in your organization. Clicking on the URL takes you directly to the Community. If you're not a member, the URL isn't linked

Maximum number of communities: 100 ' *

All Communities New Community
Action Community Name Description URL Status
Workspaces | Builder sdrivefansLightning https://sdrivefans-developer-edition.na70 force com/sdrivelightning Active
Workspaces Builder - Record 1 - sdrivefansLightning l https:/fsdrivefans-developer-edition.na7 0 force com/sdriveclassic Preview
Figure 11-6

Click "Tabs"

11.4. Configuring S-Drive Lightning Component for Lightning
Communities

Salesforce offers a Community Builder comes with rich, responsive templates (E.g Napili) for
communities targeted at customer support scenarios. You can follow the steps below configure S-
Drive Lightning Component for Lightning based communities.

1- Navigate to Setup—~> All Communities 2 Manage.
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CyanGate

Object Manager Vv

HH Setup Home
eee
Q, communities
~ Feature Settings
v Communities
| I All Communities. I

Communities Settings
Lightning Bolt Pages

Lightning Bolt Solutions

Didn't find what you were looking
for? Search all of Setup instead.

SETUP
All Communities

g Communities
g

The list shows all communities in your organization. Clicking on the URL takes you directly to the Community. If you

Maximum number of communities: 100 | *

All Communities New Community

Action Community Name Description

Builder testsdrive

Manage Test Community Testing S-Drive features in Salesforce.com Communities

Figure 11-7

2- You can select your lightning compatible template from Administration—> Settings.

o R

2

¢

Topics

-
=

Emails

Pages

Dashboards
Engagement

Moderation

Recommendations

‘f’( Administration I

Members

Login & Registration

Preferences

testsdrive 2

https://ozgurdemo-developer-edition.eu5.force.com/serhatdemo

Status  Active Deactivate

Template ~ Customer Service (Napili) Change Template

Settings

Figure 11-8
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3- Navigate to Setup—~>All Communities—> Builder.

Setup Home

Q  search Setup

Object Manager Vv

Q, communities

~ Feature Settings

~ Communities
|
Communities Settings
Lightning Bolt Pages

Lightning Bolt Solutions

SETUP
All Communities

Communities

number of ities: 100

B The list shows all communities in your organization. Clicking on the URL takes you directly to the Community. If you're not a member, the URL isn't
]

All Communities

Action Community Name

| New Community

Description

4- Select a page to add S-Drive component.

URL
Manage | testsdrive hitps://ozd
Didn't find what you were looking Manage Test Community Testing S-Drive features in Salesforce.com Communities hitps://ozd
for? Search all of Setup instead.
Figure 11-9

Community Builder +

Case Detail

-

Case Detail 2

Pages

Q. Case [>]

OBJECT PAGES

Case Detail
Case List

Case Related List

Search...

HOME TOPICS »

Figure 11-10
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5- Open Components menu, scroll down and locate S-Drive Lightning Component. (Figure 11-11)

COMPONENTS

Search...
B3 Hecora st
Record Related List
¥ SUPPORT(2)
Ask Button

Contact Support & Ask Butt..

¥ TOPICS (3}
G Featured Topics
Topic Catalog
B Trending Topics

¥ CUSTOM COMPONENTS (9)
abcdtestcomponent
CaseCompl
CaseCompanent
CaseCOmponentt
Custom Forgot Password
LightningBolt
SDrive
Testl
testtest

Get more on the AppExchange

Figure 11-11
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6- Drag & Drop S-Drive Lightning Component to your page.

|:mw..gu e = | Case Detall

+ | CoseDetal -

COMPONENTS

Gzgiir Yegilbas created this case.
07 January 2016 3£07:25

00001028

CassRaason

View more details

o like @ Comment

O | vitcacomment

5 S-Drive Files Search
HOME
Shaw, 100 § per page. Ofilets)
@ Morecords found
Ofilefs)

Figure 11-12

136 All Rights Reserved - CyanGate LLC



SsDRIVE

7- Click on the component in the page and then start filling component attributes.

Title 0 Default email address (i ]
Case Files
Parent object name )] »  Enable upload i
Case Allowed file extensions 0
Object namespace prefix o
v Enable folders i
> I
File object name o Enable private files 0
CaseFile__c Default sort field name (i ]
cg__File_MName__c
File object namespace prefix (O}
—_ Default sort order 0
asc
Relationship field name (O}
Case__r File number to be shown in a page @
100
+ | Enable copy url i ]
Default view type of file list table
+ Enable delete o e bt
list
¥ | Enable download [}
+ | Enable edit i ] +  Show Folder Tree component @
+ Enable e-mail 0 ¥ | Show breadcrumb component @
Figure 11-13

The component attributes are explained below;

1. Title (optional)
This is the title of the page block inside the object page. You can set it to “My Example Object
Files”. This field is optional and if you don’t provide a value for this field, it will be set as “S-

Drive Files”.
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2. Parent object name
This is the name of the custom or standard object that will be the object that the files will be
attached to.
For Case Files: Parent Object name = Case.
For Account Files: Parent object name = Account.
For Contact Files: Parent Object name = Contact.
For Opportunity Files: Parent object name = Opportunity.
For Other Standard Object Files: Parent object name = Name of your standard object (E.g.
Lead)
For Custom Object Files: Parent object name = APl Name of your custom object (E.g.
My _Example_Object_ c)
If you are adding S-Drive Tab (S30bject) to the communities, Parent object name will be
empty.

3. Object namespace prefix (optional)
This is the object’s namespace prefix that your Salesforce.com organization uses. If your
organization has a namespace prefix and you have a custom object inside your organization,
your object namespace prefix is same with your organization namespace prefix. If this object
belongs to a managed package, you need to use that managed package’s namespace prefix. If
your object does not belong to any namespace you do not need to set this attribute. If your
namespace prefix is "exampleprefix" you need to manually set objectNamespacePrefix as

"exampleprefix__".

For Case, Account, Opportunity, Contact and other standard objects this attribute will be
empty.
For Custom Objects, this attribute will be set as your organization prefix.

4. File object name
This is the name of your object file. This object will be holding the information regarding the

4

attached files. For our example, it is "My_Example_Object_File_ c" or “CaseFile__c”".

For Case: File object name = CaseFile__c.

For Account: File object name = AccountFile__c.

For Contact: File object name = ContactFile__c.

For Opportunity: File object name = OpportunityFile__ c.

For Custom Object: File object name is your custom object file API Name (E.g.
My_Example_Object_File__ c).
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If you are adding S-Drive tab (S30bject) to the communities, file object name will be
“S30bject__ ¢”

5. File object namespace prefix (optional)
This is the file object’s namespace prefix that your Salesforce.com organization uses. If your
organization has a namespace prefix and you have a custom object file inside this organization,
your file namespace prefix is same with your organization namespace prefix. If this file object
belongs to a managed package, you need to use that managed package’s namespace prefix. If
your file object does not belong to any namespace you do not need to set this attribute. If your
namespace prefix is "exampleprefix" you need to set File object namespace prefix as

"exampleprefix__".

For Case Files, Account Files, Opportunity Files, Contact Files and S30bject (S-Drive Tab) this
attribute will be set as “cg_ ”
For Custom Object Files, this attribute will be the name of your organization prefix.

6. Relationship field name
Master-detail relation used for selected standard/custom object. This attribute is optional and

default value is 'Parent__r'.

7. Enable copy URL (optional)
This option is used to enable/disable “Copy URL” link in the page. There are two possible values
for this attribute: “true” or “false”. If the checkbox is checked, this means that the value is set
to true, and you will be able to see the “Copy URL” link for each asset. The default value for this
checkbox is checked.

8. Enable delete (optional)
This option is used to enable/disable “Delete” option for all attachments in the page. There are
two possible values for this attribute: “true” or “false”. If the checkbox is checked, this means
that the value is set to true, and you will be able to see the “Delete” link for each asset. The
default value for this checkbox is checked.

9. Enable download (optional)
This option is used to enable/disable “Download”, “Open” and “Zip & Download” options for
all attachments in the page. There are two possible values for this attribute: “true” or “false”.
If the checkbox is checked, this means that the value is set to true, and you will be able to see
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the “Download” link for each asset. The default value for this checkbox is checked.

10. Enable edit (optional)
This option is used to enable/disable “Edit” option for all attachments in the page. There are
two possible values for this attribute: “true” or “false”. If the checkbox is checked, this means
that the value is set to true, and you will be able to see the “Edit” link for each asset. The
default value for this checkbox is checked.

11. Enable e-mail (optional)
This option is used to enable/disable “E-Mail” option for all attachments in the page. There are
two possible values for this attribute: “true” or “false”. If the checkbox is checked, this means
that the value is set to true, and you will be able to see the “E-Mail” link for each asset. The
default value for this checkbox is checked.

12. Default email address (optional)
You can use this option, if you want to set a default “Additional To” email address for sending
emails from your S-Drive Attachments. For example, if you select an Account S-Drive
Attachment for an account and click “Email” button, “Email Files” screen will be opened and
“Additional To” field will be filled with the email address you have provided here.

13. Enable upload (optional)
This option is used to enable/disable “Upload” option for all attachments in the page. There are
two possible values for this attribute: “true” or “false”. If the checkbox is checked, this means
that the value is set to true, and you will be able to see the “Upload File(s)” link for each asset.
The default value for this checkbox is checked.

14. Allowed file extensions (optional)
You can use this option, if you want to limit the file types to be uploaded into selected object’s
S-Drive attachments. Semicolon separated list of file extensions that are allowed to upload can
be written here. This attribute is optional and leaving this empty will allow all kind of files to be
uploaded. For example, “*.jpg, *.txt” will limit the files to be uploaded to jpg and txt files.

15. Enable folders (optional)
This option is used to enable/disable folder support for S-Drive attachments in the page. There
are two possible values for this attribute: “true” or “false”. If the checkbox is checked, this
means that the value is set to true, and you will be able to see the “New Folder” button. The
default value for this checkbox is checked. If the box is not checked, the “New Folder” button
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16.

17.

18.

19.

20.

will be removed from the toolbar section.

Enable private files (optional)

This option is used for enabling public/private file access to the S-Drive attachments and
commonly used to limit the customer portal users’ access to individual files. Set this attribute
to true by checking the checkboyx, if you want to enable private/public flag. Setting the private
flag on a file hides the file from customer portal users. The default value for this checkbox is
unchecked.

Default sort field name (optional)

This option is used to order/sort S-Drive attachments based on a field. You need to set the
name of the field that should be used to order the list of files. For this example, it should be
filled in as “cg__File_Name__c”. You can change this option from the settings button located at
the toolbar of S-Drive attachments anytime. See S-Drive Lightning User Guide for more
information about using the S-Drive attachments.

Default sort order (optional)

This option is used to set the sort order direction of the S-Drive attachments. There are two
possible values for this attribute: “asc” or “desc”. The default value is “asc” which stands for
ascending. You can change this option from the settings button located at the toolbar of S-
Drive attachments anytime. See S-Drive Lightning User Guide for more information about using
the S-Drive attachments.

File number to be shown in a page (optional)

This option is to set the number of files to be shown in an attachment page. The default value
for this section is set to 100. If this value is set to ‘30’ and object has 91 total items, the files will
be displayed in 4 pages. You can change this option from the pagination setting located under
the toolbar of S-Drive attachments. See S-Drive Lightning User Guide for more information
about using the S-Drive attachments.

Default view type of file list table (optional)

This option is to set the default view type of the file list table. There are 3 options you can
choose: List, Thumbnail and Grid. You can change this option from the toolbar of S-Drive
attachments, and set it as default by using the settings button. See S-Drive Lightning User Guide
for more information about using the S-Drive attachments.
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21. Show Folder Tree component (optional)

This option sets the default behavior of the folder tree component located on the left-hand

side of the S-Drive attachments page. You can choose to hide or show the Folder Tree

component by using the settings button on the toolbar of S-Drive attachments. See S-Drive

Lightning User Guide for more information about using the S-Drive attachments.

22. Show breadcrumb component (optional)

This option sets the default behavior of the breadcrumbs located on the left-hand side of the S-
Drive attachments page, above the folder tree component. You can choose to hide or show the

breadcrumbs by using the settings button on the toolbar of S-Drive attachments. See S-Drive

Lightning User Guide for more information about using the S-Drive attachments

23. Enable Chatter (optional)

This option helps users to collaborate with each other using the native Chatter app. Once

enabled, in order to leverage Chatter, on the Actions menu of a file, a user can click on Post to

Chatter. Alternatively, on the Details page of a file, there is Chatter tab. See S-Drive Lightning

User Guide for more information about using the S-Drive attachments

8- Once configuration is complete, you can publish your changes from top right corner. (Figure 11-14)

ommunity Builder ~  Case Detail ~ ' CaseDetall ~ c

L) [m] @ | Puviisn | Previel

ilbas. 07/01/2016 07:25

SDRIVE

Case Files Search

HOME

Show 100 & perpage

No records found

0 file(s).

0 file(s).

Figure 11-14
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11.5.

S-Drive Toolbar Color Configuration for Lightning

You can configure the toolbar color of S-Drive in Salesforce Communities. In order to reach
communities, you should go to Setup/Communities/All Communities and select the community where
you want to change the toolbar color of S-Drive.

From community page, you should go to Builder section.

My Workspaces

Builder

Build, brand, and customize your community pages

Gamification

Keep your community members engaged with recognition
badges.

Moderation

Monitor posts and comments, create rules.

Dashboards

Examine the heaith of your community with reports and
dashboards and engage with community members

Content Management

Organize, manage and build Collections for your
Community Site.

Administration

Configure settings and properties for your commurnity.

Guided Setup

Configure features and integrations with step-by-step
instructions.

Figure 11-15

From Builder, you should click to Theme button.

u Templafe Header Top

# Theme Home  Support

Template Header Bottom

&S, S-Drive

o OBmon Onounnne aoooc

HOME

> Folder Test
> Bl Scientists
Show| 100 & |per page
T Recycle Bin

ACTIONS AT.. FILENAME CREATED BY

PR

Figure 11-16
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After clicking the Theme button, you should click the arrow button at the top right and click Edit CSS
there.

u Theme =

Customner Account Portal & Manage Branding Sets
ChanggTq?.ﬁe .u.. n. -.
H = 2 der Test !
j%z Colors

{fy Edit CS5

HOME
entists I EEESS e
"~ Images ! E: Show 100 : per page.
) I:.'v_.u'l:lo:Bin {:é
Fonts |
!‘.{ ACTIONS AT FILE NAME

Figure 11-17

Then you should come into this page.

Edit CSS
Use custom CSS to override the default template and Branding panel styles. We recommend that you use custom CSS sparingly, because future releases of template components might not support all CSS customizations.
Tips:

Press CTRL + SPACE to see more CSS properties.
- Save  backup copy of your custom CSS code

1

Cancel Save

Figure 11-18

In this section, you can change the S-Drive toolbar color as you wish. You can use Color Name, Hex
Color Code, or RGB Color Code to change the toolbar color. For instance, if you want to add Color
Name to change the toolbar color as light coral, you should write:

.slds-grid.community-toolbar {background: lightcoral}
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! 1 .slds-grid.community-tooclbar {background: lightcoralﬂ

Cancel Save

Figure 11-19

After clicking the save button at bottom right, you should see the change immediately.

fod I E

Search

&5, S-Drive
a [o]t]a-l=]ofu]e]xlalals] Q== a]s]a]
> W Folder Test HOME > SCIENTISTS
> b5 scientists 7
Show| 100 y perpage i i

o
T Recyclesin £ .

ACTIONS AT.. FILENAME CREATED BY FILE SIZE DESCRIPTION TAGS
<
& @ v Albert Einstein jpg CyanGate CyanGate 47.07KB theory of general relativit..
KR iR Nikola Tesla jpg CyanGate CyanGate 166 KB alternating current

Figure 11-20

Secondly, if you want to change the toolbar color by using a Hex Color Code that is a green like color,

you should write it as:

.slds-grid.community-toolbar {background: #0C9F27}

! 1 .slds-grid.community-toolbar {background: #9C9F27}|

Cancel Save

Figure 11-21

After clicking the save button at bottom right, you should see the change in the toolbar.
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&5, S-Drive search Q
> B Folder Test HOME » SCIENTISTS
> B Scientists

Show 100 % perpage.

T RecycleBin
ACTIONS. AT.. FILENAME CREATED BY FILE SIZE DESCRIPTION TAGS

IR SR B Albert Einsteinjpg CyanGate CyanGate 47.07KB theory of general relativit..

IR IR B Nikola Tesla jpg CyanGate CyanGate 16.6 KB alternating current

Figure 11-22

Finally, if you want to change the toolbar color by using the RGB Color Code that is a purple like color,
you should write it as:

.slds-grid.community-toolbar {background: rgh(79, 18, 140)}

! 1 .slds-grid.community-toolbar {background: rgb(79, 18, 140)}'

Cancel Save

Figure 11-23

&S, S-Drive Search Q
0 2N A ODEERam aoEnon
> Folder Test i: HOME > SCIENTISTS
> Scientists

{ Show 100 5 perpage.
T Recycle Bin

ACTIONS AT.. FILENAME CREATED BY FILE SIZE DESCRIPTION TAGS

& B v B Albert Einstein jpg CyanGate CyanGate 47.07KB theory of general relativit...

& @ B Nikola Teslz jpg CyanGate CyanGate 16.6 KB sltemating current

Figure 11-24
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11.6. Security Settings

To enable profiles for selected community, use the "Members" section in the "Community Settings"
page.

Based on the profile of the community user, users can have different permissions in S-Drive.

If you try to access the community with no permissions, you'll see "You do not have permissions to
access S-Drive data!" error when you click the "S-Drive" tab (Figure 11-25).

ymunity

Test Community

= o ~

You do not have permissions to access S-Drive datal

Figure 11-25

If you just enable “read” feature, community users will just be able to download or email uploaded
files by internal users. They won'’t be able to upload a file, delete a file, create a folder or edit an item’s
description. Also note that visibility of the files list, buttons and menu items are affected via sharing
and S-Drive Configuration.

To set these permissions edit the selected profile using the Administration Setup -> Manage Users ->
Profiles menu. Click on the name of the profile you want to edit (Figure 11-26).

Assigned Profiles Assioned Profies Help &)
Profile Users
Portal Manager Clone 3
Figure 11-26

In the new window click Edit button to edit the user permissions (Figure 11-27).

Profile

Portal Manager Clone
« Back to List: Users

Users with this profile have the permissions and page layauts listed below. Administrators can change a user's profile by editing that user's persanal information

If your organization uses Record Types, use the Edit links in the Record Type Settings section helow to make ane or more record typas available to users with this profile
Enabled Apex Class Access [11] | Enabled Visualforce Page Access [5]

Prafile Detail Zai ) Clome |
[k
Hame  Portal Manager Clone
User License  Customer Portal Manager L Custom Profile
Figure 11-27

Scroll down to the “Custom Object Permissions” section. You'll see the “Basic Access” selections for
“S30bjects” custom object (or if you're working on S-Drive Attachments like Cases, Accounts, custom

147 All Rights Reserved - CyanGate LLC



£S:DRIVE CyanGate

objects etc. you need to edit the custom object file's permissions). You will need to check/uncheck
these boxes based on your needs (Figure 11-28). Note that you can edit “Custom Object Permissions”
for just “Custom Profiles”. You may need to clone your standard profile to be able to edit a community
profile. Refer to the Salesforce.com documentation for more information.

There are four access levels: Read, Create, Edit, and Delete. We'll see examples of these access level
combinations in the subsections.

Read Create Edit Delete Wiew All Modify All 5
530bjects |:| I:l I:l |:| I:l
Case Files
(] (] (] (] (]
Figure 11-28

You can set access levels for customers using communities. We strongly suggest you to just set the
“Read” access to the community users for data security.

A. Example 1: Just Read Permission Enabled
If you just set “Read” and unset other permissions for selected custom object (here S30bject) (Figure
11-28), your community users won’t be able to:

- upload files

- create folders

- delete files/folders

- edit descriptions of files/folders
- cut/copy files

- rename files/folders.

They will be able to:

- browse folders

- download files

- email files

- copy the URL of the file to the clipboard.
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In the S-Drive screen, "Email" and "Download File(s)" buttons will be displayed (if Download Manager
is enabled) for community users and for each file “Download” and “Copy URL” item menu actions will
be visible. "ltem Actions" menu will be hidden for folders (Figure 11-29).

e, Gl R A e T e PN

€ C O 8 sem s SDneTsidctablame -01e410000010n 2aBtRelURLISPR-"%2Fhome2Fhome b NEEEY

& e

wme | Cmwes | Sounmrs | Reons [ Some

r
# Folders toms (searen a)

.....

Bl sorvesalestorc co A | Wl imagetpng ~ showal | X

Figure 11-29

B. Example 2: Read, Create and Edit Permissions Enabled
If you set Read, Create, Edit permissions and unset Delete permission for selected custom object (here
S30bject) (Figure 11-30), your community users won’t be able to:

- delete files/folders

- cut/copy files.

Bas=ic Access Data Administration
Read Create Edit Delete Wiew All Modify All 4
530bjects D |:| |:|
Case Files I:l |:| |:|
Figure 11-30

They will be able to:

- upload files
- create folders
- browse folders
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- download files

- rename files/folders

- edit descriptions of files/folders

- email files

- copy the URL of the file to the clipboard.

In the S-Drive screen, "New Folder", "Upload File(s)", "Email" and "Download File(s)" (if Download
Manager is enabled) buttons will be displayed for community users and for each file “Download”,
“Edit”, “Rename” and “Copy URL” action menu items will be visible. "Edit" and "Rename" action menu
items will be visible for folders (Figure 11-31). Also note that visibility of the buttons and menu items
are affected via sharing and S-Drive Configuration.

7 Erali
/ M Inbox (297) - bfenercicg x‘M {no subject) - buraki@gr xY 21 Document Update G X y. Customer Portal % ¥ 3% Open S-Drive Configur’ X W Y S =
< C Y | & Secure | https;/curious-badger-205027-dev-ed--cg.na3S.visual force.com/apex/SDrive?sfdc tabName=01r41000001Bn2q &vRetURLINSFX=%2F home%2Fhome jsp
salesforce i Logged in
618
Home | Cases  Sofions Reporis | S-Drive
# Folders Homa
[ o | |« —
Actions T FileName - Created By ID Description
e - B slanmedonald.ona Jack Rogers
Open
o . Bk kisa-sac-modelleri 2016 | 1312008 7:10 PM Jack Rogers
Download
Gomini 2items in 1 pages
Details
Edit .
Home | Cases | Solutions | Reports | S-Drive
Rename
Detete
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Figure 11-31

C. Example 3: Read, Create, Edit and Delete Permissions Enabled
If you set Read, Create, Edit, Delete permissions for selected custom object (here S30bject) (Figure
11-32), your community users will be able to:
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Ba=sic Access Data Adminiztration
Read Create Edit Delete Wiew All ; Modify All ;
530bjects D |:|
Case Files I:l |:|
Figure 11-32

- upload files

- create folders

- browse folders

- download files

- delete files/folders

- edit descriptions of files/folders

- cut/copy files

- rename files/folders

- email files

- copy the URL of the file to the clipboard.

In the S-Drive screen, "New Folder", "Upload File(s)", "Email", "Download File(s)" (if Download
Manager is enabled), "Cut", "Copy", "Paste" and "Delete File(s)" buttons will be displayed for
community users and for each file “Download”, “Edit”, “Copy URL”, “Rename” and “Delete” item
menu actions will be visible. "Edit", "Rename" and "Delete" action menu items will be visible for
folders (Figure 11-33). Also note that visibility of the buttons and menu items are affected via sharing
and S-Drive Configuration.
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Figure 11-33

D. Permission Combinations That Are Not Supported

Permission combinations other than above examples are not supported by S-Drive and we strongly
recommend you not to use unsupported permission combinations.

E. Other Issues

If you get an "INVALID FIELD" error message like below while uploading a file after giving required
permissions, you may need to check the "Field Accessibility" settings for the selected profile under
Administration Setup -> Security Controls -> Field Accessibility menu:

Operation Failed

Figure 11-34

"Hidden" fields for the selected custom object (here S30bject) needs to be set as "Visible" from this
menu.
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12. S-DRIVE SALESFORCE MOBILE APP CONFIGURATION AND USER
GUIDE

12.1. For S30bject Folders Files

In order to display S-Drive Mobile Tab on Salesforce Mobile App Navigation Menu, you should add
the S-Drive Mobile Tab to Salesforce Mobile App Navigation Menu.

12.1.1. Customize Salesforce Mobile App Navigation Menu

e Click Mobile Administration. Then, click Salesforce Navigation (Figure 12-1).

maobile

Expand All | Collapse All

Administer

B Mobile Administration

Salesforce Navigation

Qalacfarra Mfflina
Figure 12-1

e Add S-Drive Mobile Tab from Available section. Add to the “Selected” section. Then, click Save
(Figure 12-2).

Navigation Menu Items Save | | Cancel
Available Selected
$-Drive Dashboards -
Tasks
Add | Smart Search ltems Up
| »| People &
“¢| Groups
W | Reron =)
eports
Remove Down
Events
Approvals
Paused Flow Interviews
S-Drive Mobile
Use SHIFT + click or click and drag to select a range of adjacent items. Use CTRL + click to select multiple items that are not adjacent.
Figure 12-2

You can now see S-Drive Mobile Tab on Salesforce Mobile App navigation menu (Figure 12-3).

153 All Rights Reserved - CyanGate LLC



Contacts

Accounts

Show More

Team

Dashboards

S-Drive Mobile

CyanGate CyanGate

Figure 12-3
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After clicking on the S-Drive Mobile tab, you can see S-Drive Folders files on S-Drive Mobile Page
(Figure 12-4).

ul AT&T LTE 6:38 AM < 3 69% wm )

&

S-Drive Files
DRIVE:

( Search Q)

a5
o
3
o

‘Up'“d | Total Items: 5

alanmcdonald.png
Jan 30, 2018 . 94.06 KB

recepson.PNG
Jan 30, 2018 . 619.75 KB

Test 1
Jan 30, 2018.. -

Test 2
Jan 30, 2018.. -

test folder lightning
Jan 30, 2018.. -

[~
ﬁ

Figure 12-4
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12.2. For Standard Objects S-Drive Attachments
(Account/Case/Contact/Opportunity File)

For displaying S-Drive Attachments files on Salesforce Mobile App, you should add the S-Drive
Attachments Visualforce pages (Figure 12-5) to their page layouts.

S-Drive Attachment Files Mobile Pages

Account Files MobileAccountFilePage

Case Files MobileCaseFilePage

Contact Files MobileContactFilePage

Opportunity Files MobileOpportunityFilePage
Figure 12-5

There are two options for adding mobile S-Drive attachments pages to their page layouts: Adding
as a Mobile Card and Adding Custom Button or Link.

Example for Case File

12.2.1. Add as a Mobile Card (Option1)

e Go to Customize>Cases>Page Layouts (Figure 12-6).
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B Customize

» Tab Names and Labels

* Home

» Activities

» Campaigns

» Leads

» Accownts

+ Contacts

» Opportunities

» Ouotes

» Forecasts

B Cases
Fields
Validation Rules
Triggers
Contact Roles

Page Layouls
Figure 12-6

Save * Quick Save  Preview As..~ Cancel | Rall

Buttons @ Quick Find[Page Na|
Custom Links Lol Seotion T
Actions +FElank =
Expanded Lookups s s F;* -
Related Lists | Mobile CasaFilePage
Report Charls B '
Visualforce Pages

Figure 12-7

e Drag MobileCaseFilePage visualforce page to the Mobile Cards section (Figure 12-8).
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Mobile Cards (Salesforce1 only) !

v MobileCaseFilePage

Figure 12-8

Edit properties. Then, Save page layout (Figure 12-9).
Visualforce Page Properties

Yidth (in pixels or %) 10005

Height (in pixels) |55

Show serollbars

Show label
0K Cancel

Figure 12-9

You can now see the Mobil Card on Related Items section of Salesforce Mobile App Case Detail Page
(Figure 12-10).
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12.2.2. Add as a Custom Button or Link (Option2)

e Click Customize>Cases>Buttons, Links and Actions (Figure 12-11).

B Cases
Fields
Validation Rules
Triggers
Contact Roles
Page Layouls
Field Sels
Compact Layouls New!
Search Layouls
Assignment Rules
Escalation Rules

Links, and Atlion:
Figure 12-11

e Click on New Button or Link button. Give a Label and Name. Select Display Type and Behavior.
Select cg__MobileCaseFilePage content. Then, Click Save (Figure 12-12).
' Custom Button o Link Edit Save | (Quick Save) | Proview |Cancel

Label | My Case Files

Marre | My_Case_Files -

Description
Désplay Type Detail Page Link View example
« Detail Page Button View example
List Button View example
Behavior I Display in new window v | View Behavior Options

Content Source l Visualforce Page v

Content | MobileCaseFilePage [cg_MobileCaseFilePage] ¥ |

Figure 12-12
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e Click Edit Case Page Layout. You can see My Case Files custom button on Buttons section of its
layout (Figure 12-13).

Save ¥ Quick Save Preview As..* Cancel $Undo 73 Bedo | [m Layout Prop

Fields @, Quick Find| Button Name %
Buttons Clone | My Case Files
Custom Links Close Case Sharing
Actions Dalate | Submit for Approval
Expanded Lookups (=]
Related Lists
R = i

Figure 12-13

e Drag My Case Files button to the Custom Buttons section. Then, save page layout (Figure
12-14).

Case Detail 1ehom Butt
E Delete Close Case Clone Sharing My Case Files

Figure 12-14

e If you selected Display Type as Detail Page Link, you should drag the custom link to the
Custom Links section.
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You can now see the My Case Files button on Case Detail Page (Figure 12-15).

11:51 AM

X

My Cese Files

Figure 12-15
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After clicking “My Case Files” custom button, you can see S-Drive Attachments files on Mobile Case
File Page (Figure 12-16).

Figure 12-16
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12.3. For Other Standard/Custom Object’s S-Drive Files

For displaying other standard/custom object files on Salesforce Mobile App, you should first create
mobile object file page. Then, you should add this page to its page layout.

Example for Example _Object _c (Parent object) and Example_Object File__c (Child object)
12.3.1. Create Mobile Object File Page

e Go to App Setup > Create > Objects. Click on New Custom Object button (Figure 12-17).

| App Setup

» Customize
B Create

ADps
Cuslom Labels
Interaction Log Layouls

Figure 12-17

e Give a Label and a Name. Check the Available for Salesforce mobile apps (Figure 12-18).

Help for this Page &

New Custom Object

O Permissions for this object are disabled for all profiles by default. You can enable object permissions in permission sets or by editing custom profiles. Tell me morel  Don't
show this message again

Custom Object Definition Edit Save | Save & New| |Cancel

Custom Object Information 1 = Required Information

The singular and plural labels are used in tabs, page layouts, and reports.

Label |ﬁ1ob|4ExampleObjectPage Example: Account
PluralLabel | vobilExampleObjectPage: Example: Accounts

Starts with vowel sound

The Object Name is used when referencing the object via the API.
ObjectName [ vobilExampleObjectPage | Example: Account

Description |

Context-Sensitive Help Setting (g Open the standard Salesforce com Help & Training window

Figure 12-18
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e For creating mobile page content, you will need to use cg:FileComponent component tag
(Figure 12-19).

Visuatforce Markup = Version Settings

EEAL AN

{apex:page standardController="Example Object c" tabStyle="Example Object c" shovHeader="false" sidebar="false" >
<eg: FileComponent
customChjectName="Example Object c"
customCbjectFileName="Example Object File c"
objectId="{!Example Object c.Id}"
relationshipName="Parent "
objectiamespacePrefix=""
fileNamespacePrefix=""
enableFolders="true”
enableEmail="true”
enableCopyURL="true®
enableDeletes"trus”
enableDownload="trus®
privaceEnabled="trus"
orderBy="File Name c"

order="asc"

loading5izes="50"

title="Hy Example Files"
defaultEmailiddresss""

/>

</ apex:page>

Figure 12-19
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e Basically the page skeleton will be as below:

<apex:page standardController="Example_Object__c" tabStyle="Example_Object ¢
showHeader="false" sidebar="false" >

<cg:FileComponent

customObjectName="Example_Object_ c"
customObjectFileName="Example_Object_File_ c"
objectld="{!Example_Object__c.ld}"

relationshipName="Parent__r

objectNamespacePrefix="examplenamespaceprefix__
fileNamespacePrefix="examplenamespaceprefix__"
enableFolders="true/false"
enableEmail="true/false"
enableCopyURL="true/false"
enableDelete="true/false"
enableDownload="true/false"
privateEnabled="true/false"
orderBy="File_Name__c"

order="asc"

loadingSize="100"

title="My Example Files"
defaultEmailAddress="user@company.com"
/>

</apex:page>

You need to set these component attributes based on your configuration. Let’s explain these
components attributes:

standardController

You need to set this standard controller to the object that you want to use with. For our example this
is the custom object name that we created: “Example_Object__c”. As you can see from the example
we appended “__c” to the end of the name. This means, this object is a custom object. You can use
standard objects also. For standard objects you will not append “__c” at the end of the object name
(e.g. Solution). Also, do not prepend your account’s namespace prefix.

tabStyle
This is the tab style of the page. Normally you can set it same with standardController. That means tab
style will be derived from the standard controller you chose.
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customObjectName

This is the name of the custom or standard object that will be the object that the files will be attached
to. For our example, it is “Example_Object__c”. If this is a custom object you need to append “__c” to
the end of the name. If this is a standard object you won’t append “__c” at the end of the object name
(eg. Solution). Also do not prepend your account’s namespace prefix.

customObjectFileName

This is the name of the custom object file. This object will be holding the information regarding the
attached files. For our example, it is “Example_Object_File_ c”. If this is a custom object you need to
append “__c” to the end of the name. Also do not prepend your account’s namespace prefix.

objectid
You need to pass in the “{IExample_Object__c.ld}"” value for this attribute. This attribute is required to
retrieve object id.

relationshipName (optional)
Master-detail relation used for selected standard/custom object. This attribute is optional and default

value is 'Parent__r".

objectNamespacePrefix (optional)

This is the object’s namespace prefix that your Salesforce.com organization uses. If your organization
has a namespace prefix and you created this custom object inside your organization, your object
namespace prefix is same with your organization namespace prefix. If this object belongs to a
managed package, you need to use that managed package’s namespace prefix. If your object does not
belong to any namespace you do not need to set this attribute. If your namespace prefix is

’

“examplenamespaceprefix” you need to set objectNamespacePrefix as “examplenamespaceprefix__".

fileNamespacePrefix (optional)

This is the file object’s namespace prefix that your Salesforce.com organization uses. If your
organization has a namespace prefix and you created this custom object file inside this organization,
your file namespace prefix is same with your organization namespace prefix. If this file object belongs
to a managed package, you need to use that managed package’s namespace prefix. If your file object
does not belong to any namespace you do not need to set this attribute. If your namespace prefix is

n

“examplenamespaceprefix” you need to set fileNamespacePrefix as “examplenamespaceprefix__".

enableFolders (optional)

167 All Rights Reserved - CyanGate LLC



£S:DRIVE CyanGate

This option is used to enable/disable folders support for S-Drive Attachments. Set this attribute false
to disable folders. If you disable folders for S-Drive Attachments, folders breadcrumb will be removed.
This configuration won't hide/delete currently created folders. The default for this attribute is true.

enableEmail (optional)

This option is used to enable/disable “Email” button in the page. There are two possible values for this
attribute: “true”, “false”. If “false” is set “Email” button won’t be displayed in this page. This field is
optional and if you don’t provide a value for this field, it will be set as “true”; therefore “Email” button
will be visible. Note that security and permission settings override this option.

enableCopyURL (optional)

This option is used to enable/disable “Copy URL” button in the page. There are two possible values for
this attribute: “true”, “false”. If “false” is set “Copy URL” button won’t be displayed in this page. This
field is optional and if you don’t provide a value for this field, it will be set as “true”; therefore “Copy
URL” button will be visible for. Note that security and permission settings override this option.

enableDelete (optional)

This option is used to enable/disable “Delete” button for the page. There are two possible values for
this attribute: “true”, “false”. If “false” is set “Delete” button won’t be displayed in this page. This field
is optional and if you don’t provide a value for this field, it will be set as “true” therefore, “Delete”
button will be visible. Note that security and permission settings override this option.

enableDownload (optional)

This option is used to enable/disable “Download” button for attachment in the page. There are two
possible values for this attribute: “true”, “false”. If “false” is set “Download” button won’t be
displayed in this page. This field is optional and if you don’t provide a value for this field, it will be set
as “true” therefore, “Download” button. Note that security and permission settings override this
option.

privateEnabled (optional)

This option is used for enabling public/private file access to the S-Drive attachments and commonly
used to limit the customer portal users’ access to individual files. Before setting this property, you
need to add a new field to your custom object file named ‘Private’. Set this attribute to true if you
want to enable private/public flag. Setting the private flag on a file hides the file from customer portal
users. There are two possible values for this attribute: “true”, “false”. The default for this attribute is
"false”.
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orderBy (optional)

This option is used to order/sort S-Drive attachments based on a field. You need to set the name of
the field that should be used to order the list of files without namespace prefix. This attribute is
optional and leaving this empty will not order the results in any specific order. The default for this

”

attribute is "File_Name__c”. Note that Salesforce does not allow Long Text Area fields to be
ordered/sorted. So if you want to order/sort by a long text area field (e.g. Description__c), you need
to change its type from ‘Long Text Area’ to ‘Text Area’. This will limit your description to be 255

characters long.

order (optional)
This option is used to order/sort S-Drive attachments based on a field (orderBy) ascending or

“u

descending. There are two possible values for this attribute: “asc”, “desc”. The default for this
attribute is asc.

loadingSize (optional)

This option is used to set the number of items loading at a time. Attachment items will be loaded
based on this value. So, if this value is set to '30', and object has 91 total items, youwill click ‘Load
More’ link on file page 4 times. This attribute is optional and default value is 100.

Note: If you have more than 1000 files, Files page will be paginated and you will see the 1001th file on

next file page by clicking Next Page link. The pagination is for performance reasons.

title (optional)

This is the title of the page. You can set it to “Custom Object Name” Files. For our example it will be
“Example Object Files”. This field is optional and if you don’t provide a value for this field, it will be set
as “Attached Files”.

defaultEmailAddress (optional)

You can use this option, if you want to set a default “TO” email address on Email page for sending
emails from your S-Drive Attachments. This option is automatically set for out of the box Contact,
Opportunity, Case and Account S-Drive Attachments. For example, if you select a Contact S-Drive
Attachment for a contact and click “Email Selected” button, “Email Files” screen will be opened and
“To...” field will be filled with the contact name .If default email address is not found in your Salesforce
Contacts, that email will be set to the “Additional To...” section of the “Email Files” page. These “To...”
or “Additional To...” fields are auto-filled when “Email Files” page is loaded. You can clear them and/or
select other contacts as you wish.

e After setting the page based on above component attributes, then click Save.
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e Set the security for your page on other profiles. Go to Develop >Pages and click Security link
next to your page name (Figure 12-20).

Action Label llame llamespace Prefix Api Version

Edit| Del | Security 3] MobileExampleObiectPage MobileExampleObjectPage 290
. Figure 12-20 .

e Move all profiles (or select based on your needs) from Available Profiles section to Enabled
Profiles (Figure 12-21).

Enable Profile Access for Visualforce Page

MobileExampleObjectPage

Save  Cancel

Available Profiles Enabled Profiles

Systermn Administrator
Basic User

Contract Manager
Custom: Marketing Profile

LU Custom: Sales Profile

LA Custom: Support Profile
Customer Community Login User
Customer Community User

--None--

Customer Portal Manager Custom
Customer Portal Manager Standard
Force.com - App Subscription User
Marketing User

Partner App Subscription

Sitver Partner User

Figure 12-21

e If you skip this step, your users that belong to the disabled profiles will see an error page
(Figure 12-22).
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Insufficient Privileges
You do not have the level of access necessary to perform the operation you requested. Please contact the owner of the record or your administrator if access is necessary.

Figure 12-22

There are two options for adding mobile object file pages. Adding as a Mobile Card and adding
custom button or link.

12.3.2 Option 1: Add as a Mobile Card (Option1)
e Go to Create>Objects>Example Object. If you want to create standard object file page, you
should go to Customize>Standard Object>Page Layout (Figure 12-23).

.ﬁpp Setup
» Customize

B Create

ADpS
Custom Labels
Interaction Log Layouls

Figure 12-23

e Click Edit My Example Object Page Layout section. You can see MobileExampleObjectPage on
Visualforce Pages section of its layout (Figure 12-24).
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My Example Object Layout «

- . —
‘Save ¥ | Quick Save Preview As..” Cancel £ Und(

Fields @, Quick Find| Page Name |
Buttons r 1|

: |+ Saclion

Aclions *ﬂ ﬁmk ﬁpm
Expanuec{ Lookups &.m.mmpﬂ. |
Related Lists  MobileExampleObje... |

Report Chans
Visualforce Pages

Figure 12-24

e Drag MobileExampleObjectPage visualforce page to the Mobile Cards section(Figure 12-25).

' Mobile Cards (Salesforce1 only) !

v¥| MoileExampleOtiectPage

Figure 12-25

e Edit properties. Then, Save page layout (Figure 12-26).

Visualforce Page Properties x
Width (in pixels or %) :103% |
Height (in pixels) 55 |

Show scrollbars

Show label

OK Cancel

Figure 12-26
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You can now see the Mobile Card on Related Items section of Example Object Detail Page (Figure
12-27).
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Figure 12-27
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12.3.3 Option 2: Add as a Custom Button or Link (Option2)

e Go to Create>Objects>Example Object >Buttons, Links and Actions. If you want to create
standard object file page, you should go to Customize>Standard Object>Buttons, Links and
Actions (Figure 12-28).

.App Setup

+ Customize

B Create
Apps
Custom Labels
Interaction Log Layouts

Figure 12-28

e Click on New Button or Link. Give a Label and a Name. Select Display Type and Behavior. Select
MobileExampleObjectPage content. Then, click Save (Figure 12-29).

Edit Example Object Custom Button or Link

My Example Files

Custom Button or Link Edit Save | Quick Save Preview | Cancel

Label I Wy Example Files

Hame I My_Example_Files i

Description
Display Type Detail Page Link View example
» Detail Page Button View example
List Button Yiew exarmple
Behavior I Display in new window ¥ | View Behavior Options

Content Sourco IV\suaIforceF'age v

Content | MobileE xampleObjectPage [MobileExampleObjectPage] ¥

Figure 12-29

e Click Edit Case Page Layout. You can see My Example Files custom button on Buttons section
of its layout (Figure 12-30).
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|

| Save * Quick Save Preview As...* Cancel I.In-:

r :

Fields CLOLIII:H Find BUHU”IH[E

Buttons Clera Sh!

{

Actions Dl et Sul
Expanded Lookups Edit

lReIated Lists My Exarmple Files

Figure 12-30

e Drag My Example Files button to the Custom Buttons section. Then, save page layout (Figure
12-31).

Example Object Detail

Edit| |Delete Clone  Sharing My Example Files

Figure 12-31

e If you selected Display Type as Detail Page Link, drag the custom link to the Custom Links
section.
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You can now see the My Example Files button on Example Object Detail Page (Figure 12-32).

Figure 12-32
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After clicking on the My Example Files button, you can see Example Object’s S-Drive files on Example
Object File Page (Figure 12-33).

Figure 12-33
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12.4. Actions on S-Drive File’ Detail Page

12.4.1. Upload File to S-Drive

In order to upload file to S-Drive, click on the Upload button (Figure 12-34).

wll AT&T LTE 6:38 AM < % 69% mm )

= y 2

&SJ S-Drive Files
DRIVE

Search Q\l

Home

M Total Items: 5

alanmcdonald.png
Jan 30, 2018 . 94.06 KB

recepson.PNG
Jan 30, 2018 . 619.75 KB

Test 1
Jan 30, 2018 . -

Test 2
Jan 30, 2018.. -

test folder lightning
Jan 30, 2018 . -

Figure 12-34
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12.4.2. Download/Open S-Drive File

In order to download/open the S-Drive file, you should click on the Download button (Figure
12-35).

Western Sales Brochure paf

M

Figure 12-35
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12.4.3. Delete S-Drive File

In order to delete the S-Drive file, you should click on the Delete button (Figure 12-36).

il ATEY

Western Sales Brochure. pdf

M

Figure 12-36
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You can delete the S-Drive file by clicking on Delete button and you can cancel to delete the S-Drive

file by clicking on Cancel or X button (Figure 37).

Western Soles Brochure.pdf

B

Home

Fio Narw

Westemn Sakes Brod

Crosted Date
96/2012 025 PM

Cresed By D

CyanGate CysnGate

Descripton

Figure 12-37
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12.4.4. Send Email with S-Drive File

In order to send Email with an S-Drive file, you should click on the Email button (Figure 38).

Western Seles Brochure paf

M

Figure 12-38
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12.4.5. Copy URL for S-Drive File

In order to copy URL for an S-Drive file, you should click on the Copy URL button (Figure 39)

Western Sales Brochure pdf

M

Figure 12-39
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You can select the url of to the S-Drive file by clicking on Select Ur/ button and You can cancel to
select url the by clicking on X button (Figure 40).

POF

Western Sales Brochure pof

M

Homo

POSS. 5] Amazonaw:

Fi Name
Western Sales Brod

Select Url

Cremed Dae
9672012 025 PM

Cronted By D
CyanGate CyanGate

Descroeca

Figure 12-40
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12.4.6. Back to Home Page

For Back to the Home Page, you should click the Home link (Figure 12-41). If there is any folder
breadcrumb link, you can also navigate back to this folder by clicking on the folder name.

Western Soles Brochure. paf

M

Figure 12-41
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13. S-DRIVE SUPPORT

You can contact S-Drive Support team for any questions or problems that you couldn't solve using
S-Drive documents:

1. Open a Ticket at Support Site: sdriveapp.com/support

2. Send an Email: sdrive@sdriveapp.com

You can find up-to-date product information, documents, tutorial videos, tools in our web page:
www.sdriveapp.com
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A Appendix A: S-DRIVE PORTAL

A.l. S-Drive Account

In order to use S-Drive, you should create a free S-Drive account on S-Drive portal. Here you will
be able to see your Amazon account and payment details.

A.1.1. Login or Register

e Go https://portal.sdriveapp.com. Register for a free account, or login if you already have
an account.

S-DRIVE

Login

Email

Password

Login to S-Drive

Forgot Password? | Register for Free

Figure A-1

A.1.2. Update S-Drive Account Information or Password

e Click Account link on menu (Figure A-2) to update your account information (Figure A-3) or
change your password (Figure A-4).

&DRNE Biling  Connected Organizations  Payment Method Account

Logout

Figure A-2
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Edit Account Change Password

Name *

CyanGate

Email *

user@cyangate.com

Email Confirmation *

user@cyangate.com

Company Name

CyanGate LLC

Phone Number

18333269778

Address

8593 Concord Hills Circle Cincinnati, OH 4

PO Number
4L PH4 NUM3R1C4L

Figure A-3

Edit Account Change Password

Current Password *

rrrrsReies

New Password *

Figure A-4
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A2, Connected Organizations

In order to use S-Drive, you must connect your Salesforce.com organization to S-Drive.

%Note

* You can connect your organization if you use 1.24 or higher version of S-Drive and if you
have enough privileges to make OAuth authorization.

A.2.1. Connect Salesforce.com Organization

e Click Connected Organizations link on the menu (Figure A-5). You see "Connect

Salesforce.com Organizations" and "Connected Salesforce.com Organizations" sections
(Figure A-6).

CSDRIVE oo - comecs

Payment Method Account  Logout
Figure A-5
Connect Salesforce.com QOrganization
Connected Salesforce.com Organizations
Action Organizationld Type User Name Date Created Date Updated Organization Status

[:] 00DA0D0000000O000OT  PRODUCTION  user@cyangate.com 1027/2014 1118 111412014 15:43  [EITERE]

[ ] falaln - alaTalaTaTalalalalalatalate} DOANLICTIAA puanaatamiruannate com ANNAMNAA 4A4-R2

Figure A-6

ANAIINAA 4457 | ~nuurcerrn |

To connect an organization, click "Production Instance" button if your organization will be
leveraging S-Drive in production environment. Alternatively, click "Sandbox Instance"
button if your organization is leveraging S-Drive in sandbox environment (Figure A-7). It

redirects the salesforce.com login page. You should login with your organization's
account.
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e Click 'Allow' button for S-Drive to have permission to connect the app

e You should now see your organization(s) on "Connected Salesforce.com Organizations "
section (Figure A-7).

Connected Salesforce.com Organizations

Action Organizationld Type User Name Date Created Date Updated Organization Status

00DA00000000000001  PRODUCTION  user@cyangate.com 102720141118 11142014 15:43  CEITEED)
000b00000000000002 ~ PRODUCTION  cyangate@cyangate.com 1012420141453 1012420141453 [EEITEED)
00DL00000000000003 ~ SANDBOX ~testuser@cyangatecom  11/0212014 1132 111320141738 (RN

Figure A-7

e If you see your organization in DISCONNECTED status (Figure A-8), you should connect
your organization again by clicking "Connect" button OR to reconnect, click on
"Production Instance"/ "Sandbox Instance" button (Figure A-6). You can also reconnect
your CONNECTED status organization by clicking "Reconnect" button (Figure A-7).

m 00D000000000000002  PRODUCTION  cyangale@cyangatecom 10242014 1453 1012412014 1453

Figure A-8

A.2.2. Remove Salesforce.com Organization from S-Drive Account
e Click "Delete" button (Figure A-8). But, beware that you are responsible with deleted
organization's usage costs until different account is connected from this organization.
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A.3. Amazon Payment
Add an Amazon payment method if your S-Drive trial has
expired. S-Drive is always free in Sandboxes.

A.3.1. Register Payment Method
e Click Payment Method link on menu (Figure A-9).

&DRNE Biling  Connecled Organizalions  Payment Melfod Sk g

Figure A-9

e Click Login with Amazon button on "Amazon Payment" section (Figure A-10).

Amazon Payment

8, Login with Amazon

L

Figure A-10

e It opens Amazon.com Sign-in page (Figure A-11). You should login with your Amazon
account.
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https://www.amazon.com/ap/signin?_encoding=UTF8&openid.assoc_handle=iba&openid.return_to=https%3A¢

ajagen SSDRIVE

Sign in to S-Drive using your Amazon account

What is your e-mail address? Shop safely

| | ! We do not share your password n
and payment information. Your ﬂ

What is your password? purchases are protected by the A-
to-z Guarantee

Speed thru checkout

s - Access your shipping and payment | —m®
| Sign in using our secure server I ! prng EnaRay =
information from your Amazon Ed
Forgot your password? Payments account.

Create an Amazon.com account. Logiﬂ without hassle
Use Amazon to log into this site J
without another password

Learn More

Conditions of Use  Privacy Notice  ® 1996-2014, Amazon.com, Inc. or its affiliates

Figure A-11

After login, select a Payment Method, then check the consent box and click the "Approve" button
(Figure A-12).
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Amazon Payment

@ Payment Method
S

visa Visa ..1111

v Visa..1111 visa MasterCard.. 4444 ﬂ
American Expn...0005 % Discover... 3424 Nﬁ_im
| ’ | 1-4of 5 Amazon Payments

@ Pay with Amazon
e

./ Use my selected payment method for future purchases and
payments to this merchant.

Learn more

You should select the consent!

Figure A-12

e After you complete the payment method registration, you see billing details related to
Amazon account on "Billing Details" section (Figure A-13).

This account is registered to be payed via Amazon Payments using the Amazon account amazonuser@cyangate.com. If you would like to make any changes to your
payments, use the Login button below to make changes.

Billing Details
Amazon Email Date Created Date Updated Payment Method Status
amazonuser@cyangate com 11/08/2014 13:14 11/08/2014 13:14 [ oPEN |

Amazon Payment

l 8, Login with Amazon

Figure A-13
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e If you see CLOSED payment method status (Figure A-14), you should update your payment
method again by clicking "Login with Amazon" button. You can also change or update
your method by clicking "Login with Amazon" button.

There is a problem with Amazon account amazonuser@cyangate.com. You can update your payment details by clicking the Login button

Billing Details

Amazon Email Date Created Date Updated Payment Method Status
amazonuser@cyangate.com 11/08/2014 13:14 11/08/2014 13:14

Amazon Payment

@, Login with Amazon

Figure A-14

A.4. Billing
You can see payment details and your organizations' usages and cost for the current month on
"Billing" tab.

A.4.1. Payment Details
Click Billing link on menu (Figure A-15). You see "Current Usage" (Figure A-16) and "Payment History"

sections (Figure A-17).

C Billina "
d JDR'VE Siing  Connected Organizations  Payment Method Account  Logout

Figure A-15
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Current Usage
Organization Current Total current Timed Current Month Preview Generation Preview
Organizationld Type Status Usage Usage™ Cost Count Cost Total
00D80000000IG5GEAA  PRODUCTION 2.216800 GB 1.000647 GB-Month  $0.01 0 300 $001
00DOY0D00001KFKCUAG ~ PRODUCTION 1.030524 GB 0.465170 GB-Month  $0.00 [} %00 %00
00D0Y000001iwkJUAQ PRODUCTION 0.000000 GB 0.000000 GB-Month ~ $0.00 [} %00 %00
00D0Y000001dQRAUAM  PRODUCTION 0.029071 GB 0.013123 GB-Month ~ $0.00 [} %00 %00
00DB0000000ThITEAS PRODUCTION [EEIESE 0.001045 GB 0.000468 GB-Month  $0.00 [} %00 %00
00D0Y000002FEpDUAW PRODUCTION  [EETTESE 0.000185 GB 0.000083 GB-Month ~ $0.00 [} 500 500
00D58000000JXNEAG PRODUCTION 0.000655 GB 0.000296 GB-Month ~ $0.00 o 0.0 0.0
00D800000012avGEAQ  PRODUCTION  [EETTESE 4.480871 GB 2.022624 GB-Month  $10.23 0 $0.0 $10.23
Figure A-16

e Under "Current Usage", you can see your organization's usage and cost for the current
month.

e The "Preview Generation Count" column shows your organization's Preview Generation
Count for the current month.

e The "Preview Generation Cost" column shows your organization's Preview Generation
Cost for the current month.

To see payment details for previous months, select a month from "Payment History" select list
(Figure A-17).

Payment History

- August 2018 v

[Select
August 2018

July 2018
June 2018
May 2018
April 2018

Figure A-17

e You can see the details of your payments on "Payment Details" section (Figure A-18). You
can see billing cycle, payment status, your organizations' billable usages and usage
amounts. You can also download PDF invoices using the “Download Invoice” button (see
section A.4.2 Downloading Invoices for details.)
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©

1t History

August 2018 v

nt Details

Charges billed on August 1, 2018 Download Inveice

Billing Cycle : July 1 - July 31, 2018

Item

1

Description

00D0O000000ghCWUAY PRODUCTION ORG USED 2 537135 GB, BILLABLE USAGE 2.537135 GB
00D0OO00000ghCWUAY PRODUCTION ORG PREVIEW SERVICE PAYMENT: § 0.0, CONVERSION MINUTE COUNT: 2
00D1r000002FANWEA4 PRODUCTION ORG USED 0.0 GB, BILLABLE USAGE 0.0 GB

00D1r000002b37rEAA PRODUCTION ORG USED 0.008109 GB, BILLABLE USAGE 0.00810% GB

Total Amount:

Charges Due on August 1, 2018

- Payment received on August 1, 2018 (AMAZON) - Thank youl

Amount
$15.37
50.0
$0.00
$0.00

$15.37

Figure A-18

e If there are active organizations and the total amount is not zero, if your organization has

been charged, a "Payment received" message is displayed (Figure A-18). If your

organization has not been charged yet, "Payment processing" message is displayed (Figure

A-19).

Charges Due on December 1, 2014

- Payment processing... - Thank you!

Figure A-19

e If there are no active organizations on the billing cycle, there will be no payment cost and

you see "No payment required" message (Figure A-20).
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A4.2,

Payment Detalls

Charges billed on December 1, 2014 Download Invoice

Billing Cycle : November 1 - November 30, 2014

Item Description Amount
1 There are no active organizations. $0.00
Total Amount: $0.00

Charges Due on December 1, 2014

- No payment required - Thank you!

Figure A-20

Downloading Invoices

You can download invoices using the “Download Invoice” button which is displayed in the top
row of “Payment Details” page (Figure A-20), every time you select a new month from the
“Payment History” menu.

For example, if you’ve selected “August 2018” from the “Payment History” menu and click the
“Download Invoice” button, an invoice for your usages in the billing cycle July 1-July 31, 2018
will be downloaded automatically by your browser.

198 All Rights Reserved - CyanGate LLC




“S\DRIVE

Your billing information (name, company, address, PO number) will be the same as your

account information, which you can change using the “Edit Account” tab (see A.1.2 Update S-

Drive Account Information or Password).

If you download an invoice for an already-closed payment, your invoice will come with a

“PAID” stamp on the top-right corner.

CyanGate LLC

8593 Concord Hills Cir
C ya n Ga te Cincinnatl, OH 45243 US

(703) 485-3864

sales@cyangate com
it iharaw. cyangate. com

Invoice

BILLTO

CyanGate

CyanCate LLC

8583 Concord Hills Cirde Cincinnati, OH 45243

INVOICE # nsDests-20180801

DATE 0am1/2018

DUE DATE oamizo1a

TERMS Due Upon Receipt

PO NUMBER
4LPHE NUM3SR1CAL

S-Drive Service 1
00D000000D0GhCWUAY PRODUCTION ORG USED

2537135 GB, BILLABLE USAGE 2.537135 GB

S-Drive Service 1
00D0O000000ghCWUAY PRODUCTION ORG

FREVIEW SERVICE PAYMENT: § 0.0, CONVERSION

MINUTE COUNT: 2

S-Drive Service 1
00D1r000002FANWEA4 PRODUCTION ORG USED 0.0

GB, BILLABLE USAGE 0.0 GB

S-Drive Service 1

0001 ri00002b37rEAS PRODUCTION ORG USED
0.008109 GB, BILLABLE USAGE 0.008102 GB

Experts in Media Management

18.37

0.00

0.00

0.00

AMOUNT PAID

BALANCE DUE

18.37

0.00

0.00

0.00

TOTAL CHARGES USD 15.37

USD 15.37
UsD 0.00

Figure A-21
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A.4.3. Pricing

S-Drive pricing is based on usage and preview generation count (Figure A-23) and it is calculated by
Cyangate at the beginning of the next month and charged from your payment method. S-Drive pricing
is tiered and as your usage increases, the cost per usage will decrease significantly (Figure A-22).

Price of S-Drive
Usage

$10.00 per GB-Month  First 5 GB-Month

$5.00 per GB-Month Greater than 5 GB-Month through 25 GB-Month
$2.50 per GB-Month Greater than 25 GB-Month through 100 GB-Month

$1.25 per GB-Month Greater than 100 GB-Month through 1000 GB-
<2 P Month
$0.50 per GB-Month Greater than 1000 GB-Month

Pricing Tiers

Figure A-22
Preview & Thumbnail Pricing (v1.28+)
With S-Drive 1.28, thumbnails and previews can be generated. Calculation is done based on the number of conversions used while
generating the thumbnail and previews.
100 conversions are free for each month!
Preview & Thumbnail Sample Pricing Table *
File Count  Conversion Count Price Total Price
50 100 $0.00 $0.00
500 1000 $0.05 $45.00
2500 5000 04 $205.00
5,000 03 $355.00
25,000 02 $1,155
50,00 $0.01 $1,655
Figure A-23

e First 1 GB storage and bandwidth usage is FREE every month.

e After creating an S-Drive account, you can use S-Drive on Salesforce.com organizations
free of charge for 15 days.

e You can use S-Drive on Sandbox Salesforce.com organizations free of charge.
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A.5. Troubleshooting Tips

Could not login because of locked S-Drive account.
»  Your S-Drive account has been locked because of too many invalid attempts. You can
reactivate your account by resetting your password.
e Could not login because of inactive S-Drive account.
» Check your email address to activate your S-Drive account.

e Forgot S-Drive account password.
» Reset your S-Drive account password.
e 15 day trial has expired for S-Drive usage.
» Add your Amazon payment details. See "Register Payment Method" section of this
document.

e See DISCONNECTED status on "Connected Organizations" or "Billing" page.
» You may revoke the S-Drive connected app or uninstall the S-Drive package. You can
connect this organization. See "Connect Salesforce.com Organization" section of this
document.

e See CONNECTED status organization on "Connected Organizations" or "Billing" page, although
uninstall the S-Drive package or revoke the S-Drive connected app.
» Your organization status will be DISCONNECTED, after next time we try to connect
your Salesforce.com organization to calculate hourly S-Drive usage.

e Could not see DELETED organization on "Connected Organizations" or "Billing" page.
» You could not see DELETED organization. But this organization belongs your S-Drive
account until another S-Drive organization connect this. Also, you can reconnect this
organization. See "Connect Salesforce.com Organization" section of this document.

e Could not use S-Drive, although there is a CONNECTED status organization.
» You may uninstall the S-Drive package or revoke the S-Drive connected app.

Can use S-Drive, although there is a DISCONNECTED status organization.
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> You can continue to use S-Drive max more 6 hours, after revoke the S-Drive connected
app. After this, you could not use S-Drive.

e Non-admin user could not make "OAuth Authorization-Connect Organization”.
» Only administrator user who has modify all data permission can make "OAuth
Authorization-Connect Organization".

e Could not complete "OAuth Authorization-Connect Organization" because of necessity for
installing latest version (1.24 or later) of S-Drive package.
» You must install 1.24 or later versioned S-Drive package.

e Could not complete "OAuth Authorization-Connect Organization" because of there is an
organization which already authorized with different S-Drive account.
» You could not connect other S-Drive account' organization until this account delete
the organization.

e Could not see Connect Salesforce.com Organization section and Connect-Reconnect-Delete
buttons on "Connected Organizations" page.
» If your Amazon payment detail is CLOSED status, you could not connect your
organization. Update your Amazon payment details to continue use S-Drive. See
"Register Payment Method" section of this document.

e Could not make "OAuth Authorization-Connect Organization” for other organization shortly
after authorizing one organization.
» Clear your browser cookies and session, then retry make "OAuth Authorization-
Connect Organization".

e Get an email from us related AMAZON ACCOUNT issue.
» We could not charge you for S-Drive usage because of you did not add your Amazon
payment detail. Add your Amazon payment details. See "Register Payment Method"
section of this document.

e 15 days’ trial has expired for S-Drive usage.
» Add your Amazon payment details. See "Register Payment Method" section of this

document.

Get an email from us related INVALID PAY MENT METHOD issue.
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» We could not charge you for S-Drive usage because of Invalid Payment Method issue.
Update your Amazon payment details to continue use S-Drive. See "Register Payment
Method" section of this document.

e Get an email from us related CLOSED AMAZON PAYMENT issue.

» We could not charge you for S-Drive usage because of CLOSED status Amazon
payment method related Invalid Payment Method issue. Update your Amazon
payment details to continue use S-Drive. See "Register Payment Method" section of
this document.

e See CLOSED status Amazon payment detail on "Payment Method" page.
» The Amazon billing detail turned to CLOSED because of INVALID PAYMENT METHOD
issue. Update your Amazon payment details to continue use S-Drive. See "Register
Payment Method" section of this document.

e Could not use S-Drive, although update Amazon payment details for Payment Method and see
OPEN status.
» Because of there is uncompleted payment charge due to INVALID PAYMENT METHOD
issue, you can continue to use S-Drive after payment charge is completed.

e See "Payment processing..." message on Billing Details section of "Billing" page.
» We have not charge you yet for S-Drive usage.

e See "Session Expired" message on portal.sdriveapp.com page.
» Because of your session has expired, you should login again.

e See error messages on Login, Reset Password, Register, Connected Organizations, Payment
Method, Account pages.
» Try your operation. If you got error message again, please contact to us.

e See “You did not register a S-Drive account. Please register for free, then configure S-Drive
connectivity for this organization at https://portal.sdriveapp.com" message on Salesforce.com
account.

» Create a free S-Drive account or use your existing S-Drive account, then connect your
organization to S-Drive. See "Register” and "Connect Salesforce.com" sections of this
document.
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See “You did not configure S-Drive connectivity for this organization. Please configure S-Drive

connectivity for this organization at https://portal.sdriveapp.com" message on Salesforce.com
account.
» Connect your organization to S-Drive. See "Connect Salesforce.com" section of this
document.

e See “There is a problem with your S-Drive connectivity with this organization. Please check
your account, organization status and reconnect this organization at
http://portal.sdriveapp.com"

message on Salesforce.com account.
» Reconnect your organization to S-Drive. See "Connect Salesforce.com" section of this
document.

e See “Your trial has expired. Please add your payment details at https://portal.sdriveapp.com "
message on Salesforce.com account.
» Add your Amazon payment details. See "Register Payment Method" section of this
document.

e See “There is a problem with your payment method. Please update your payment details at
https://portal.sdriveapp.com" message on Salesforce.com account.
» Update your Amazon payment details to continue use S-Drive. See "Register Payment
Method" section of this document.
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B Appendix B: Upgrading S-Drive

Follow these instructions to upgrade to the latest version of S-Drive

1. Install the latest version of S-Drive
If you have custom objects from your previous S-Drive version, there are fields that must be
added to the associated S-Drive File Objects. (For example, if you have a custom object called
Software that is using S-Drive, there’s related object called SoftwareFile that must be
updated.) S-Drive can do this automatically:

e Open S-Drive Configuration tab.

e On the General Settings tab, scroll down to Object Field Settings.

e Click on the Sync button. This will add fields to your S-Drive File Objects that are needed in
the upgraded version.

s-Drive Configuration m Cancl
S-Drive Authentication "
Settings ‘ General Settings [ Customization Settings |

S-Drive Tab Settings

Enable Download [
Enable Chatter &

Disable Copy URL on S-Drive Tab

Enable Email on S-Drive Tab ¥ disable for portal users

Select page size for S-Drive tab 100 v

Mail Settings

Custom Email Footer Default Email Footer

Default Email Expiration Time Unlimited

Embed Thread Id In Case Emails

Case Email Reply-To Address

Object Field Settings

Sync File Object Fields Syne E

File Settings

Figure B-1
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3. Once the Object sync is done, go to each of your custom file objects and check that all the
fields have been added correctly. If any are missing, add them manually as described in the
table below. You can ignore these steps for CaseFiles, AccountFiles, ContactFiles,

OpportunityFiles and S30bject):

e Go to Setup and navigate to your S-Drive File Object’s fields and relationships. Be sure to
check the S-drive File Object, not your custom object. (Staying with the example above,

check the SoftwareFile object, not the Software object.)

e If any of the following fields are missing, create them manually.
Note: In each step you should check Visible checkbox for all Field-Level Security for

Profile fields.

Field Label
Text{255)

Long Text Area(32000)
Text(255)

Formula (Text)
Number(18, 0)
Checkbox

Checkbox

Checkbox

Text{255)
Number(18, 0)
Master-Detail{CustomObjectName)
Text(255)

Text(255)

Text(255)

Checkbox

Text(255)

Text(255)

Long Text Area(4096)
Text(255)

Text(255)

Text(255)

Text(255)

Checkbox

Field Name
Content Type
Description

File Name

File Size

File Size in Bytes
Is Deleted

Is Latest Version
Is Parent Deleted
Key

Page Count
Parent

Parent Folder Id
Preview Key
Preview Version Id
Private

Shortcut

Sync Id

Tags

Thumbnail Key
Thumbnail Version Id
Wersion Description
WVersion Id

WIP

Data Type

cg_ Content Type c

cg_ Description__c

cg_ File Name_ ¢

cg_ File Size ¢

cg_ File Size in_Bytes ¢
cg_ |s Deleted ¢

cg_ Is_Latest Version__c
cg_ Is Parent Deleted ¢
cg Key c

cg_ Page Count_c

cg_ Parent_ c

cg_ Parent Folder Id_c
cg_ Preview Key «c

cg_ Preview Version_ld ¢
cg_ Private__ c

cg_ Shortcut_ c

cg  Sync Id_ ¢

cg Tags ¢

cg_ Thumbnail Key ¢

cg_ Thumbnail Version Id_ ¢
cg_ Version_Description__c
cg_ Version_Id_ ¢

cg WIP_c
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If you would like to use S-Drive Versioning feature, open S-Drive Configuration tab and click Enable
Versioning button to activate version upload feature.
Important Note: If you enable versioning you can’t disable it later.

Note that Preview & Thumbnail feature will be auto enabled for S-Drive Folders (S30bject), and
Preview & Thumbnail will be generated for your future uploads to S-Drive Folders in 2.1. You can
disable this feature from S-Drive Configuration Tab. You can also check Preview & Thumbnail
conversion pricing here.

Amazon Region and Remote Site Settings

After switching to Signature Version 4, your AWS S3 bucket region is now required information for S-
Drive to work. If you are upgrading to any S-Drive version after 2.5.1 for the first time, it is highly
advised to configure your Amazon Credentials and your S3 bucket again. If this is not done it is likely
you will get an error when using S-Drive.

Enhanced Email and Lightning Email Component

If you cannot install S-Drive and the message from Salesforce regards to Enhanced Email being
disabled, please go to Setup > EnhancedEmail > Enable from Salesforce Lightning Experience.
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C Appendix C: Troubleshooting

e [Problem] I'm getting "Failed: Unauthorized endpoint, please check Setup->Security-
>Remote site settings. endpoint = https://s3.amazonaws.com/?....... "error.
[Solution] You forgot to set or deleted Remote Site Settings. Go to Setup -> Security ->
Remote Site Settings and add this site: https://s3.amazonaws.com

e [Problem] My mail message contains "??2?" for some language-specific characters in
email clients (Outlook, Thunderbird etc.).
[Solution] Go to Setup -> Personal Setup -> My Personal Information -> Personal
Information. Edit User Detail and set Email Encoding to Unicode (UTF-8).

e [Problem] Salesforce sharing is not working.
[Solution] Sharing is only supported for S-Drive Folders. Both, S-Drive Folders and S-Drive
Attachments are sharing-aware that means they will respect the sharing rules applied on
S-Drive objects.

e [Problem] Percent character (%) is replaced with an underscore character (_) while
downloading.
[Solution] This is a technical limitation.

e [Problem] Some special characters (e.g. g, s, 1) can’t be typed into text fields on Apple
Macintosh.
[Solution] This is a limitation related to Flash Player’s Macintosh version. This issue will be
addressed in later releases.

e [Problem] Special characters in file names are URL encoded for Firefox browser.
[Solution] This is a limitation of Firefox.

e [Problem] If a sub folder is deleted parent folder's (+) sign stays there until clicked Home
and refreshed.
[Solution] You need to refresh the S-Drive tab.

e [Problem] If folder has no sub folders, tree's folder icon is closed whether we click on it or
not. [Solution] This is only a visual problem and it will not affect the operation of the
application.
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[Problem] S-Drive tab for Lightning Experience is not visible after installation.
o [Solution] Go to Setup->Profiles->Edit Your Profile->Tab Settings and then set S-
Drive Tab to “Default On”. This issue occurs if you install S-Drive 2.5 before
deploying my domain. This is a known issue of Salesforce. You can visit this link for

further information.

209
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